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tutorials	Beginner,	Design	How	to	Make	a	Zine	in	Adobe	InDesign	By	the	end	of	the	tutorial	you’ll	have	a	zine	template	you	can	customise	to	make	a	more	unique	design.	Unlimited	Downloads:	1,000,000+	InDesign	Templates,	Mockups	&	Design	Assets	by	Suitable	for	relative	beginners	to	InDesign,	this	is	a	great	all-round	introduction	to	basic	print
design	techniques.	As	well	as	access	to	Adobe	InDesign,	you’ll	need	a	selection	of	images	and	fonts	to	use	in	your	zine.	To	recreate	the	design	pictured	here,	you	can	download	the	following	photos	and	fonts:	Install	the	font	onto	your	computer	and	you’re	ready	to	start	designing.	Open	InDesign	and	go	to	File	>	New	>	Document.	Unlimited	Downloads:
1,000,000+	Fonts,	Mockups	&	Design	Assets	by	Set	up	the	document	for	Print,	with	an	A5	page	size	(148	x	210	mm).	Set	the	number	of	pages	to	10	and	make	sure	Facing	Pages	is	checked.	UNLIMITED	DOWNLOADS:	50	Million+	Fonts	&	Design	Assets	Add	a	Top	and	Bottom	Margin	of	19	mm,	set	the	Inside	Margin	to	21	mm	and	the	Bottom	Margin
to	25	mm.	Finally,	add	a	5	mm	Bleed	to	all	edges	except	the	Inside	edge,	and	click	Create.	Expand	the	Layers	panel	(Window	>	Layers).	Double-click	on	Layer	1	and	rename	this	Color.	Create	two	more	new	layers	—	Photos,	and	Type.	Expand	the	Swatches	panel	(Window	>	Color	>	Swatches).	Choose	New	Color	Swatch	from	the	panel’s	drop-down
menu	(at	top-right).	With	the	Type	set	to	Process	and	Mode	to	CMYK,	set	the	levels	below	to	C=96	M=82	Y=3	K=0.	Click	Add	and	Done.	Create	a	second	new	swatch,	C=0	M=86	Y=89	K=0.	Choose	New	Gradient	Swatch	from	the	Swatches	panel’s	menu.	Name	the	swatch	Gradient	Swatch.	Click	on	the	left-hand	stop	on	the	Gradient	Ramp,	and	choose
your	blue	swatch,	C=96	M=82	Y=3	K=0,	from	the	Stop	Color	menu.	For	the	right-hand	stop	choose	your	red	swatch,	C=0	M=86	Y=89	K=0.	Click	Add	and	Done.	Double-click	on	the	A-Master	icon	at	the	top	of	the	Pages	panel	(Window	>	Pages)	to	bring	up	the	master	on	your	screen.	Use	the	Type	Tool	(T)	to	create	a	text	frame	across	the	bottom	of
the	left-hand	page.	Here	you	can	place	page	numbers.	With	your	type	cursor	in	the	frame,	go	to	Type	>	Insert	Special	Character	>	Markers	>	Current	Page	Number.	You	can	format	the	page	number	using	the	Swatches	panel	and	Character	and	Paragraph	panels	(Window	>	Type	&	Tables	>	Character	/	Paragraph).	Edit	>	Copy	and	Edit	>	Paste	the
page	number	text	frame,	moving	this	over	to	the	right-hand	page.	Use	the	Rectangle	Tool	(M)	to	create	a	tall,	narrow	shape	across	the	left	edge	of	the	spread,	taking	it	up	to	the	bleed,	and	allowing	a	small	area	to	extend	onto	the	page.	Set	the	Fill	Color	of	this	to	Gradient	Swatch.	Copy	and	Paste	the	rectangle,	and	on	the	copy,	Right-Click	>
Transform	>	Flip	Horizontal.	Move	this	over	into	a	mirrored	position	on	the	right-hand	page.	In	the	Pages	panel,	Right-Click	on	the	A-Master	icon,	and	choose	Duplicate	Master	Spread	“A-Master”.	On	the	new	B-Master,	select	and	delete	the	page	number	text	frames.	In	the	Pages	panel,	select	the	top	[None]	master	page,	and	choose	Apply	Master	to
Pages	from	the	panel’s	drop-down	menu.	We	want	to	have	no	master	applied	to	the	front	and	back	cover	of	our	zine,	which	is	on	pages	1	and	10	of	our	document.	So	type	in	1,	10	and	click	OK.	Select	the	B-Master	icon	in	the	Pages	panel,	and,	as	before,	choose	Apply	Master	to	Pages.	You	want	to	apply	the	B-Master	to	any	pages	which	you	don’t	want
to	have	page	numbers.	In	this	case,	I	type	in	2,	6,	before	clicking	OK.	In	this	zine,	I	want	to	split	the	document	into	two	sections,	with	page	1	beginning	on	what	is	currently	page	3	of	the	document.	To	begin	a	new	section,	Right-Click	on	the	page	you	want	to	start	as	page	1	(in	this	case	page	3),	and	choose	Numbering	&	Section	Options.	In	the	New
Section	window	that	opens,	check	Start	Page	Numbering	at,	and	set	this	to	1.	Then	click	OK.	You’ll	get	a	warning	message,	but	don’t	worry	about	that.	Just	click	OK.	On	the	first	page	of	the	document,	Right-Click	>	Numbering	&	Section	Options.	As	before	make	sure	Start	Page	Numbering	at	is	selected	and	set	to	1.	But	this	time	choose	a	different
Style	for	the	Page	Numbering,	such	as	lowercase	roman	numerals.	Then	click	OK.	Working	on	the	first	page	(i)	of	your	document,	and	on	the	Color	layer,	use	the	Rectangle	Tool	(M)	to	create	a	shape	across	the	whole	page,	extending	the	edge	up	to	the	bleed	on	the	top,	right	and	bottom	sides.	Set	the	Fill	Color	to	Gradient	Swatch.	You	can	adjust	the
strength	of	the	gradient	from	the	Gradient	panel	(Window	>	Color	>	Gradient).	Here	I	want	to	make	the	gradient	blend	more	abruptly	in	the	center	of	the	page.	Copy	and	Edit	>	Paste	in	Place	the	rectangle	shape,	adjusting	the	Fill	to	your	blue	swatch,	C=96	M=82	Y=3	K=0.	With	the	blue	shape	selected	go	to	Object	>	Effects	>	Transparency,	and
bring	the	Opacity	down	to	30%.	Click	on	Inner	Glow	in	the	panel’s	left-hand	menu.	With	the	Mode	set	to	Normal,	click	on	the	colored	square	to	adjust	the	Effect	Color	to	your	red	swatch,	C=0	M=86	Y=89	K=0.	Increase	the	Opacity	to	100%.	Set	the	Source	to	Centre,	Size	to	around	55	mm,	Choke	to	50%	and	Noise	to	about	45%.	Then	click	OK.
Working	on	the	Type	layer,	use	the	Type	Tool	(T)	to	add	text	to	your	cover,	setting	the	Font	to	Cormorant	and	Font	Color	to	[Paper].	Select	both	rectangle	shapes	sat	on	the	Color	layer	on	the	front	cover,	and	Copy	them.	Scroll	down	to	the	first	inside	spread	of	your	zine,	and	Paste	the	shapes,	moving	them	over	onto	the	left-hand	page.	Edit	>	Paste	a
second	time,	and	with	this	copy	selected,	go	to	Object	>	Convert	Shape	>	Ellipse.	From	the	top	Controls	panel	adjust	the	Width	and	Height	of	the	circles	to	108	mm.	Then	move	these	over	the	top	of	the	left	page,	positioning	them	centrally.	Shift	the	top	circle	slightly	up	and	to	the	right	to	create	a	slightly	blurry	effect.	You	can	add	text	to	your	zine
using	the	Type	Tool	(T),	and	working	on	the	Type	layer.	Here,	I’ve	added	text	set	in	Cormorant	and	a	blue,	C=96	M=82	Y=3	K=0,	Font	Color,	to	the	right-hand	page	of	the	spread.	Use	the	Rectangle	Frame	Tool	(F)	to	create	image	frames	on	some	of	the	pages	of	your	zine.	Go	to	File	>	Place	to	drop	images	into	the	frames.	Use	the	swatches	you’ve
already	created	to	format	text,	adding	a	touch	of	color	to	your	typography.	Here,	I’ve	also	set	the	text	to	Align	towards	spine	(which	you	can	find	in	the	top	Controls	panel	with	the	Type	Tool	selected).	Use	elements	you’ve	already	created,	such	as	the	colored	rectangles	and	circles	on	the	first	spread,	to	create	a	quick	and	simple	design	for	your	back
cover,	on	the	final	page	of	the	document.	Make	sure	to	add	your	website	to	the	back	cover	too.	File	>	Save	your	artwork,	then	go	to	File	>	Export.	Choose	Adobe	PDF	(Print)	from	the	Format	menu,	name	your	file,	and	then	click	Save.	In	the	Export	Adobe	PDF	window,	choose	Press	Quality	for	the	Adobe	PDF	Preset,	at	the	top.	Make	sure	the	pages	are
set	to	Export	As:	Pages	(not	spreads).	Click	on	Marks	and	Bleeds	in	the	left-hand	menu.	Check	All	Printer’s	Marks	and	Use	Document	Bleed	Settings,	before	clicking	Export.	You	can	send	off	this	PDF	document	straight	to	the	printers,	great	job!	Eager	to	pick	up	more	print	design	skills?	Check	out	our	magazine	design	tutorials,	or	download	free
magazine	templates	for	InDesign.	templates	Magazines	Zine	Template	for	InDesign	Complete	with	an	elegant	layout	for	the	inside	pages	and	a	wraparound	cover,	this	downloadable	zine	template	features	creative	typography,	black	and	white	photography	and	an	on-trend	design	throughout.	Unlimited	Downloads:	1,000,000+	InDesign	Templates,
Mockups	&	Design	Assets	by	This	zine	template	includes	a	front	and	back	cover,	professional-standard	text	formatting,	page	numbers,	master	pages,	a	bold	colour	palette,	and	simple	and	stylish	geometric	backgrounds.	Scroll	down	to	find	out	more,	and	download	the	template.	Zine	template	size:	14.8cm	x	21	cm	14.8cm	x	21cm	is	a	great	zine	size,
however	other	sizes	are	widely	used.	Don’t	panic	if	you	need	a	different	size,	we’ve	put	together	a	handy	little	tutorial	on	how	to	resize	templates	.	Below	you	can	preview	a	selection	of	spreads	from	this	photography	zine	template,	download	the	InDesign	file	and	find	a	bunch	of	helpful	tips	on	how	to	edit	your	template	in	InDesign.	Download	this	12-
page	Zine	Template	Download	this	zine	template*	for	free	(your	download	will	include	an	INDD	file	for	InDesign	CS6	and	an	IDML	version	for	opening	in	InDesign	CS4,	CS5	or	CC):	Download	Template	(Free)	*Note	that	images	are	not	included	in	your	free	download.	Font	files	Cormorant	–	Font	Squirrel		Help	Working	with	InDesign	Templates	We’ve
put	together	a	collection	of	helpful	tips	to	make	editing	our	InDesign	Templates	super	easy.	If	you’re	a	newbie	to	Adobe	InDesign	it’s	worth	checking	these	out	before	starting	work	on	your	design.	Unlimited	Downloads:	1,000,000+	Fonts,	Mockups	&	Design	Assets	by	How	to	Open	an	InDesign	Template	Step	1.	Download	the	file.	UNLIMITED
DOWNLOADS:	50	Million+	Fonts	&	Design	Assets	Step	2.	Our	InDesign	templates	are	packaged	and	saved	as	ZIP	files.	If	you	have	a	Windows	computer	Right	Click	>	Extract	All	before	opening	the	InDesign	file.	Step	3.	If	you’re	running	InDesign	CS6	open	the	INDD	version	of	the	file.	If	you’re	working	with	InDesign	CS4,	CS5	or	CC	open	the	IDML
version.	How	to	Work	With	Layers	in	Your	Template	Our	InDesign	templates	are	organized	into	layers,	which	group	similar	elements	together.	The	layers	in	your	document	can	be	controlled	from	the	Layers	panel	(Window	>	Layers).	Pro	tip:	Try	locking	the	YOUR	IMAGES	HERE	layer	to	save	time	when	editing	text.	This	will	prevent	you	from
accidentally	moving	the	graphics	out	of	position.	How	to	Change	the	Colors	The	color	scheme	of	this	template	can	be	edited	from	the	Swatches	panel	(Window	>	Color	>	Swatches).	Pro	tip:	Editing	a	swatch	will	automatically	update	all	instances	of	that	color	across	your	document.	How	to	Add	Your	Own	Text	The	text	across	this	design	can	easily
replaced	with	your	own	copy.	Simple	use	the	Type	Tool	(T)	to	select	the	text	box	you	wish	to	edit.	You	can	then	add	your	own	fonts	and	formatting.	Read	more	about	formatting	text	in	InDesign.	How	to	Add	Your	Own	Images	You’ll	notice	when	you	first	open	the	template	that	all	the	image	frames	have	a	placeholder	image.	You	can	insert	your	own
images	by	selecting	the	image	frame	and	using	File	>	Place	to	select	a	replacement	image.	Read	our	beginner’s	guide	to	working	with	images	in	InDesign.	Pro	tip:	Do	your	images	look	blurry?	Make	sure	your	display	is	set	to	high-quality	(View	>	Display	Performance	>	High-Quality	Display).	To	see	more	accurately	how	your	design	will	appear	when
printed	go	to	View	>	Overprint	Preview.	How	to	Resize	Pages	in	InDesign	It’s	simple	to	change	the	width	of	the	spine	in	your	template	by	using	the	Page	Tool	(Shift+P).	Select	the	tool	and	then	click	onto	the	spine	to	select	it.	You	can	drag	the	sides	of	the	page	to	preview	your	desired	new	size.	Hold	down	Alt	or	Option	while	you	drag	to	resize	the
page.	Read	more	about	resizing	pages	in	InDesign.	How	to	Export	Your	Document	for	Printing	Once	you’ve	completed	work	on	your	template	and	you’re	ready	to	print	it		you	can	head	to	File	>	Export.	To	create	a	print-ready	file,	choose	Adobe	PDF	(Print)	from	the	Format	drop-down	menu	in	the	Export	window.	Make	sure	to	include	the	bleed	in	your
export	options	by	checking	Use	Document	Bleed	Settings	in	the	Export	Adobe	PDF	window.	Read	more	about	prepping	your	designs	for	printing	in	InDesign.	How	to	Change	the	Fonts	in	a	Document	You	can	format	individual	items	of	text	using	the	Type	Tool	(T)	and	Controls	panel,	which	you’ll	find	running	along	the	top	of	the	InDesign	workspace.
The	fonts	in	most	templates	are	not	set	as	InDesign	styles.	However,	it’s	easy	to	create	a	Character	or	Paragraph	Style	using	existing	text	formatting,	and	then	edit	this	from	the	Styles	panels	(Window	>	Styles).	Read	more	about	editing	Styles	in	InDesign.	Discover	more	advice	for	InDesign	beginners	on	our	Tutorials	page.	Or	why	not
discover	inspiration	about	typography,	layout	design	and	much	more	right	here.	templates	Magazines	Zine	Template	for	InDesign	Complete	with	an	elegant	layout	for	the	inside	pages	and	a	wraparound	cover,	this	downloadable	zine	template	features	creative	typography,	black	and	white	photography	and	an	on-trend	design	throughout.	Unlimited
Downloads:	1,000,000+	InDesign	Templates,	Mockups	&	Design	Assets	by	This	zine	template	includes	a	front	and	back	cover,	professional-standard	text	formatting,	page	numbers,	master	pages,	a	bold	colour	palette,	and	simple	and	stylish	geometric	backgrounds.	Scroll	down	to	find	out	more,	and	download	the	template.	Zine	template	size:	14.8cm	x
21	cm	14.8cm	x	21cm	is	a	great	zine	size,	however	other	sizes	are	widely	used.	Don’t	panic	if	you	need	a	different	size,	we’ve	put	together	a	handy	little	tutorial	on	how	to	resize	templates	.	Below	you	can	preview	a	selection	of	spreads	from	this	photography	zine	template,	download	the	InDesign	file	and	find	a	bunch	of	helpful	tips	on	how	to	edit
your	template	in	InDesign.	Download	this	12-page	Zine	Template	Download	this	zine	template*	for	free	(your	download	will	include	an	INDD	file	for	InDesign	CS6	and	an	IDML	version	for	opening	in	InDesign	CS4,	CS5	or	CC):	Download	Template	(Free)	*Note	that	images	are	not	included	in	your	free	download.	Font	files	Cormorant	–	Font	Squirrel	
Help	Working	with	InDesign	Templates	We’ve	put	together	a	collection	of	helpful	tips	to	make	editing	our	InDesign	Templates	super	easy.	If	you’re	a	newbie	to	Adobe	InDesign	it’s	worth	checking	these	out	before	starting	work	on	your	design.	Unlimited	Downloads:	1,000,000+	Fonts,	Mockups	&	Design	Assets	by	How	to	Open	an	InDesign	Template
Step	1.	Download	the	file.	UNLIMITED	DOWNLOADS:	50	Million+	Fonts	&	Design	Assets	Step	2.	Our	InDesign	templates	are	packaged	and	saved	as	ZIP	files.	If	you	have	a	Windows	computer	Right	Click	>	Extract	All	before	opening	the	InDesign	file.	Step	3.	If	you’re	running	InDesign	CS6	open	the	INDD	version	of	the	file.	If	you’re	working	with
InDesign	CS4,	CS5	or	CC	open	the	IDML	version.	How	to	Work	With	Layers	in	Your	Template	Our	InDesign	templates	are	organized	into	layers,	which	group	similar	elements	together.	The	layers	in	your	document	can	be	controlled	from	the	Layers	panel	(Window	>	Layers).	Pro	tip:	Try	locking	the	YOUR	IMAGES	HERE	layer	to	save	time	when	editing
text.	This	will	prevent	you	from	accidentally	moving	the	graphics	out	of	position.	How	to	Change	the	Colors	The	color	scheme	of	this	template	can	be	edited	from	the	Swatches	panel	(Window	>	Color	>	Swatches).	Pro	tip:	Editing	a	swatch	will	automatically	update	all	instances	of	that	color	across	your	document.	How	to	Add	Your	Own	Text	The	text
across	this	design	can	easily	replaced	with	your	own	copy.	Simple	use	the	Type	Tool	(T)	to	select	the	text	box	you	wish	to	edit.	You	can	then	add	your	own	fonts	and	formatting.	Read	more	about	formatting	text	in	InDesign.	How	to	Add	Your	Own	Images	You’ll	notice	when	you	first	open	the	template	that	all	the	image	frames	have	a	placeholder	image.
You	can	insert	your	own	images	by	selecting	the	image	frame	and	using	File	>	Place	to	select	a	replacement	image.	Read	our	beginner’s	guide	to	working	with	images	in	InDesign.	Pro	tip:	Do	your	images	look	blurry?	Make	sure	your	display	is	set	to	high-quality	(View	>	Display	Performance	>	High-Quality	Display).	To	see	more	accurately	how	your
design	will	appear	when	printed	go	to	View	>	Overprint	Preview.	How	to	Resize	Pages	in	InDesign	It’s	simple	to	change	the	width	of	the	spine	in	your	template	by	using	the	Page	Tool	(Shift+P).	Select	the	tool	and	then	click	onto	the	spine	to	select	it.	You	can	drag	the	sides	of	the	page	to	preview	your	desired	new	size.	Hold	down	Alt	or	Option	while
you	drag	to	resize	the	page.	Read	more	about	resizing	pages	in	InDesign.	How	to	Export	Your	Document	for	Printing	Once	you’ve	completed	work	on	your	template	and	you’re	ready	to	print	it		you	can	head	to	File	>	Export.	To	create	a	print-ready	file,	choose	Adobe	PDF	(Print)	from	the	Format	drop-down	menu	in	the	Export	window.	Make	sure	to
include	the	bleed	in	your	export	options	by	checking	Use	Document	Bleed	Settings	in	the	Export	Adobe	PDF	window.	Read	more	about	prepping	your	designs	for	printing	in	InDesign.	How	to	Change	the	Fonts	in	a	Document	You	can	format	individual	items	of	text	using	the	Type	Tool	(T)	and	Controls	panel,	which	you’ll	find	running	along	the	top	of
the	InDesign	workspace.	The	fonts	in	most	templates	are	not	set	as	InDesign	styles.	However,	it’s	easy	to	create	a	Character	or	Paragraph	Style	using	existing	text	formatting,	and	then	edit	this	from	the	Styles	panels	(Window	>	Styles).	Read	more	about	editing	Styles	in	InDesign.	Discover	more	advice	for	InDesign	beginners	on	our	Tutorials	page.	Or
why	not	discover	inspiration	about	typography,	layout	design	and	much	more	right	here.	Get	to	publish	your	own	magazine	containing	journals,	catalogs,	and	art	that	you	can	use	for	your	company,	school,	or	organization.	Choose	from	our	wide	variety	of	professional	magazine	templates	that	you	can	download	for	free.	These	files	are	ready-made	and
100%	customizable	for	your	convenience.	Premade	with	placeholder	content	that's	easy-editable	in	all	versions	of	Adobe	InDesign.	Available	in	(US)	8.5x11	inches	with	bleed.	Download	the	templates	instantly	anytime,	anywhere,	and	on	any	device.	Whether	it’s	for	publishing	a	weekly,	monthly,	or	bi-monthly	magazine,	create	stunning	magazine
covers	including	weddings,	fitness,	kitchen,	travel,	fashion,	sports,	photography,	and	food	magazines.	Download	now	and	report	all	the	modern	trends	to	your	readers	with	an	eye-catching	magazine!	Magazines	are	great	for	building	one's	brand	and	for	introducing	people	to	products	and/or	services	that	they	could	potentially	purchase.	Are	you	trying
to	decide	on	an	editing	program	to	use	in	putting	together	your	own	magazine?	Searching	for	templates	to	use	for	designing	both	the	inside	and	outside	of	your	booklet/brochure?	You	won’t	go	wrong	with	Adobe	InDesign	and	our	catalog	of	Ready-made	Magazine	Templates!	1.	The	Perfect	Tool	for	Any	Reading	Material	As	an	impressive	work	of
software	from	Adobe,	InDesign	is	a	perfect	match	for	assembling	your	magazine	or	booklet.	This	program	is	specifically	made	for	editing	and	composing	publicized	reading	material	of	all	kinds:	brochures,	newspapers,	flyers,	books,	etc.	So,	with	InDesign,	you’re	sure	to	have	all	the	necessary	tools	you’ll	ever	need	(and	more)	to	edit	any	of	our	many
magazine	templates.	To	get	your	hands	on	an	installation	of	InDesign,	pay	a	visit	to	Adobe’s	online	store	to	find	it.	Once	you’re	there,	you	can	take	your	pick	from	the	different	monthly	subscription	plans	that	they	have	available	for	InDesign.	Not	convinced	of	InDesign’s	capabilities?	If	that’s	the	case,	then	you	can	simply	try	out	Adobe’s	free	trial	offer
to	see	what	InDesign	can	do	for	you	before	having	to	commit	to	a	subscription.	The	trial	lasts	for	a	whole	week	and	requires	no	need	for	a	credit	card,	letting	you	work	on	our	templates	without	having	to	pay	at	all	yet!	Nice!	2.	A	Beautiful	Template	for	a	Beautiful	Vision	Once	you’ve	got	Adobe	InDesign	installed	and	ready	to	go,	up	next	is	to	peruse	our
wide	array	of	Ready-made	Magazine	Templates	and	pick	whatever	you	need	to	use	for	your	creativity.	We	guarantee	that	you’ll	find	sets	of	cover	and	page	templates	that	are	definitely	worthy	of	your	bold	and	artistic	imagination!	Be	it	something	on	the	front	to	showcase	the	latest	Android	phone	or	a	section	of	content	for	a	special	seasonal	menu	from
the	classiest	restaurant	in	town,	you’re	bound	to	find	designs	that’ll	click	with	you!	3.	Download	a	Template	or	Two.	Or	Three!	Have	any	of	our	beautifully-designed	magazine	templates	spoken	to	you?	Download	however	many	you	need	by	first	clicking	on	their	respective	thumbnail	in	our	gallery	to	open	their	own	respective	pages	in	separate	browser
tabs.	In	each	new	tab,	there’s	a	provided	download	link;	click	said	link	to	save	a	template	file	to	your	computer.	On	each	template’s	page,	you	can	also	view	some	preview	images	to	your	left	side	and	read	about	the	file’s	details	to	your	right.	4.	Edit	to	Impress!	With	Adobe	InDesign	installed	and	your	template(s)	downloaded,	you	can	now	let
inspiration	bring	your	ideas	to	form!	Since	our	templates	already	come	with	plenty	of	gorgeous	placeholder	content,	getting	started	won’t	be	an	issue.	When	writing	the	dialog,	be	sure	to	be	endearing	and	concise;	use	styles	and	colors	for	your	font	that	compliment	the	overall	look	of	your	magazine	cover	and	pages.	Utilize	good	color	theory	for	an
eye-catching	palette	and	organize	the	text	in	an	interesting	yet	efficient	way	of	guiding	the	reader’s	eyes.	Don’t	forget	to	add	whatever	clipart/imagery	you	need	for	your	content	and	to	professionally	arrange	the	layout	with	it!	5.	Ready	to	Publish	After	letting	your	creativity	do	its	thing,	remember	to	save	all	that	hard	work,	and	your	material	is	ready
for	its	audience.	Give	the	world	a	read	to	remember	with	Adobe	InDesign	and	our	Ready-made	Magazine	Templates!	templates	Magazines	Zine	Template	for	InDesign	Complete	with	an	elegant	layout	for	the	inside	pages	and	a	wraparound	cover,	this	downloadable	zine	template	features	creative	typography,	black	and	white	photography	and	an	on-
trend	design	throughout.	Unlimited	Downloads:	1,000,000+	InDesign	Templates,	Mockups	&	Design	Assets	by	This	zine	template	includes	a	front	and	back	cover,	professional-standard	text	formatting,	page	numbers,	master	pages,	a	bold	colour	palette,	and	simple	and	stylish	geometric	backgrounds.	Scroll	down	to	find	out	more,	and	download	the
template.	Zine	template	size:	14.8cm	x	21	cm	14.8cm	x	21cm	is	a	great	zine	size,	however	other	sizes	are	widely	used.	Don’t	panic	if	you	need	a	different	size,	we’ve	put	together	a	handy	little	tutorial	on	how	to	resize	templates	.	Below	you	can	preview	a	selection	of	spreads	from	this	photography	zine	template,	download	the	InDesign	file	and	find	a
bunch	of	helpful	tips	on	how	to	edit	your	template	in	InDesign.	Download	this	12-page	Zine	Template	Download	this	zine	template*	for	free	(your	download	will	include	an	INDD	file	for	InDesign	CS6	and	an	IDML	version	for	opening	in	InDesign	CS4,	CS5	or	CC):	Download	Template	(Free)	*Note	that	images	are	not	included	in	your	free	download.
Font	files	Cormorant	–	Font	Squirrel		Help	Working	with	InDesign	Templates	We’ve	put	together	a	collection	of	helpful	tips	to	make	editing	our	InDesign	Templates	super	easy.	If	you’re	a	newbie	to	Adobe	InDesign	it’s	worth	checking	these	out	before	starting	work	on	your	design.	Unlimited	Downloads:	1,000,000+	Fonts,	Mockups	&	Design	Assets	by
How	to	Open	an	InDesign	Template	Step	1.	Download	the	file.	UNLIMITED	DOWNLOADS:	50	Million+	Fonts	&	Design	Assets	Step	2.	Our	InDesign	templates	are	packaged	and	saved	as	ZIP	files.	If	you	have	a	Windows	computer	Right	Click	>	Extract	All	before	opening	the	InDesign	file.	Step	3.	If	you’re	running	InDesign	CS6	open	the	INDD	version
of	the	file.	If	you’re	working	with	InDesign	CS4,	CS5	or	CC	open	the	IDML	version.	How	to	Work	With	Layers	in	Your	Template	Our	InDesign	templates	are	organized	into	layers,	which	group	similar	elements	together.	The	layers	in	your	document	can	be	controlled	from	the	Layers	panel	(Window	>	Layers).	Pro	tip:	Try	locking	the	YOUR	IMAGES
HERE	layer	to	save	time	when	editing	text.	This	will	prevent	you	from	accidentally	moving	the	graphics	out	of	position.	How	to	Change	the	Colors	The	color	scheme	of	this	template	can	be	edited	from	the	Swatches	panel	(Window	>	Color	>	Swatches).	Pro	tip:	Editing	a	swatch	will	automatically	update	all	instances	of	that	color	across	your	document.
How	to	Add	Your	Own	Text	The	text	across	this	design	can	easily	replaced	with	your	own	copy.	Simple	use	the	Type	Tool	(T)	to	select	the	text	box	you	wish	to	edit.	You	can	then	add	your	own	fonts	and	formatting.	Read	more	about	formatting	text	in	InDesign.	How	to	Add	Your	Own	Images	You’ll	notice	when	you	first	open	the	template	that	all	the
image	frames	have	a	placeholder	image.	You	can	insert	your	own	images	by	selecting	the	image	frame	and	using	File	>	Place	to	select	a	replacement	image.	Read	our	beginner’s	guide	to	working	with	images	in	InDesign.	Pro	tip:	Do	your	images	look	blurry?	Make	sure	your	display	is	set	to	high-quality	(View	>	Display	Performance	>	High-Quality
Display).	To	see	more	accurately	how	your	design	will	appear	when	printed	go	to	View	>	Overprint	Preview.	How	to	Resize	Pages	in	InDesign	It’s	simple	to	change	the	width	of	the	spine	in	your	template	by	using	the	Page	Tool	(Shift+P).	Select	the	tool	and	then	click	onto	the	spine	to	select	it.	You	can	drag	the	sides	of	the	page	to	preview	your	desired
new	size.	Hold	down	Alt	or	Option	while	you	drag	to	resize	the	page.	Read	more	about	resizing	pages	in	InDesign.	How	to	Export	Your	Document	for	Printing	Once	you’ve	completed	work	on	your	template	and	you’re	ready	to	print	it		you	can	head	to	File	>	Export.	To	create	a	print-ready	file,	choose	Adobe	PDF	(Print)	from	the	Format	drop-down
menu	in	the	Export	window.	Make	sure	to	include	the	bleed	in	your	export	options	by	checking	Use	Document	Bleed	Settings	in	the	Export	Adobe	PDF	window.	Read	more	about	prepping	your	designs	for	printing	in	InDesign.	How	to	Change	the	Fonts	in	a	Document	You	can	format	individual	items	of	text	using	the	Type	Tool	(T)	and	Controls	panel,
which	you’ll	find	running	along	the	top	of	the	InDesign	workspace.	The	fonts	in	most	templates	are	not	set	as	InDesign	styles.	However,	it’s	easy	to	create	a	Character	or	Paragraph	Style	using	existing	text	formatting,	and	then	edit	this	from	the	Styles	panels	(Window	>	Styles).	Read	more	about	editing	Styles	in	InDesign.	Discover	more	advice	for
InDesign	beginners	on	our	Tutorials	page.	Or	why	not	discover	inspiration	about	typography,	layout	design	and	much	more	right	here.	So	you’ve	just	started	out	on	your	InDesign	journey,	or	maybe	you’re	a	seasoned	professional	who	just	doesn’t	have	the	time	to	create	all	of	your	projects	from	scratch.	We	know	what	you’re	thinking	–	we’ve	wondered
about	it	too.	Does	InDesign	have	free	templates?	The	answer	is	yes.	There	are	amazing	Adobe	InDesign	templates,	free	to	download	and	customize,	hiding	all	over	the	internet	if	you	know	where	to	look	–	and	we	do!	But	we	understand	that	you’re	super	busy	and	don’t	have	the	time	to	waste	searching,	so	we’ve	taken	the	very	best	free	InDesign
templates	from	our	research	and	put	them	all	together	in	one	place	for	you.	Easy!	Read	on	to	discover	our	carefully	curated	list	of	free	InDesign	templates,	perfect	for	stunning	print	projects	of	all	kinds.	Get	everything	you	need	to	supercharge	your	InDesign	projects	and	workflow,	with	InDesign	templates	for	every	idea	you	can	imagine!	From	just
$16,	get	unlimited	access	to	thousands	of	professional	InDesign	templates	for	flyers,	brochures,	books,	magazines,	proposals,	reports,	and	much	more.Find	InDesign	Templates	Graphic	Design	Portfolio	InDesign	Template	Every	designer	needs	to	have	a	killer	portfolio	to	wow	and	win	clients.	This	InDesign	template	will	help	achieve	that	goal.	It
includes	72	different	page	layouts	for	showcasing	your	work	and	case	studies.	And	the	brochure	comes	in	3	different	color	schemes	as	well.	Modern	Resume	Template	for	InDesign	This	InDesign	template	is	ideal	for	making	professional	and	corporate-style	resumes	for	professionals.	There	are	3	layouts	in	this	template	for	a	two-page	resume	and	a
cover	letter.	The	template	is	fully	customizable	and	comes	in	multiple	file	formats.	Trendy	Magazine	InDesign	Template	You	won’t	find	a	cooler	or	trendier	magazine	template	than	this	one.	With	this	InDesign	template,	you	can	design	a	modern	fashion	or	design	magazine	for	many	different	types	of	businesses.	It	features	25	unique	page	layouts	with	a
stylish	cover	design.	You	can	easily	customize	it	to	your	preference	as	well.	Gift	Voucher	–	Adobe	InDesign	Templates	First	up	is	a	stunning	gift	voucher	template	suitable	for	virtually	any	purpose	under	the	sun.	It	offers	a	300	DPI,	print-ready	layout	that	can	be	fully	customized	to	your	heart’s	content.	Compatible	with	InDesign	CS4	and	higher
versions.	Premium	InDesign	Magazine	Template	The	next	in	our	list	of	the	best	Adobe	InDesign	templates	is	this	premium	magazine	layout	from	Envato	Elements,	suitable	for	any	creative	purposes.	It	offers	22	professionally	designed	pages	in	A4	format	with	a	3mm	bleed	and	column-based	layout,	and	every	element	can	be	fully	customized.	Premium
InDesign	Flyer	Template	Next	up,	we	have	a	versatile	premium	flyer	template	from	Envato	Elements	that	features	a	clean,	minimal	layout	that	can	be	customized	to	fit	any	brand	or	business.	It’s	super	easy	to	use	and	is	fully	layered	for	seamless	editing,	plus	it	comes	with	free	fonts	and	a	print-ready	CMYK	color	space.	Premium	InDesign	Resume
Template	For	a	professional	and	modern	looking	resume,	look	no	further	than	this	stunning	premium	template	from	Envato	Elements,	perfect	for	any	profession!	It	offers	an	elegant	and	minimal	single	page	layout	with	all	graphics	fully	editable,	as	well	as	free	fonts	and	picture	placeholders.	Premium	InDesign	Newsletter	Template	If	you	want	to	put
together	a	business	newsletter	for	company	updates,	this	premium	newsletter	from	Envato	Elements	includes	everything	you’ll	need.	It	comes	with	8	unique	page	layouts	featuring	fully	editable	text,	images,	and	other	graphic	elements,	and	the	well-layered	design	makes	it	super	easy	to	customize.	Premium	InDesign	Lookbook	Template	Designed	as	a
fashion	lookbook	but	versatile	enough	to	be	suitable	for	any	kind	of	brochure	or	portfolio,	our	final	premium	template	from	Envato	Elements	can	be	fully	customized	according	to	your	personal	style,	using	InDesign	versions	CS4	and	above.	It	includes	20	custom	pages	with	US	Letter	sizing.	Deeprock	Stationary	Set	&	Invoice	Deeprock	is	an	exhaustive
set	of	Adobe	InDesign	templates	containing	a	letterhead,	invoice,	gift	voucher,	business	cards,	and	postcards,	and	so	many	more	designs.	These	layouts	can	be	fully	customized	with	your	content.	Agency	Flyer	InDesign	Template	This	flyer	template	is	designed	to	announce	a	wide	range	of	seasons.	Creative	and	Minimalist	flyer,	perfect	for	any	personal
or	corporate	use.	It’s	ideal	for	any	company	project.	You	can	edit	easily	this	flyer,	It’s	100%	customizable	Going	Somewhere	–	Brochure	InDesign	Template	Here	we	have	a	great	trifold	Brochure	template	for	all	business	and	personal	needs.	This	Brochure	is	suitable	for	any	kind	of	business,	corporate	and	can	be	also	used	for	any	other	publishing
needs	like	annual	reports	and	company	profiles.	Graphic	DEsign	Portfolio	–	InDesign	Template	This	32	page	minimal	brochure	template	is	for	designers	working	on	product/graphic	design	portfolios,	interior	design,	catalogs,	product	catalogs,	and	agency-based	projects.	Just	drop	in	your	own	pictures	and	texts,	and	it’s	ready	for	print.	Or	use	it	as	a
professional	online	PDF	or	email	attachment.	Lonest	–	Photography	InDesign	Template	Lonest	is	a	beautifully	designed	photography	portfolio	template,	fully	customizable	in	Adobe	InDesign.	It	features	40	custom	pages	in	A4	and	US	letter	sizes,	a	grid-based	layout,	free	fonts,	and	more.	Jasmine	–	Catalog	InDesign	Template	Jassmine	is	a	carefully
crafted	catalog	template	that	helps	you	showcase	your	products,	and	designs	in	the	best	light	possible.	It	comes	in	a	lookbook-style	landscape	format	and	offers	18	pages	that	can	be	completely	customized	in	Adobe	InDesign.	Business	Brochure	InDesign	Template	Here	we	have	a	premium	InDesign	template	perfectly	suited	to	businesses	wanting	to
create	an	upscale	and	opulent-looking	brochure.	It	features	16	pages,	well-organized	layers,	CMYK	color	space,	unlimited	color	choices,	free	fonts,	and	more.	Nyx	–	InDesign	Proposal	Template	Nyk	is	a	stunning	template	for	Adobe	InDesign	fitting	perfectly	for	any	creative	business	wanting	to	go	bold,	and	fearless	with	its	proposal	design.	It	has	an
effortlessly	stylish	design	guaranteed	to	impress	the	clients	and	land	you	the	deal	that	can	take	your	business	to	new	heights.	Atmos	–	InDesign	Book	Template	Atmos	is	a	sophisticated	and	graceful	template	that	provides.	a	lot	of	versatility.	It	can	be	used	for	a	variety	of	purposes	:	book,	catalog,	brochure,	portfolio,	magazine,	and	more.	It	comes	with
18	pages	ready	for	both	print,	and	digital	publishing.	Free	InDesign	Templates	Free	Company	Profile	InDesign	Template	This	free	InDesign	template	is	perfect	for	making	a	modern	brochure	for	making	a	professional	company	profile.	It	features	creatively	crafted	page	layouts	with	a	mix	of	shapes,	colors,	and	visuals.	It	includes	free	fonts	as	well.	Free
Interior	Design	InDesign	Template	This	free	InDesign	template	will	help	you	craft	the	perfect	portfolio	to	showcase	your	best	clients	and	work.	It’s	especially	suitable	for	interior	designers	and	architects.	It’s	a	free	sample	of	a	premium	template	that	you	can	use	to	create	a	custom	design	of	your	own.	Free	Design	Portfolio	InDesign	Template	If	you’re
a	graphic	designer,	this	free	InDesign	template	is	perfect	for	crafting	a	modern	portfolio	to	present	your	designs.	This	free	version	includes	5	page	layouts	that	you	can	easily	edit	and	customize	using	InDesign.	Free	Apparel	Catalog	InDesign	Template	This	free	InDesign	template	is	perfect	for	designing	a	stylish	and	colorful	magazine	or	catalog
brochure.	It’s	designed	with	fashion	and	apparel	brands	in	mind	for	easily	showcasing	their	selection	in	style.	Free	Simple	Magazine	InDesign	Template	Another	free	InDesign	template	for	crafting	simple	yet	modern	magazine	brochures.	The	template	comes	with	an	easily	editable	design	with	simple	page	layouts.	It	comes	in	both	MS	Word	and	Adobe
InDesign	formats.	Free	Aesthetic	Magazine	InDesign	Template	This	free	InDesign	template	features	a	creative	and	aesthetic	design.	It’s	perfect	for	designing	stylish	travel	and	lifestyle	magazines.	You	can	easily	edit	each	page	to	change	fonts,	paragraph	styles,	images,	and	colors.	Free	Research	Report	InDesign	Template	Here’s	a	professional-looking
InDesign	template	for	your	business	reports	and	research	documents.	This	template	comes	with	a	clean	and	business-themed	design.	It	includes	7	page	layouts	with	customizable	elements.	Free	Minimal	Zine	InDesign	Template	This	is	a	free	InDesign	template	featuring	a	fully	minimalist	and	simple	page	design.	It’s	ideal	for	making	modern	magazine
brochures,	especially	for	creative	agencies	and	brands.	The	template	is	available	in	MS	Word	format	as	well.	Free	Marketing	Proposal	InDesign	Template	Create	an	attractive	proposal	brochure	that	wins	over	clients.	This	free	InDesign	template	is	made	with	marketing	agencies	in	mind.	The	free	version	of	the	template	has	a	few	sample	pages	you	can
copy	over	for	existing	designs.	Free	Web	Design	Proposal	InDesign	Template	This	free	InDesign	template	is	designed	to	help	you	craft	winning	web	design	proposals.	It	has	several	pages	that	allow	you	to	detail	your	plans	for	your	designs	and	building	websites.	The	free	version	includes	limited	pages	but	they	are	fully	customizable.	Free	Creative
Design	Portfolio	InDesign	Template	The	creative	design	and	the	page	layout	used	in	this	brochure	design	will	help	you	find	inspiration	for	your	own	design	portfolio	brochures.	It	features	a	stylishly	trendy	design	that	will	surely	impress	your	clients.	Free	Business	Brochure	InDesign	Template	Whether	it’s	a	financial	report	or	an	annual	business
report,	this	free	brochure	template	can	handle	them	all.	It	features	multiple	page	layouts	with	fully	customizable	designs.	You	can	use	this	one	to	craft	professional	brochures	even	for	corporate	brands.	Santal	–	Free	Magazine	InDesign	Template	Featuring	a	minimal	and	clean	layout,	this	InDesign	template	is	a	great	choice	for	making	an	elegant
magazine	design.	A	sample	of	this	template	is	free	to	download	and	it’s	more	than	enough	to	find	inspiration	for	your	own	design	projects.	Free	Branding	Portfolio	InDesign	Template	You	can	use	this	free	brochure	template	to	design	a	creative	portfolio	document	for	your	design	studio	or	digital	agency.	It	includes	multiple	page	layouts	with	minimal
and	easily	customizable	designs.	Free	Magazine	Template	for	InDesign	This	InDesign	magazine	template	can	be	anything	you	want.	It	can	be	transformed	into	a	portfolio	brochure,	a	business	magazine,	or	even	a	photography	showcase.	The	template	has	16	unique	page	designs	to	choose	from.	Free	Portfolio	Layout	InDesign	Template	This	free
portfolio	brochure	template	is	ideal	for	designers,	artists,	and	creative	professionals	for	showcasing	their	work.	It	includes	18	different	page	layouts	with	image	placeholders	and	stylish	formatting.	Free	Fashion	Magazine	InDesign	Template	If	you	plan	on	creating	a	fashion	magazine	to	promote	your	latest	clothing	lineup	or	promote	your	brand,	this
free	InDesign	template	is	for	you.	There	are	18	unique	pages	in	this	template	with	fully	customizable	layouts.	Free	Minimal	Portfolio	InDesign	Template	The	black	and	white	color	theme	gives	this	brochure	template	a	very	bold	and	minimalist	feel.	It’s	great	for	making	portfolios	for	designers,	photographers,	and	artists.	The	template	comes	with	16
different	pages	in	A4	size.	Free	Look	Book	Magazine	InDesign	Template	You	can	design	a	beautiful	lookbook-style	magazine	using	this	free	InDesign	template.	It	features	bold	and	stylish	page	layouts	with	easily	editable	image	placeholders,	colors,	and	text.	It	includes	16	pages.	Free	BiFold	Brochure	InDesign	Template	This	bi-fold	brochure	template
is	perfect	for	creating	brochures	to	promote	brands	and	businesses.	You	can	use	it	to	promote	your	services,	special	events,	and	even	real	estate	properties.	It	has	a	print-ready	design	that	will	use	fewer	colors	on	your	printer	at	home.	Free	Creative	Resume	Template	for	InDesign	If	you’re	looking	for	a	free	template	to	design	a	modern	and
professional	resume,	this	template	is	for	you.	It	features	a	clean	design	and	has	3	layouts	for	the	resume,	cover	letter,	and	portfolio.	All	are	available	in	InDesign	format.	Free	Minimal	eBook	InDesign	Template	This	free	InDesign	template	is	perfect	for	designing	modern	eBooks,	magazines,	and	brochures.	The	template	includes	16	different	page
layouts	with	black	and	white	color	schemes.	Of	course,	you	can	fully	customize	it	to	your	preference	too.	Free	Multipurpose	Brochure	InDesign	Template	This	free	InDesign	template	features	a	multipurpose	design,	allowing	you	to	craft	various	types	of	brochures.	There	are	8	unique	page	layouts	in	this	template	with	editable	colors,	paragraphs,	and
fonts.	Free	Branding	Board	InDesign	Template	The	first	free	option	in	our	roundup	of	Adobe	InDesign	templates	is	this	super	handy	branding	board	template	from	StockInDesign,	allowing	you	to	showcase	your	organization’s	style	in	one	impactful,	visual	package	encompassing	the	fonts,	colors,	and	patterns	that	capture	the	essence	of	your	brand.
Corporate	Business	Card	–	InDesign	Templates	Free	Here	we	have	a	corporate	business	card	template	that	is	sure	to	make	an	impression.	It	offers	a	clean,	and	elegant	design,	high-resolution,	print-ready	format,	CMYK	color	space,	and	much	more.	One	of	the	best	free	InDesign	templates	on	our	list!	Free	Minimalistic	Portfolio	InDesign	Template	Next
up,	we	have	a	minimalistic	portfolio	with	a	wide	variety	of	potential	applications,	offering	26	interactive	page	layouts,	a	clean,	elegant	style,	and	a	range	of	Typekit	fonts.	It’s	available	as	a	free	download	from	Behance	and	can	be	customized	in	both	InDesign	and	Illustrator.	Free	Brochure	InDesign	Template	If	you’re	looking	for	a	free	portfolio	style
brochure	template	with	a	modern,	corporate	feel,	this	design	from	CRS	InDesign	Templates	fits	the	bill.	It	offers	three	content	page	layouts	plus	front	and	rear	covers,	using	an	8	column	grid	on	a	330mm	by	310mm	artboard.	Free	Lookbook	InDesign	Template	Here	we	have	a	lovely	minimal	fashion	lookbook	template	that’s	ideal	for	use	as	a	catalog	to
showcase	your	new	products	and	designs,	using	a	classic	minimal	approach	to	help	the	reader	focus	on	the	visual	elements.	Grab	this	InDesign	template	for	free	from	Creative	Tacos.	Free	Business	Proposal	InDesign	Template	Perfect	for	a	business	proposal	or	any	other	corporate	purpose,	our	next	fabulous	free	InDesign	template	available	from
Behance	offers	a	clean,	modern	style	with	strategic	use	of	color	blocks	and	simple	yet	contemporary	fonts	that	are	sure	to	make	an	impression.	Free	Executive	Summary	InDesign	Template	Another	corporate	themed	option,	this	visually	appealing	executive	summary	template	is	super	easy	to	edit	in	Adobe	InDesign	versions	CS4	and	higher	and
includes	3	portrait	pages	with	subtle	use	of	color	and	the	choice	of	A4	and	US	Letter	sizing	options.	You	can	download	this	InDesign	template	for	free	from	StockInDesign.	Free	Architecture	Portfolio	InDesign	Template	Next	in	our	roundup	of	the	best	free	InDesign	templates	is	this	architecture	portfolio	template	that	offers	a	clean,	minimal	style,
comes	in	a	large-scale	A4	format	for	presenting,	and	allows	for	easy	customization,	making	it	suitable	for	other	purposes	as	well.	It’s	available	to	download	from	StockIndesign.	Book	Cover	–	Free	InDesign	Templates	Free	Next	on	our	list	is	a	stunning	paperback	book	cover	template	that	is	sure	to	draw	attention.	It	features	a	full	front	and	back	cover
design,	a	spine	that	can	be	easily	adjusted,	CMYK	color	space,	and	a	print-ready	format.	A	gold	standard	when	it	comes	to	the	best	free	InDesign	templates.	Letterhead	–	Free	InDesign	Templates	Wanting	a	letterhead	that	can	give	your	business	identity	a	boost?	Look	no	further	as	we	have	the	perfect	option	for	you.	This	is	a	minimal	yet	creative
letterhead	template	that	can	be	customized	to	meet	your	needs.	Free	Newsletter	InDesign	Template	Putting	together	a	newsletter	to	keep	your	clients,	investors,	and	community	up	to	date	on	any	changes	in	your	business?	Use	this	free	corporate	newsletter	template	from	Creative	Tacos	that	comes	in	a	versatile	A4	format	and	features	a	professional,
well-organized	layout,	as	well	as	drag	and	drop	placeholders	for	quick	editing.	Free	Resume	InDesign	Template	Land	your	dream	job	with	this	stunning	resume	set	consisting	of	a	four-page	cover	letter	and	CV	duo,	both	featuring	an	elegant	navy	and	gold	color	scheme	and	tidy,	sophisticated	fonts.	It’s	easy	to	edit	in	InDesign,	Photoshop,	Illustrator,
and	Word	and	is	available	as	a	free	download	from	Behance.	Free	Recipe	Book	InDesign	Template	What’s	cooking,	good	looking?!	Present	your	favorite	recipes	beautifully	and	professionally	with	this	free	recipe	book	template	for	InDesign,	sourced	from	InDesignSkills,	and	featuring	a	clean,	minimal	style,	elegant	serif	typography,	and	fully
customizable	layouts,	with	plenty	of	space	to	include	photos	of	your	tasty	creations.	Free	Planner	InDesign	Template	If	you’re	looking	to	create	a	custom	planner	to	write	down	your	weekly	tasks,	this	free	template	from	StockInDesign	will	make	your	job	a	lot	easier!	It	offers	a	free	checklist	and	comes	with	a	multifunctional	layout	which	can	easily	be
customized	and	edited.	Free	Calendar	InDesign	Template	Keep	track	of	important	events	and	reminders	with	this	free	A3	wall	calendar	template	from	CRS	InDesign	Templates,	perfect	for	creating	a	corporate	calendar	to	hand	out	to	clients	and	staff,	or	a	thoughtful	gift	for	your	family	and	friends!	It	features	a	large	image	area	to	showcase	photos	for
each	month.	Free	Minimalisme	Magazine	InDesign	Template	The	next	in	our	list	of	free	InDesign	templates	for	all	kinds	of	projects	is	this	contemporary	fashion	magazine	template	that	can	easily	be	adapted	to	fit	other	businesses	and	industries.	This	modern	and	trendy	design	can	be	directly	sent	to	post-production,	so	what	are	you	waiting	for?
Download	it	from	StockIndesign	now.	Free	Product	Brochure	InDesign	Template	Last	but	not	least,	we	have	this	stunning	product	brochure	template	that’s	available	for	InDesign	versions	CS4	and	above,	and	is	perfect	for	showcasing	home	decor	and	furniture,	or	any	other	retail	goods!	It	features	an	elegant	minimal	design	and	can	be	downloaded	for
free	from	Behance.	And	with	that,	we’ll	leave	you	with	this	list	of	premium	and	free	InDesign	templates	for	any	kind	of	print	project,	with	a	professional	look	guaranteed.	It’s	never	been	this	easy	to	create	stunning	designs	for	free!	Create	your	own	zine	templates	with	our	customizable	and	printable	options.	Discover	professional	quality	designs	to
elevate	your	project.	Try	now!	These	Free	Editable	Zine	Templates	from	Template.net	will	provide	you	with	trendy	and	inventive	zine	designs	that	are	certain	to	complement	your	interests.	Our	designs	include	photo	zines,	folded,	one-page,	photography,	creative,	and	mini	zines.	Surely,	Template.net's	template	library	contains	a	design	suitable	for
you.	Simply	choose	a	zine	template	you	like	and	download	it.	Customize	Online	and	Download	Our	Free	Editable	Zine	Templates	are	trendy	and	aesthetically	pleasing	zine	designs	that	will	elevate	your	expression	of	your	interests.	Our	templates	include	photo	zines,	digital	zines,	design	studio,	stom	zines,	8-page	zines,	and	quotes,	among	others.
Complete	with	photos	and	illustrations.	All	of	the	templates	in	our	template	library	are	fully	editable	via	our	built-in	editor.	You	can	effortlessly	drag	and	drop	components	such	as	photographs,	graphics,	backdrops,	and	even	different	text	and	font	styles	onto	your	publication	design.	Once	you	have	accomplished	this,	you	can	download	your	template	in
any	of	our	supported	file	formats	including	pdf.	Our	curated	list	is	divided	into	four	different	sections	where	you'll	find	both	free	and	paid	InDesign	Magazine	Templates	and	Zine	Templates.So,	without	further	ado,	feel	free	to	dive	deep	into	our	comprehensive	list.Click	on	the	links	to	jump	to	each	section:No	time	to	scroll?	Use	this	search	bar	to	find
the	magazine	styles	and	zine	templates	you	prefer:InDesign	Zine	Templates1.	Square	Magazine	Layout	with	Pop	Style	ElementsSquare	Magazine	Layout	with	Pop	Style	ElementsFun,	artistic,	and	unique!	This	template	is	the	best	when	it	comes	to	showcasing	ideas	in	a	memorable	way!	Choose	this	template	and	you	are	choosing	to	stand	out	from	the
crowd.2.	Brochure	Layout	with	Red	and	Blue	AccentsBrochure	Layout	with	Red	and	Blue	AccentsInnovative	illustrations	and	color	choices	are	what	make	this	template	unique.	The	creator	of	this	template	went	a	step	beyond	and	let	the	imagination	run	wild,	so	why	shouldn't	you	too?Go	back	to	the	selectionProfessional	InDesign	Magazine
Templates3.	Magazine	Layout	with	Yellow	AccentsMagazine	Layout	with	Yellow	AccentsDon't	be	afraid	to	show	your	true	colors!	Express	your	thoughts,	projects,	and	business	ideas	with	the	help	of	this	innovative	InDesign	Magazine	Template.	The	dominant	white	color	combined	with	black	and	yellow	details	will	definitely	grab	your	attention.4.	The
Professional	Magazine	LayoutThe	Professional	Magazine	LayoutEasy	to	customize	and	neatly	organized,	this	template	is	polished	and	professional!	It	is	suitable	for	every	single	company,	business,	and	corporation,	large	or	small.5.	The	Magazine	Article	TemplateThe	Magazine	Article	TemplateThis	template	is	strikingly	efficient,	the	layout	is	simple
and	well	structured.	It	allows	you	to	express	ideas	and	concepts	in	a	creative	way,	through	both	picture	placement	and	descriptive	text.	The	balance	between	the	two	is	perfect,	while	the	colors	are	minimal.6.	Magazine	Layout	with	Pink	and	Green	ElementsMagazine	Layout	with	Pink	and	Green	ElementsAre	you	seeking	something	soft,	feminine,	and
rather	delicate?	If	so,	this	template	has	it	all.	The	colors	in	this	InDesign	template	are	subtle	and	soothing,	the	basic	white	background	adds	a	traditional	feel	to	it,	and	the	chosen	font	adds	a	dose	of	elegance.7.	Food	Magazine	and	CookbookFood	Magazine	and	CookbookElegant,	stylish,	and	timeless!	The	flawless	design	combined	with	the	practical
layout	make	this	InDesign	magazine	template	hard	to	resist.8.	Blue	and	White	Brochure	LayoutBlue	and	White	Brochure	LayoutThis	travel	magazine	has	the	perfect	combination	of	colors,	elegant	typography,	and	versatile	pages	which	create	a	flawless	and	modern	template.	The	pages	are	rich	with	photo	placeholders,	large	headings,	and	the	overall
layout	is	very	well	balanced.9.	The	Rustic	Magazine	Article	TemplateThe	Rustic	Magazine	Article	TemplateTake	a	look	at	this	template	and	fall	in	love	with	its	perfect	rustic	feel!	The	design	is	uncluttered	and	uncomplicated.	Instead,	it	shines	with	framed	pages,	subtle	colors,	great	typographic	style,	and	a	two-column	layout.10.	Sport	Magazine	Article
Template	with	Red	AccentsSport	Magazine	Article	Template	with	Red	AccentsCreative	and	fun,	this	InDesign	Magazine	template	with	interesting	red	accents	is	perfect	if	you	are	searching	for	something	simple.	The	diamond-shaped	elements	are	distinctive	and	original,	while	the	pictures	and	classic	paragraph	layout	make	it	timeless.11.	Magazine
Layout	with	Teal	and	Orange	AccentsMagazine	Layout	with	Teal	and	Orange	AccentsThese	two	colors	combined	give	this	template	its	retro	vibe.	Elegant	and	stylish,	subtle	and	well-organized,	this	template	will	successfully	bring	your	creative	idea	to	life.12.	The	Modern	AlternativeThe	Modern	AlternativeDon't	be	afraid	to	stand	out	from	the	crowd
with	this	InDesign	Magazine	Template.	It	is	modern	and	chic,	with	bold	typography	and	large	picture	placeholders.13.	The	Bold	Typographic	StyleThe	Bold	Typographic	StyleThis	InDesign	Template	with	a	book	layout	and	bold	typographic	accents	is	suitable	for	people	who	are	looking	for	something	extraordinary	yet	user-friendly.	The	pages	have	a
creative	layout	while	the	overall	look	is	striking	and	attention	grabbing.14.	Multipurpose	MagazineMultipurpose	MagazineHere	we	have	a	classic	magazine	layout	with	no	specific	color	palette	and	no	unique	elements.	While	it	may	seem	plain,	this	template	is	essential.	It	is	the	right	fit	if	you	want	to	create	a	traditional	magazine	and	get	your	message
across	in	a	conventional	way.15.	The	Minimalist	Magazine	LayoutThe	Minimalist	Magazine	LayoutFall	in	love	with	this	InDesign	Magazine	Layout	and	its	flawless	simplicity!	All	of	the	pages	are	subtle	and	delicate,	giving	it	that	luxurious	and	high-class	feel.	You	cannot	go	wrong	if	you	choose	this	template.16.	The	Daily	Magazine	LayoutThe	Daily
Magazine	LayoutThis	template's	strength	is	its	versatility.	It	is	multipurpose	and	easy	to	customize,	so	it	can	fit	any	need.	Be	it	fashion,	travel,	living,	interior,	architecture,	or	business,	you	can't	go	wrong!17.	Magazine	Layout	with	Pale	Color	AccentsMagazine	Layout	with	Pale	Color	AccentsThey	say	less	is	more,	and	I	agree!	This	template	is	the
perfect	example.	The	subtle	color	palette	combined	with	the	interesting	elements	create	this	unforgettable	minimalism.18.	Magazine	Layout	with	Colorful	AccentsMagazine	Layout	with	Colorful	AccentsBright	colors,	creative	pages,	and	a	simple	magazine	layout.	This	template	has	a	classic	feel	but	it	makes	a	loud	statement,	one	you	won't	be	able	to
ignore.19.	Magazine	Layout	with	Red	Typographic	AccentsMagazine	Layout	with	Red	Typographic	AccentsThis	InDesign	Magazine	Template	is	anything	but	ordinary.	It	has	a	versatile	layout	with	many	possible	combinations	of	pages	and	colors.	The	red	accents	on	black	and	grey	backgrounds,	make	it	stand	out.	Overall,	this	template	is	a	memorable
one.20.	Botanic	MagazineBotanic	MagazineThis	InDesign	Magazine	is	bold	and	unique.	Its	structure	speaks	for	itself.	The	layouts	are	various	but	all	practical,	and	neatly	designed.	Let	yourself	dream	and	give	your	content	the	platform	it	deserves.21.	Black	and	White	Magazine	LayoutBlack	and	White	Magazine	LayoutThis	InDesign	Magazine
Template	is	literally	the	monochromatic	paradise.	The	pages	are	just	black	and	white,	however,	they're	far	from	being	plain	or	boring.	As	a	result,	the	design	is	so	powerful,	it	seems	brighter	than	the	clearest	rainbow.22.	The	Adjustable	Magazine	LayoutThe	Adjustable	Magazine	LayoutBring	your	idea	to	life	with	the	help	of	this	easily-adjustable
magazine.	The	colors	and	structure	can	be	changed	within	seconds.	The	design	is	straightforward	and	clean,	and	the	overall	layout	is	easy	to	read.23.	The	Dominance	of	Green	AccentsThe	Dominance	of	Green	AccentsChoose	this	template	and	you	are	choosing:	strong	structure,	captivating	details	and	bright	colors.	The	result	will	be	well-balanced	and
user-friendly.24.	Outdoor	and	Travel	Magazine	LayoutOutdoor	and	Travel	Magazine	LayoutMagazines	like	this	one,	thrive	through	visual.	Above	all,	the	photos	have	to	pop!	That's	why	this	InDesign	Magazine	Template	puts	the	accent	on	picture	placement	while	still	leaving	room	for	descriptive	paragraphs.25.	Superior	AestheticsSuperior
AestheticsThis	template	is	aesthetically	appealing	and	cleverly	designed.	In	addition,	its	practical	layout	is	easy	to	customize	and	edit.	This	template	will	fit	your	every	need.26.	Minimalist	Magazine	LayoutMinimalist	Magazine	LayoutThis	template	is	bound	to	make	quite	an	impression	on	the	reader.	Its	minimalist	design	is	beautiful	yet	practical.	The
unique	structure,	in	terms	of	text/photo	ratio,	makes	it	stand	out.	What	ties	everything	together	is	its	elegant	style.27.	Fashion	Magazine	LayoutFashion	Magazine	LayoutEdgy	and	modern!	Impressive	and	exquisite!	This	InDesign	Magazine	Template	is	suitable	for	the	fashion	industry.	The	design	is	impressive	and	neatly	organized,	the	colors	are
simple,	and	the	typography	is	bold.28.	Black	and	White	Magazine	LayoutBlack	and	White	Magazine	LayoutClassic	and	timeless;	in	other	words,	a	perfect	choice!	If	you	want	to	play	it	safe,	choose	this	template	and	your	win	is	guaranteed!29.	Magazine	Layout	with	Multicolored	Line	ElementsMagazine	Layout	with	Multicolored	Line	ElementsThe
colorful	line	element	in	this	InDesign	Magazine	template	makes	it	innovative	and	artistic.	It's	fun,	captivating,	and	interesting;	however,	the	overall	structure	is	easy	to	read	and	effortless	in	its	design.30.	Black	and	White	EleganceBlack	and	White	EleganceLess	is	indeed	more,	and	this	is	another	great	example.	This	uncluttered	template	is
sophisticated,thanks	to	the	subtle	colors,	the	well-designed	structure,	and	the	simple	typography.31.	Bold	Titles	Magazine	Article	TemplateBold	Titles	Magazine	Article	TemplateGet	your	message	across	in	a	bold	and	daring	way	with	the	help	of	this	InDesign	Magazine	Template.	It	is	modern	in	its	overall	appearance	and	its	typographic	style	really
makes	a	statement.32.	Olive	Green	AccentsOlive	Green	AccentsOne	look	at	this	template	and	you	will	fall	in	love	with	its	subtle	colors,	uncluttered	design,	basic	typography,	and	page-structure.In	other	words,	it	is	simple	yet	visually	appealing.33.	The	Fresh	DesignThe	Fresh	DesignA	colorful,	fresh,	and	clean	design	spread	across	52	unique	pages
which	can	be	easily	combined	and	customized.	Choose	this	and	brighten	up	your	content!34.	Magazine	Layout	with	Yellow	AccentsMagazine	Layout	with	Yellow	AccentsNothing	can	beat	the	killer	combination	of	black	and	white	and	yellow!	The	details	on	this	InDesign	Magazine	Template	are	stunning.	As	a	result,	it	is	unique,	vivid,	and	eye-catching!
It	is	definitely	right	if	you're	seeking	something	extraordinary.35.	Elegant	and	stylish	Magazine	LayoutElegant	and	stylish	Magazine	LayoutThis	horizontal	InDesign	Magazine	Template	has	a	subtle	brochure	vibe.	It	is	suitable	for	showcasing	and	describing	a	variety	of	products.	Overall,	this	template	is	elegant	and	contemporary.36.	The	Fashion
Froward	Lifestyle	MagazineThe	Fashion	Froward	Lifestyle	MagazineBold	graphic	elements	combined	with	flashes	of	color	and	elegant	layers,	make	this	template	suitable	for	fashion	forward	companies	that	are	trying	to	create	a	lifestyle	magazine.37.	Minimalist	Annual	Report	LayoutMinimalist	Annual	Report	LayoutAll	sorts	of	charts,	info-graphics,
and	tables	are	seen	in	this	template,	hence	its	name.	In	addition,	the	colors	are	fun	and	the	structural	elements	are	very	practical.38.	Pink	and	ModernPink	and	ModernStylish	and	fancy,	elegant	but	definitely	practical.	The	pink	details	in	this	template	add	an	unpredictable	and	contemporary	element	to	the	overall	simple	design.39.	Minimalist
Magazine	LayoutMinimalist	Magazine	LayoutUncluttered	and	straightforward	design	are	the	main	characteristics	of	this	template.	As	a	result,	it	is	easy	to	read	and	easy	to	understand.	The	simplicity	of	this	template	allows	you	to	shine	a	light	on	the	written	information.40.	The	Refined	Fashion	MagazineThe	Refined	Fashion	MagazineTwo	things	that
stand	out	in	this	template	are	the	typography	and	the	polished	structure.	The	first	gives	it	style,	while	the	second	makes	it	easy	to	read	and	allows	the	content	to	shine!41.	Recipe	Book	Layout	with	Tan	AccentsRecipe	Book	Layout	with	Tan	AccentsThis	food	magazine	has	a	typical	structure	and	layout	–	picture	on	one	side	recipe	on	the	other.	However,
the	design	is	bright	and	refreshing.	As	a	result,	the	overall	feel	to	this	magazine	is	traditional	yet	captivating.42.	Magazine	Layout	with	Photo	PlaceholdersMagazine	Layout	with	Photo	PlaceholdersIn	this	template,	the	accent	is	placed	on	the	photos,	hence	the	many	placeholders.	Therefore,	if	you	are	trying	to	express	your	ideas	visually,	then	this
magazine	is	just	perfect.43.	The	attractive	DesignThe	attractive	DesignWith	40	multipurpose	pages	of	attractive	designs	and	versatile	layouts,	this	InDesign	Magazine	Template	is	sure	to	fit	your	needs!	Any	company	or	business,	any	designer	or	creative	entrepreneur,	can	thrive	through	this	template.44.	The	Timeless	magazine	LayoutThe	Timeless
magazine	LayoutThis	template	varies	in	structure	and	layout	from	page	to	page.	However,	all	of	them	can	boast	a	unique	picture	placement,	framed	elements,	bold	highlights,	and	classic	paragraphs.45.	Architecture	Magazine	LayoutArchitecture	Magazine	LayoutClean	lines,	subtle	colors,	graceful	typography,	and	a	dose	of	edginess!	In	other	words,
this	template	is	superior!46.	Unique	Plant	ElementsUnique	Plant	ElementsSeeking	something	artistic	and	delicate?	If	the	answer	is	yes,	then	this	InDesign	Magazine	Template	is	the	one	for	you.	It	has	gentle	and	delicate	colors,	a	polished	overall	look,	and	unique	artistic	plant	elements.	Surely	it's	clear,	that	this	is	the	template	for	you!47.	Lifestyle
MagazineLifestyle	MagazineShowcase	your	ideas	and	articles	in	style	with	the	help	of	this	hand-crafted	magazine.	The	structure	of	this	template	covers	most	everything:	music,	make-up,	interior	design,	travel,	photo	essays,	fashion	spreads,	interviews,	and	so	much	more.	In	addition,	it	can	all	be	edited,	changed,	or	combined	within	seconds.48.	Green
and	White	CombinationGreen	and	White	CombinationThis	food	magazine	template	is	unique	because	unlike	similar	magazines	it	has	a	captivating	color	palette	(green	and	white).	Stand	out	from	the	crown	of	plain	white	food	magazines,	and	add	vibrant	touch	to	your	content!49.	Retro	MagazineRetro	MagazineMake	a	statement	with	the	help	of	this
retro	magazine	template.	All	throughout	the	40	pages,	the	font,	the	colors,	and	the	style	come	together	to	remind	us	of	the	good	old	days.	Get	your	message	across	in	an	unconventional	and	fun	way!50.	Brochure	Layout	with	Green	AccentsBrochure	Layout	with	Green	AccentsNatural	and	green,	soothing	and	refreshing,	this	template	is	a	dream.	The
color	scheme	is	captivating	and	the	layout	is	neatly	organized.	Above	all,	and	the	design	is	attractive	and	well-organized.51.	Delicate	Pink	AccentsDelicate	Pink	AccentsHorizontal	orientation	and	organized	layout	are	only	half	of	what	this	template	has	to	offer.	For	instance,	the	subtle	shades	of	pink	,	and	the	bold	typography	make	this	magazine
unforgettable.52.	Kids	Magazine	TemplateKids	Magazine	TemplateColorful	and	fun,	this	template	is	suitable	for	the	youngest.	The	structure	and	pages	are	bursting	with	color.	In	addition,	they	are	easy	to	understand,	while	also	being	versatile.	Above	all,	this	magazine	contains	fun	and	engaging	activities	such	as:	reading	and	writing	tasks,	puzzles,
and	all	sorts	of	games.53.	Black	and	White	Magazine	LayoutBlack	and	White	Magazine	LayoutThis	black	and	white	magazine	layout	with	bold	typographic	elements	might	not	be	unique,	but	it	will	definitely	is	practical	and	well-organized.	Additionally,	it	has	multiple	image	elements,	info-graphics,	and	interestingly	divided	pages.54.	Green-based
combination	of	Two	InDesign	TemplatesGreen-based	combination	of	Two	InDesign	TemplatesYes,	you've	read	well.	For	the	price	of	one,	you	will	be	able	to	get	two	professional	InDesign	templates.	Specifically,	you	will	get	a	total	of	82	pages.	Wow,	right?	They	are	wonderfully	done,	multipurpose,	and	easy	to	customize.55.	Book	Layout	with	Purple
Text	AccentsBook	Layout	with	Purple	Text	AccentsOne	look	at	this	template	and	you	will	fall	in	love	with	its	engaging	overall	layout.	The	colors	are	fun	and	so	is	the	typographic	style.	Above	all,	the	pages	are	created	in	a	way	that	sparks	the	reader's	curiosity.56.	Brochure	Layout	with	Pink	AccentsBrochure	Layout	with	Pink	AccentsThis	template
doesn't	as	much	space	for	descriptive	text	as	others.	However,	it	does	have	numerous	picture	placeholders,	creative	pink	and	purple	details,	and	a	delicate	feel	to	it.	As	a	result,	your	products	are	going	to	shine!57.	Science	MagazineScience	MagazineThis	template	has	an	impressive	design.	In	fact,	the	pages	are	anything	but	ordinary.	Instead	of	being
plain	white,	the	background	is	itself	the	picture.	The	descriptive	paragraph	can	be	placed	right	on	top.	How	thoughtful	and	innovative,	right?58.	The	Basic	Magazine	LayoutThe	Basic	Magazine	LayoutClassic	and	timeless	with	basic	colors	and	a	simple	layout,	this	template	is	suitable	for	anybody	who	is	searching	for	something	user-friendly.59.	Winery
Vineyard	Brochure	LayoutWinery	Vineyard	Brochure	LayoutPresent	your	Winery	Vineyard	in	a	sophisticated	way	with	the	help	of	this	beyond	luxurious	InDesign	Magazine	Template.	Tell	the	story	behind	the	wines	you	are	selling,	showcase	the	Winery	itself,	and	captivate	wine	lovers	everywhere!60.	Monochromatic	Design	Over
EverythingMonochromatic	Design	Over	EverythingSometimes	nothing	is	more	powerful	than	simplicity.	For	instance,	a	monochromatic	design.	This	particular	black	and	white	layout	leaves	enough	space	for	the	contents	to	shine	through.	In	addition	to	the	great	combination	of	colors,	this	template	is	packed	with	other	beautiful	elements.Go	back	to
the	selectionInDesign	Zine	Templates	-	Free61.	Modern	and	CleanModern	and	CleanAre	you	seeking	something	creative	and	modern	yet	simple	and	clean?	Something	that	is	easy	to	read	and	understand?	If	so	this	InDesign	zine	template	is	the	one	for	you.	Easy	to	customize	and	packed	with	all	the	vital	pages,	I	am	sure	this	template	will	cover	all	of
your	needs.62.	The	picture	dominant	zineThe	picture	dominant	zineCreative	and	visually	appealing,	this	Zine	Template	is	for	anybody	that	wants	to	showcase	business	ideas	or	projects	mostly	through	visuals.	For	this	reason,	each	page	is	made	up	of	a	dominant	picture	spot	with	a	practical	heading.63.	Retro	Proposal	LayoutRetro	Proposal	LayoutTake
black	and	white	creativity	to	another	level!	This	template	gives	out	a	retro	feel	while	still	being	artistic	and	unique.	If	you	want	to	make	a	statement,	you	cannot	go	wrong	by	choosing	this	template.64.	Art	Zine	TemplateArt	Zine	TemplateWait	no	more	to	express	your	creative	side	with	the	help	of	this	art	zine	template.	Each	page	is	a	story	on	its	own
but	together	they	create	quite	an	impressive	and	original	overall	appearance.Go	back	to	the	selectionProfessional	InDesign	Magazine	Templates	-	Free65.	Minimalist	Magazine	LayoutMinimalist	Magazine	LayoutChoose	this	InDesign	magazine	template	and	you	are	choosing	simplicity	and	elegance	over	everything.	The	fonts	in	this	template	are
tasteful	and	sophisticated.	In	addition,	the	picture	placement	is	elegant.	As	a	result,	the	overall	look	is	classic	and	timeless.66.	Elegant	Magazine	LayoutElegant	Magazine	LayoutMake	your	publication	or	project	shine	with	the	help	of	this	sophisticated	magazine	layout.	Overall,	this	template	is	refined	and	original	while	being	practical	and	easy	to
understand.67.	Food	MagazineFood	MagazineBig	and	bold	picture	placement	allows	you	to	almost	taste	and	smell	all	the	delicious	meals	you	can	fit	in	this	InDesign	magazine	template.	In	addition,	the	versatile	look	of	the	pages	lets	you	to	explain	the	recipes,	and	write	the	step	by	step	process.68.	News	MagazineNews	MagazineColorful	and	fun	yet
timeless	and	classic.	This	InDesign	Magazine	Template	will	definitely	fit	your	needs.	It's	perfect	for	all	sorts	of	news	without	being	plain.69.	Simple	Magazine	LayoutSimple	Magazine	LayoutBasic	cover	page,	white	layout	and	contrasting	colorful	“picture	pages”.	The	design	is	simple	yet	effective.	The	white	pages	are	reserved	for	descriptive	text,	while
the	picture	pages	are	perfect	to	show	what	you	are	writing	about.70.	Clean	and	ModernClean	and	ModernAre	you	searching	for	something	chic	and	stylish?	If	so,	then	this	InDesign	Template	is	the	one	for	you.	Specific	paragraphs	allow	you	to	highlight	the	important	stuff,	while	picture	pages	provide	you	with	the	related	visuals.	As	a	result,	the
overall	organized	structure	will	make	this	magazine	easy	to	read.71.	The	interesting	structureThe	interesting	structureIf	there	is	one	thing	I	find	really	interesting	in	this	InDesign	Magazine	template,	it's	the	innovative	structure.	Every	single	page	has	a	particular	creative	detail,	such	as:	statistic	elements,	unconventional	picture	layout,	table
elements,	and	so	much	more.72.	Japanese	Ready	MagazineJapanese	Ready	MagazinePicture	dominant	and	colorful,	this	Japanese	ready	magazine	has	a	great	design	and	a	tasteful	overall	feel	to	it.	It	truly	is	one	of	the	best	InDesign	magazine	templates.73.	The	Balanced	Magazine	LayoutThe	Balanced	Magazine	LayoutI've	chosen	this	name	because
this	template	has	the	perfect	balance	between	traditional	and	modern	elements.	Certainly,	this	is	a	great	way	to	make	a	good	first	impression.	The	elements	are	visually	appealing,	the	colors	are	fun,	and	the	typographic	style	is	classic.74.	Modern	Digital	Magazine	LayoutModern	Digital	Magazine	LayoutEach	and	every	page	in	this	modern	digital
magazine	template,	is	chic	and	graceful.	In	addition,	each	page	allows	you	to	tell	your	story	both	visually	and	descriptively.	In	other	words,	this	template	is	delicate,	unique,	colorful,	and	sophisticated.Go	back	to	the	selectionInDesign	Digital	Magazine	Templates	-	Free75.	Adventure	Digital	Magazine	LayoutAdventure	Digital	Magazine	LayoutCreative
and	unique,	this	InDesign	magazine	template	will	make	an	unforgettable	first	impression.	It	is	fun	and	interesting	to	read,	with	vivid	colors,	and	an	interesting	structure.76.	Black	and	White	creativityBlack	and	White	creativityThis	template	has	an	artistic	and	innovative	structure.	The	black	and	white	combination	of	colors,	the	tiny	golden	details,	the
simple	typographic	style	are	all	delightful.	In	addition,	the	picture	placement	is	very	well	balanced	with	the	descriptive	text	layout.77.	Contemporary	Digital	Magazine	LayoutContemporary	Digital	Magazine	LayoutThe	color	palette	of	this	InDesign	Magazine	Template	is	beyond	unique.	In	other	words,	it's	what	makes	this	template	stand	out.	Besides
the	colors,	the	structure	itself	and	the	overall	appearance	are	creative	and	attractive.78.	Dark	Digital	Magazine	LayoutDark	Digital	Magazine	LayoutCaptivating	and	bold.	This	digital	magazine	is	perfect	for	you	if	you	are	looking	for	something	that	will	grab	your	reader's	attention.	The	dominant	color	palette	is	red	and	black;	in	other	words,	powerful
and	distinctive.79.	Digital	Magazine	TemplateDigital	Magazine	TemplateCasual	and	straightforward,	this	digital	magazine	will	wow	you	with	its	uncluttered	and	uncomplicated	design.Go	back	to	the	selection80.	Find	your	favorite	templateWhile	we've	carefully	selected	all	the	templates	on	this	list,	sometimes	things	just	don't	click.	That's	totally	fine.
If	you	didn't	find	a	template	that	you	like,	try	using	the	form	below	to	search	among	more	than	3.000	high-quality	InDesign	templates.FAQDoes	InDesign	have	magazine	templates?Adobe	has	an	official	store	called	Adobe	Stock	where	you	will	be	able	to	find	InDesign	magazine	templates.How	do	I	make	a	magazine	in	InDesign?Creating	a	magazine	in
InDesign	is	a	complex	project	that's	composed	of	a	few	steps	such	as:	starting	a	new	InDesign	document	and	setting	up	your	layout,	creating	a	spread	and	column	guides,	adding	guides	and	text	frames,	and	finalising	your	design.	Does	InDesign	has	book	templates?Yes,	InDesign	has	book	templates	and	we've	created	a	list	with	the	best	50	InDesign
book	templates.	What	size	is	a	magazine	page	in	InDesign?The	standard	magazine	page	is	with	the	dimensions:	width	213	mm	and	height	276,5	mm.ConclusionWow,	you're	at	the	end	of	the	list!	And	what	a	big	list	it	was,	featuring	both	paid	and	free	Magazine	and	Zine	InDesign	Templates.I	hope	you've	found	what	you	were	looking	for	-	that	perfect



template	design	that	simply	spoke	to	you!	Remember	that	each	template	on	this	list	is	highly	customizable	so	let	your	imagination	and	creativity	run	wild!	Conceptualizing	a	design	is	one	thing,	but	executing	it	is	a	whole	other	ballgame	–	especially	when	creating	a	magazine	layout.	Templates	can	be	a	lifesaver	for	those	who	lack	the	time	or	skills	to
create	a	layout	from	scratch.	However,	many	templates	come	with	bloated	features	that	are	unnecessary	for	most	editorial	work.	Fortunately,	there	are	many	free	magazine	layout	templates	available	for	Adobe	InDesign	that	offer	a	clean	and	functional	design	without	any	unnecessary	frills.	To	save	you	the	trouble	of	scouring	the	web	for	the	best
options,	we	have	a	comprehensive	collection	of	templates	for	you	here.	With	these	templates,	you	can	focus	on	delivering	your	content	in	the	most	effective	and	engaging	way	possible.	You	might	also	like	our	collection	of	magazine	templates	for	Photoshop.	If	you’re	new	to	Adobe	InDesign,	you	might	like	to	take	a	look	at	our	collections	of	tutorials	to
help	you	get	started.	If	you	want	to	keep	the	look	of	your	magazine	simple,	this	minimal	layout	template	offers	a	50	page	layout	that	can	be	easily	customized	with	your	photos,	graphics,	and	text	as	you	see	fit.	It’s	an	excellent	choice	for	fashion	spreads,	design	magazines,	or	even	publications	that	feature	human-interest	stories.	It’s	printable	in	A4	and
US	Letter	sizes	and	includes	paragraph	and	character	styles.	Free	Minimal	Magazine	InDesign	Template	This	free	minimal	magazine	InDesign	template	is	an	excellent	choice	if	your	magazine	is	photo-heavy.	Thanks	to	its	two-	and	half-page	photographic	spreads,	I	can	easily	see	it	used	for	fashion	or	travel	publications.	It	consists	of	24	pages,	has
automatic	numbering,	and	is	very	easy	to	customize.	InDesign	Magazine	Template	This	magazine	template	offers	a	stylish	way	to	present	your	editorial	content	to	your	target	audience.	Its	overall	look	is	best	described	as	professional,	and	it	could	be	used	for	a	variety	of	industries,	from	corporate	magazines	to	niche	publications.	It	includes	26	pages,
free	fonts,	and	paragraph	styles,	and	it	is	print-ready.	Once	your	design	is	completed,	it	can	be	exported	to	the	presses.	D-Zine	Free	Magazine	InDesign	Template	The	D-Ziner	free	magazine	template	is	an	absolute	stunner.	This	InDesign	template	includes	a	mixture	of	layouts	that	can	be	arranged	to	create	a	sense	of	unpredictability	in	your	design.
This	template,	with	various	graphical	elements,	text	boxes,	and	paragraph	styles,	will	appeal	to	tech	enthusiasts	and	those	who	favor	bold	design	choices.	Food	Magazine	InDesign	Template	It’s	all	in	the	name.	The	‘Food	Magazine’	is	a	beautiful	InDesign	template	for	food	publications	or	anything	related	to	the	culinary	arts.	It	comes	with	13	page
layouts,	and	includes	all	the	fonts	and	photos	you	can	see	in	the	preview	below.	It’s	fully	printable	in	standard	US	magazine	(but	can	be	resized	if	needed).	Free	Magazine	InDesign	Template	This	free	InDesign	template	can	be	used	for	any	type	or	style	of	publication	but	is	best	suited	to	the	financial	sector.	There	are	layouts	for	text-heavy	articles,
photographic	galleries,	and	statistic	callouts	to	keep	readers	engaged	and	informed.	It’s	available	for	personal	and	commercial	use.	Stunning	Photography	Magazine	Template	for	InDesign	This	stunning	photography	InDesign	template	has	an	elegant	design	that	can	be	adapted	for	any	type	of	photography	magazine.	It	could	also	be	used	for	a	lifestyle
or	travel	magazine.	It	comes	with	paragraph	and	character	styles,	a	cover	page,	a	table	of	contents,	five-page	layouts,	and	an	overall	aesthetic	that	will	appeal	to	many	budding	editorial	creators.	Modern	Fashion	Magazine	InDesign	Layout	This	fashion	magazine	template	offers	bold	layouts	that	will	showcase	photography	beautifully.	We’re	talking
full-page	spreads	that	feature	edge-to-edge	photographs,	a	fully	editable	design,	and	a	landscape	layout	that	will	make	your	publication	stand	out.	Colorful	Shop	Brochure	Layout	for	InDesign	This	colorful	commerce	brochure	layout	has	many	uses	and	looks	lovely	while	doing	so.	This	template	features	bold	colors	that	will	readily	stand	out	on	the
magazine	rack.	The	color	scheme	is	comprised	of	gradients	that	make	for	a	sunset-esque	appearance.	This	template	is	fully	editable,	in	CMYK,	and	sized	for	A4	and	US	Letters.	Once	you’re	finished	designing,	just	click	print.	It’s	as	easy	as	that!	Stylish	Food	Magazine	Template	for	InDesign	This	stylish	food	magazine	template	for	InDesign	is	easy	to
edit	and	offers	a	slightly	more	editorial	style	than	typical	food	magazines.	It	includes	automatic	page	numbering,	bold	and	graphical	layouts,	and	typography	styles,	making	putting	together	a	magazine	centered	around	food	very	easy.	Bernard	Fashion	InDesign	Magazine	Template	The	Bernard	Fashion	InDesign	magazine	template	includes	24	page
layout	designs,	which	ensures	your	magazine’s	layout	will	have	fresh	and	exciting	perspectives	on	every	page.	You	can	set	the	custom	color	schemes,	use	the	included	paragraph	styles,	and	print	your	magazine	in	A4	or	US	Letter	sizes.	It’s	a	solid	choice	for	fashion	publications	as	well	as	architectural	or	artistic	endeavors.	Simple	Magazine	Cover
Template	for	InDesign	This	simple	magazine	cover	template	makes	quite	the	first	impression.	It	features	full-page	photography	layouts	and	bold	headers.	It	has	been	designed	for	business	publications.	You	can	customize	the	color	swatches,	fonts,	photos,	and	typography.	Plus,	the	article	headings	are	highlighted	and	colorful,	allowing	your	best
content	to	stand	out.	Multi-Purpose	Magazine	InDesign	Template	The	multi-purpose	magazine	template	offers	26	unique	page	layouts	that	can	be	customized	to	suit	any	industry,	profession,	or	area	of	focus.	It	can	be	custom-tailored	for	any	type	of	publication.	Thanks	to	automatic	page	numbering,	free	fonts,	paragraph	and	character	styles,	and
customizable	graphics,	this	magazine	template	is	an	excellent	choice	if	you’re	not	quite	sure	about	the	focus	or	direction	of	your	publication	at	the	outset.	Fashion	Magazine	Cover	Template	This	is	another	free	magazine	template	that	will	pique	the	interest	of	your	readers.	It	is	a	fashion	magazine	template	that	supports	full-page	photography	and
offers	multiple	content	teasers,	bright	headers,	custom	fonts,	and	paragraph	styles.	Marketing	Booklet	Template	for	Adobe	InDesign	The	Marketing	Booklet	Template	keeps	things	simple,	but	sometimes	that’s	all	you	need	—	especially	if	you’re	just	interested	in	putting	out	a	quick	booklet	to	spread	specific	information	about	your	business	or	a	given
industry.	Sport	Magazine	InDesign	Template	If	you	want	to	launch	a	sports	or	fitness	magazine,	this	InDesign	template	is	a	great	choice.	It	includes	30	pages	of	custom	layouts,	three	cover	layouts,	paragraph	and	character	styles,	a	grid	layout,	and	free	fonts	that	you	can	use	in	your	finished	product.	The	file	is	fully	editable,	and	every	element	is	on	a
separate	layer,	making	customization	much	easier.	Grid	Wireframe	Editorial	Layouts	for	InDesign	This	free	InDesign	template	includes	both	wireframe	and	standard	magazine	layouts.	It	is	a	collection	of	various	grid	layouts	that	can	be	used	and	adapted	for	multiple	purposes.	You	can	use	the	wireframes	to	build	a	publication	entirely	from	scratch.
This	is	especially	helpful	if	you	have	a	specific	design	in	mind	and	are	unable	to	find	what	you	need	in	pre-built	templates.	Santal	Magazine	&	Editorial	Templates	for	InDesign	Santal	is	a	free	InDesign	magazine	template	with	76	different	page	layout	templates!	It	is	perfect	for	putting	together	a	double	or	special	issue.	It’s	in	A4	and	US	letter	sizes,	is
fully	print-ready,	and	includes	separate	images,	text,	and	graphics	layers.	It	uses	open-source	fonts,	so	you	can	easily	replicate	the	typography	style	in	the	template’s	sample	pages.	Finally,	it	also	includes	multiple	paragraph	and	character	styles	for	true	customization.	Summit	Magazine	InDesign	Template	The	Summit	Magazine	template	is	perfect	for
adventure,	travel,	or	outdoor	magazines.	It	has	15	custom	page	layouts	for	creating	a	design	that	works	for	your	content.	Thanks	to	organized	layers	and	unlimited	color	selection,	it	is	easy	to	make	your	own.	Archtype	Magazine	InDesign	Template	The	Archtype	Magazine	template	is	an	excellent	choice	for	architecture	magazines.	However,	it	could
also	be	used	for	interior	design,	fashion,	or	home	magazines.	The	layouts	within	this	template’s	pages	can	help	you	tell	an	in-depth	story	or	even	promote	items	for	sale.	It	has	a	wide	range	of	flexibility,	which	is	impressive	for	a	free	template.	Hubspot	Free	Ebook	Templates	for	InDesign	HubSpot	is	a	go-to	source	for	marketing	assistance,	and	in
keeping	with	that	theme,	they	offer	free	ebook	templates	for	download.	These	InDesign	templates	can	be	easily	adapted	for	magazine	publishing	and	used	for	print	and	digital	publications.	The	designs	are	simple	and	bold,	perfect	for	conveying	business-focused	information.	Professional	&	Clean	Magazine	InDesign	Template	This	InDesign	magazine
template	is	excellent	for	general	interest,	fashion,	home	and	garden,	art,	and	many	other	publications.	It’s	a	multi-purpose	template	with	a	professional	yet	clean	design	that	is	readily	adaptable.	Some	features	include	32	page	layouts,	three	magazine	covers,	free	fonts,	automatic	page	numbering,	and	a	grid	or	column-based	layout.	Memphis	Design-
Inspired	Magazine	Layout	for	InDesign	The	Memphis	Design-Inspired	Magazine	template	has	a	retro	aesthetic	while	maintaining	a	modern	edge.	It	has	20	pages	that	you	can	fully	customize	by	adding	your	own	content.	It’s	print-ready	in	CMYK	in	A4	or	US	Letter	sizes.	The	overall	80s	look	could	work	well	for	vintage-inspired	magazines,	themed
corporation	publications,	or	a	vintage	fashion	periodical.	Hipster	Magazine	Template	for	InDesign	Here’s	another	free	template	with	plenty	of	whitespace.	This	template	features	20	pages	and	is	printable	in	A4	and	US	Letter	sizes,	giving	you	ample	room	to	feature	large	photography,	quotes,	and	other	textual	callouts.	Free	Instruction	Book	InDesign
Template	This	free	instruction	book	template	might	not	have	been	originally	designed	as	a	magazine	layout,	but	it	can	be	adapted	for	any	publication	purpose.	It	would	be	perfect	for	a	technology	magazine	that	publishes	step-by-step	instructions	or	tutorials.	You	could	also	use	it	as	a	corporate	booklet	or	brochure.	Modern	Magazine	Cover	Template
for	InDesign	This	free	InDesign	template	only	has	a	single	page	layout,	but	you	can	use	this	page	to	create	a	custom	cover	for	your	magazine.	This	cover	template	includes	the	photography	and	fonts	featured	in	the	sample,	but	you	can	easily	swap	them	out	with	your	own	for	a	truly	custom	look.	Newspaper	Template	for	InDesign	If	newspapers	are
more	your	thing,	or	you	want	to	create	a	magazine	with	a	traditional	newspaper	look,	then	this	newspaper	template	for	InDesign	is	what	you’re	looking	for.	It	comes	with	six	page	layouts	and	features	all	the	elements	you’d	expect	from	a	newspaper:	headlines,	spots	for	photographs,	column-aligned	text,	pull	quotes,	captions,	and	spots	for	ads.
Conclusion	Can	you	believe	all	of	these	templates	are	free?	This	collection	of	free	magazine	and	editorial	layout	templates	covers	a	wide	range	of	industries	and	topics,	and	one	is	sure	to	pique	your	interest.	Why	not	try	a	couple	to	see	which	best	fits	your	publication?	Browse	our	curated	collections	of	InDesign	Templates,	including	brochures,	flyers,
proposals,	stationery,	resumes,	portfolios,	lookbooks,	magazine	layouts,	and	more.	More	InDesign	Templates	Paul	is	the	founder	and	editor	of	Speckyboy	Design	Magazine.	He	has	a	passion	for	UI	design,	print	design,	motion	design,	and	graphic	design,	and	loves	discovering	and	sharing	new	resources	and	templates.	Read	more	articles	by	Paul
Andrew	Share	—	copy	and	redistribute	the	material	in	any	medium	or	format	for	any	purpose,	even	commercially.	Adapt	—	remix,	transform,	and	build	upon	the	material	for	any	purpose,	even	commercially.	The	licensor	cannot	revoke	these	freedoms	as	long	as	you	follow	the	license	terms.	Attribution	—	You	must	give	appropriate	credit	,	provide	a
link	to	the	license,	and	indicate	if	changes	were	made	.	You	may	do	so	in	any	reasonable	manner,	but	not	in	any	way	that	suggests	the	licensor	endorses	you	or	your	use.	ShareAlike	—	If	you	remix,	transform,	or	build	upon	the	material,	you	must	distribute	your	contributions	under	the	same	license	as	the	original.	No	additional	restrictions	—	You	may
not	apply	legal	terms	or	technological	measures	that	legally	restrict	others	from	doing	anything	the	license	permits.	You	do	not	have	to	comply	with	the	license	for	elements	of	the	material	in	the	public	domain	or	where	your	use	is	permitted	by	an	applicable	exception	or	limitation	.	No	warranties	are	given.	The	license	may	not	give	you	all	of	the
permissions	necessary	for	your	intended	use.	For	example,	other	rights	such	as	publicity,	privacy,	or	moral	rights	may	limit	how	you	use	the	material.	PrintablesFree.Org	|	Indesign	Zine	Template	Free	-	InDesign	Zine	Templates	Professional	InDesign	Magazine	Templates	InDesign	Zine	Templates	Free	Professional	InDesign	Magazine	Templates	Free
InDesign	Digital	Magazine	Templates	Free	Search	for	more	magazine	and	zine	templates	28	000	No	time	to	scroll	Use	this	search	bar	to	find	the	magazine	styles	and	zine	templates	you	prefer	.Indesign	Zine	Template	Free25	Creative	Free	InDesign	Templates	Envato	Tuts	Find	Download	Free	Graphic	Resources	for	Indesign	Template	Zine	Vectors
Stock	Photos	PSD	files	Free	for	commercial	use	High	Quality	Images.2	Zine	Template	for	InDesign	Bold	colors	and	gradients	make	this	brilliant	design	come	to	life	Check	out	this	free	InDesign	template	that	s	printable	and	easy	to	edit	3	Free	InDesign	Template	Trifold	Brochure	Create	a	summer	brochure	that	s	ideal	for	warmer	climates	and	beach
businesses	Enjoy	high	resolution	files	and	free	fonts	.Download	free	InDesign	templates	for	Adobe	InDesign	including	flyer	templates	brochure	templates	book	templates	report	templates	portfolio	templates	and	much	more	Here	you	ll	find	exceptionally	stylish	InDesign	templates	to	help	you	make	a	start	on	marketing	campaigns	design	projects	and
social	media	templates	Created	by	our	team	of	.55	Free	InDesign	Templates	For	Stunning	2025	Print	Projects	Free	Minimal	Zine	InDesign	Template	This	is	a	free	InDesign	template	featuring	a	fully	minimalist	and	simple	page	design	It	s	ideal	for	making	modern	magazine	brochures	especially	for	creative	agencies	and	brands	The	template	is	available
in	MS	Word	format	as	well	Free	Marketing	Proposal	InDesign	Template.An	Affinity	Publisher	and	InDesign	template	for	creating	a	classic	mini	zine	with	1	sheet	of	paper	An	Affinity	Publisher	and	InDesign	template	for	creating	a	classic	mini	zine	with	1	sheet	of	paper	The	template	pack	also	includes	a	set	of	printing	and	assembly	instructions	free	for
you	to	include	with	your	digital	zine	sales	so	that	folks	.80	Cool	Zines	and	InDesign	Magazine	Templates	2024	InDesign	Zine	Templates	Professional	InDesign	Magazine	Templates	InDesign	Zine	Templates	Free	Professional	InDesign	Magazine	Templates	Free	InDesign	Digital	Magazine	Templates	Free	Search	for	more	magazine	and	zine	templates	28
000	No	time	to	scroll	Use	this	search	bar	to	find	the	magazine	styles	and	zine	templates	you	prefer	.Simply	choose	a	zine	template	you	like	and	download	it	Customize	Online	and	Download	Our	Free	Editable	Zine	Templates	are	trendy	and	aesthetically	pleasing	zine	designs	that	will	elevate	your	expression	of	your	interests	Our	templates	include
photo	zines	digital	zines	design	studio	stom	zines	8	page	zines	and	quotes	among	others	.Make	DIY	Self	Published	Tutorial	or	Photography	Zine	Layout	with	Template	s	Zine	Templates	in	InDesign	Zine	Making	Has	Never	Been	This	Easy	.Disclaimer:	All	photos	featured	on	this	site	are	the	residential	property	of	their	respective	copyright	proprietors.	If
you	have	any	kind	of	inquiries	or	concerns	relating	to	acknowledgment	or	image	elimination,	please	don't	be	reluctant	to	call	us.Zine	Template	for	InDesign	|	Free	Download	for	Indesign	Zine	Template	Free80	Cool	Zines	and	InDesign	Magazine	Templates	(2024)	|	Redokun	Blog	for	Indesign	Zine	Template	FreeZine	Template	for	InDesign	|	Free
Download	for	Indesign	Zine	Template	FreeFREE	Single	Page	Mini	Zine	Adobe	InDesign	Template	—	CINIC	Studio	-	Creating	in	Treaty	7	for	Indesign	Zine	Template	Free80	Cool	Zines	and	InDesign	Magazine	Templates	(2024)	|	Redokun	Blog	for	Indesign	Zine	Template	Free80	Cool	Zines	and	InDesign	Magazine	Templates	(2024)	|	Redokun	Blog	for
Indesign	Zine	Template	FreeZine	making	Resources	-	Tallis	A-Level	Photography	for	Indesign	Zine	Template	FreeIndesign	Zine	Template	Free	Images	GalleryZine	Template	for	InDesign	|	Free	DownloadFREE	Single	Page	Mini	Zine	Adobe	InDesign	Template	—	CINIC	Studio	-	Creating	in	Treaty	780	Cool	Zines	and	InDesign	Magazine	Templates	(2024)
|	Redokun	Blog80	Cool	Zines	and	InDesign	Magazine	Templates	(2024)	|	Redokun	BlogZine	making	Resources	-	Tallis	A-Level	PhotographyHow	to	Create	a	Zine	Template	in	InDesign	|	Envato	Tuts+How	to	Make	a	Zine	in	InDesign	|	6-Step	Tutorial	(with	free	template)80	Cool	Zines	and	InDesign	Magazine	Templates	(2024)	|	Redokun	Blog35	InDesign
Magazine	Templates	2025	-	DesignerCandiesFREE	Single	Page	Mini	Zine	Adobe	InDesign	Template	—	CINIC	Studio	-	Creating	in	Treaty	7Frequently	Asked	Question	(FAQs)1.What	are	downloadable	products	that	can	be	published	at	no	charge?Downloadable	printables	are	complimentary	digital	data	that	can	be	accessed	and	printed	from	the	comfort
of	your	very	own	home	or	at	a	nearby	printing	service.	These	flexible	sources	include	an	including	business	coordinators,	instructional	worksheets,	attractive	art,	interactive	coloring	materials,	all	offered	at	no	charge.2.	What	kind	of	info	or	material	can	site	visitors	expect	to	locate	on	your	website?Our	website	includes	a	broad	range	of	short	articles
gathered	from	different	exterior	resources.	We	provide	a	diverse	option	of	content,	such	as	academic	sources	and	imaginative	prints,	working	as	a	one-stop	destination	for	users	looking	for	info	and	materials.3.	Is	the	material	on	you?We	do	not	insist	proprietorships	over	any	trademarks,	visuals,	or	written	content	included	on	our	system.	All	materials
continue	to	be	the	intellectual	property	of	their	respective	creators.	Our	purpose	is	to	accumulate	and	make	these	sources	easily	available	to	our	individuals.4.	Exactly	how	can	I	download	and	install	free	printables	from	your	site?To	access	free	printables,	simply	click	the	preferred	picture	with	your	ideal	mouse	switch,	select	the	"Conserve	photo	as"
choice,	and	then	pick	a	destination	on	your	tool	to	save	the	data.	This	uncomplicated	approach	makes	it	possible	for5.	Are	the	printables	in	high-quality	layouts?The	majority	of	the	free	downloadable	products	readily	available	on	our	internet	site	remain	in	widely	utilized	photo	layouts	like	PNG	and	JPG.	These	formats	are	produced	to	guarantee	top
quality	for	specific	use.	If	you	need	a	much	better	quality	edition	or	a	certain	dimension,	we	recommend	looking	into	the	original	site	that	is	linked	in	our	content.6.	How	can	I	acquire	a	greater	resolution	or	more	detailed	variation	of	a	printable	if	the	existing	one	is	insufficient?If	the	printable	you	downloaded	and	install	has	a	watermark	or	if	you	need
a	better	version,	we	urge	you	to	check	out	the	initial	site	connected	in	our	content.	This	guarantees	you	can	access	the	best	quality	straight	from	the	source.7.	What	actions	should	I	take	if	a	printable	has	a	watermark?Experiencing	a	printable	with	a	watermark	frequently	suggests	that	it	is	not	the	high-quality	version.	In	such	circumstances,	you	can
see	the	initial	resource	and	search	for	the	option	to	download	the	clearer,	unmarked	version.8.	Am	I	permitted	to	utilize	the	free	printables	for	company	usage?The	printables	offered	on	our	website	are	meant	for	personal	and	educational	use	just.	For	any	business	usage,	it	is	recommended	to	inspect	the	original	source's	conditions	to	ensure
compliance	with	their	usage	policies.9.	What	is	the	reason	behind	giving	the	printables	at	no	charge?The	free	printables	are	sourced	from	different	external	platforms	and	are	supplied	to	improve	access	to	helpful	and	creative	sources.	This	campaign	permits	individuals	to	gain	from	varied	and	abundant	content	with	no	financial	burden.10.	Where	do
you	locate	your	free	printable	resources?We	collect	free	printable	resources	from	widely	known	internet	search	engine	such	as	Bing,	Google,	and	DuckDuckGo.	After	careful	option,	we	assemble	a	variety	of	these	products	to	supply	individuals	with	a	vast	variety	of	downloadable	resources	done	in	one	convenient	area.11.	What	file	kinds	do	the	free	of
charge	downloadable	sources	on	your	website	can	be	found	in?A	lot	of	the	free	printables	available	on	our	site	remain	in	PNG	and	JPG	formats.	These	common	picture	formats	are	chosen	for	their	broad	compatibility	and	ease	of	use,	making	them	ideal	for	personal	and	educational	functions.	templates	Magazines	Zine	Template	for	InDesign	Complete
with	an	elegant	layout	for	the	inside	pages	and	a	wraparound	cover,	this	downloadable	zine	template	features	creative	typography,	black	and	white	photography	and	an	on-trend	design	throughout.	Unlimited	Downloads:	1,000,000+	InDesign	Templates,	Mockups	&	Design	Assets	by	This	zine	template	includes	a	front	and	back	cover,	professional-
standard	text	formatting,	page	numbers,	master	pages,	a	bold	colour	palette,	and	simple	and	stylish	geometric	backgrounds.	Scroll	down	to	find	out	more,	and	download	the	template.	Zine	template	size:	14.8cm	x	21	cm	14.8cm	x	21cm	is	a	great	zine	size,	however	other	sizes	are	widely	used.	Don’t	panic	if	you	need	a	different	size,	we’ve	put	together
a	handy	little	tutorial	on	how	to	resize	templates	.	Below	you	can	preview	a	selection	of	spreads	from	this	photography	zine	template,	download	the	InDesign	file	and	find	a	bunch	of	helpful	tips	on	how	to	edit	your	template	in	InDesign.	Download	this	12-page	Zine	Template	Download	this	zine	template*	for	free	(your	download	will	include	an	INDD	file
for	InDesign	CS6	and	an	IDML	version	for	opening	in	InDesign	CS4,	CS5	or	CC):	Download	Template	(Free)	*Note	that	images	are	not	included	in	your	free	download.	Font	files	Cormorant	–	Font	Squirrel		Help	Working	with	InDesign	Templates	We’ve	put	together	a	collection	of	helpful	tips	to	make	editing	our	InDesign	Templates	super	easy.	If	you’re
a	newbie	to	Adobe	InDesign	it’s	worth	checking	these	out	before	starting	work	on	your	design.	Unlimited	Downloads:	1,000,000+	Fonts,	Mockups	&	Design	Assets	by	How	to	Open	an	InDesign	Template	Step	1.	Download	the	file.	UNLIMITED	DOWNLOADS:	50	Million+	Fonts	&	Design	Assets	Step	2.	Our	InDesign	templates	are	packaged	and	saved	as
ZIP	files.	If	you	have	a	Windows	computer	Right	Click	>	Extract	All	before	opening	the	InDesign	file.	Step	3.	If	you’re	running	InDesign	CS6	open	the	INDD	version	of	the	file.	If	you’re	working	with	InDesign	CS4,	CS5	or	CC	open	the	IDML	version.	How	to	Work	With	Layers	in	Your	Template	Our	InDesign	templates	are	organized	into	layers,	which
group	similar	elements	together.	The	layers	in	your	document	can	be	controlled	from	the	Layers	panel	(Window	>	Layers).	Pro	tip:	Try	locking	the	YOUR	IMAGES	HERE	layer	to	save	time	when	editing	text.	This	will	prevent	you	from	accidentally	moving	the	graphics	out	of	position.	How	to	Change	the	Colors	The	color	scheme	of	this	template	can	be
edited	from	the	Swatches	panel	(Window	>	Color	>	Swatches).	Pro	tip:	Editing	a	swatch	will	automatically	update	all	instances	of	that	color	across	your	document.	How	to	Add	Your	Own	Text	The	text	across	this	design	can	easily	replaced	with	your	own	copy.	Simple	use	the	Type	Tool	(T)	to	select	the	text	box	you	wish	to	edit.	You	can	then	add	your
own	fonts	and	formatting.	Read	more	about	formatting	text	in	InDesign.	How	to	Add	Your	Own	Images	You’ll	notice	when	you	first	open	the	template	that	all	the	image	frames	have	a	placeholder	image.	You	can	insert	your	own	images	by	selecting	the	image	frame	and	using	File	>	Place	to	select	a	replacement	image.	Read	our	beginner’s	guide	to
working	with	images	in	InDesign.	Pro	tip:	Do	your	images	look	blurry?	Make	sure	your	display	is	set	to	high-quality	(View	>	Display	Performance	>	High-Quality	Display).	To	see	more	accurately	how	your	design	will	appear	when	printed	go	to	View	>	Overprint	Preview.	How	to	Resize	Pages	in	InDesign	It’s	simple	to	change	the	width	of	the	spine	in
your	template	by	using	the	Page	Tool	(Shift+P).	Select	the	tool	and	then	click	onto	the	spine	to	select	it.	You	can	drag	the	sides	of	the	page	to	preview	your	desired	new	size.	Hold	down	Alt	or	Option	while	you	drag	to	resize	the	page.	Read	more	about	resizing	pages	in	InDesign.	How	to	Export	Your	Document	for	Printing	Once	you’ve	completed	work
on	your	template	and	you’re	ready	to	print	it		you	can	head	to	File	>	Export.	To	create	a	print-ready	file,	choose	Adobe	PDF	(Print)	from	the	Format	drop-down	menu	in	the	Export	window.	Make	sure	to	include	the	bleed	in	your	export	options	by	checking	Use	Document	Bleed	Settings	in	the	Export	Adobe	PDF	window.	Read	more	about	prepping	your
designs	for	printing	in	InDesign.	How	to	Change	the	Fonts	in	a	Document	You	can	format	individual	items	of	text	using	the	Type	Tool	(T)	and	Controls	panel,	which	you’ll	find	running	along	the	top	of	the	InDesign	workspace.	The	fonts	in	most	templates	are	not	set	as	InDesign	styles.	However,	it’s	easy	to	create	a	Character	or	Paragraph	Style	using
existing	text	formatting,	and	then	edit	this	from	the	Styles	panels	(Window	>	Styles).	Read	more	about	editing	Styles	in	InDesign.	Discover	more	advice	for	InDesign	beginners	on	our	Tutorials	page.	Or	why	not	discover	inspiration	about	typography,	layout	design	and	much	more	right	here.	Computer	operating	systems	"Windows"	redirects	here.	For
the	part	of	a	building,	see	Window.	For	other	uses,	see	Windows	(disambiguation).	This	article	needs	additional	citations	for	verification.	Please	help	improve	this	article	by	adding	citations	to	reliable	sources.	Unsourced	material	may	be	challenged	and	removed.Find	sources:	"Microsoft	Windows"	–	news	·	newspapers	·	books	·	scholar	·	JSTOR
(December	2024)	(Learn	how	and	when	to	remove	this	message)	Operating	system	WindowsLogo	as	of	October	2021DeveloperMicrosoftSource	modelClosed-sourceSource-available	(through	Shared	Source	Initiative)Initial	releaseNovember	20,	1985;	39	years	ago	(1985-11-20)Latest	release24H2	(10.0.26100.4351)	(June	11,	2025;	13	days	ago	(2025-
06-11)[1])	[±]Latest	preview	Release	Preview	Channel	24H2	(10.0.26100.4482)	(June	19,	2025;	5	days	ago	(2025-06-19)[2][3])	[±]	Beta	Channel	24H2	(10.0.26120.4452)	(June	23,	2025;	1	day	ago	(2025-06-23)[4])	[±]	Dev	Channel	24H2	(10.0.26200.5661)	(June	23,	2025;	1	day	ago	(2025-06-23)[5])	[±]	Canary	Channel	10.0.27881.1000	(June	19,	2025;
5	days	ago	(2025-06-19)[6])	[±]Marketing	targetPersonal	computingAvailable	in110	languagesUpdate	methodWindows	UpdateMicrosoft	StoreWindows	Server	Update	Services	(WSUS)Package	managerWindows	Installer	(.msi,	.msp),[7]	App	Installer	(.msix,.[8]	msixbundle[9][10]),	Microsoft	Store	(.appx,	.appxbundle),[11]	Windows	Package
ManagerPlatformsIA-32,	x86-64,	ARM,	ARM64	Previously:	16-bit	x86,	DEC	Alpha,	MIPS,	PowerPC,	ItaniumKernel	type	Windows	NT	family:	Hybrid	Windows	Embedded	Compact/Windows	CE:	Hybrid	or	Monolithic	Windows	9x	and	earlier:	Monolithic	(MS-DOS	and	VMM32)	Defaultuser	interfaceWindows	shellLicenseProprietary	commercial
softwareOfficial	websitewindows.com	Windows	is	a	product	line	of	proprietary	graphical	operating	systems	developed	and	marketed	by	Microsoft.	It	is	grouped	into	families	and	subfamilies	that	cater	to	particular	sectors	of	the	computing	industry	–	Windows	(unqualified)	for	a	consumer	or	corporate	workstation,	Windows	Server	for	a	server	and
Windows	IoT	for	an	embedded	system.	Windows	is	sold	as	either	a	consumer	retail	product	or	licensed	to	third-party	hardware	manufacturers	who	sell	products	bundled	with	Windows.[citation	needed]	The	first	version	of	Windows,	Windows	1.0,	was	released	on	November	20,	1985,	as	a	graphical	operating	system	shell	for	MS-DOS	in	response	to	the
growing	interest	in	graphical	user	interfaces	(GUIs).[12]	The	name	"Windows"	is	a	reference	to	the	windowing	system	in	GUIs.[13]	The	1990	release	of	Windows	3.0	catapulted	its	market	success	and	led	to	various	other	product	families,	including	the	now-defunct	Windows	9x,	Windows	Mobile,	Windows	Phone,	and	Windows	CE/Embedded	Compact.
Windows	is	the	most	popular	desktop	operating	system	in	the	world,	with	a	70%	market	share	as	of	March	2023[update],	according	to	StatCounter;[14]	however	when	including	mobile	operating	systems,	it	is	in	second	place,	behind	Android.[15]	The	most	recent	version	of	Windows	is	Windows	11	for	consumer	PCs	and	tablets,	Windows	11	Enterprise
for	corporations,	and	Windows	Server	2025	for	servers.	Still	supported	are	some	editions	of	Windows	10,	Windows	Server	2016	or	later	(and	exceptionally	with	paid	support	down	to	Windows	Server	2008).[16][17]	This	section	needs	additional	citations	for	verification.	Please	help	improve	this	article	by	adding	citations	to	reliable	sources	in	this
section.	Unsourced	material	may	be	challenged	and	removed.	(December	2024)	(Learn	how	and	when	to	remove	this	message)	As	of	2025,[update]	the	only	active	top-level	family	is	Windows	NT.[citation	needed]	The	first	version,	Windows	NT	3.1,	was	intended	for	server	computing	and	corporate	workstations.	It	grew	into	a	product	line	of	its	own	and
now	consists	of	four	sub-families	that	tend	to	be	released	almost	simultaneously	and	share	the	same	kernel.	Windows	(unqualified):	For	a	consumer	or	corporate	workstation	or	tablet.	The	latest	version	is	Windows	11.[citation	needed]	Its	main	competitors	are	macOS	by	Apple	and	Linux	for	personal	computers	and	iPadOS	and	Android	for	tablets	(cf.
Usage	share	of	operating	systems	§	Market	share	by	category).	Of	note:	"Windows"	refers	to	both	the	overall	product	line	and	this	sub-family	of	it.	Windows	Server:	For	a	server	computer.	The	latest	version	is	Windows	Server	2025.	Unlike	its	client	sibling,	it	has	adopted	a	strong	naming	scheme.	The	main	competitor	of	this	family	is	Linux.	(cf.	Usage
share	of	operating	systems	§	Market	share	by	category)	Windows	PE:	A	lightweight	version	of	its	Windows	sibling,	meant	to	operate	as	a	live	operating	system,	used	for	installing	Windows	on	bare-metal	computers	(especially	on	many	computers	at	once),	recovery,	or	troubleshooting	purposes.	The	latest	version	is	Windows	PE	10.[citation	needed]
Windows	IoT	(previously	Windows	Embedded):	For	IoT	and	embedded	computers.	The	latest	version	is	Windows	11	IoT	Enterprise.[18]	Like	Windows	Server,	the	main	competitor	of	this	family	is	Linux.	(cf.	Usage	share	of	operating	systems	§	Market	share	by	category)	These	top-level	Windows	families	are	no	longer	actively	developed:	Windows	9x:
Intended	exclusively	for	the	consumer	market.	The	first	version	was	Windows	95,	which	was	followed	by	Windows	98.	The	last	version	of	the	Windows	9x	family	was	Windows	Me,	which	was	widely	regarded	as	one	of	the	worst	operating	systems	of	all	time,	with	PC	World	labeling	it	as	"Mistake	Edition"	and	placing	it	4th	in	their	list	of	Worst	Tech
Products	in	2006[19]).	All	versions	of	the	Windows	9x	family	have	a	monolithic	kernel	that	uses	MS-DOS	as	a	foundation	alongside	the	kernel	first	used	with	Windows	95.	This	line	has	since	been	defunct,	with	Microsoft	now	catering	to	the	consumer	market	with	Windows	NT	starting	with	Windows	XP.[citation	needed]	Windows	Mobile:	The
predecessor	to	Windows	Phone,	a	mobile	phone	and	PDA	operating	system.	The	first	version	was	called	Pocket	PC	2000.	The	third	version,	Windows	Mobile	2003,	was	the	first	version	to	adopt	the	Windows	Mobile	trademark.	The	last	published	version	was	Windows	Mobile	6.5.	Windows	Phone:	Sold	only	to	smartphone	manufacturers.	The	first
version	was	Windows	Phone	7,	followed	by	Windows	Phone	8	and	Windows	Phone	8.1.	It	was	succeeded	by	Windows	10	Mobile,	which	is	also	defunct.	Windows	Embedded	Compact:	Most	commonly	known	by	its	former	name,	Windows	CE,	it	is	a	hybrid	kernel	operating	system	optimized	for	low	power	and	memory	systems,	with	OEMs	able	to	modify
the	UI	to	suit	their	needs.	The	final	version	was	Windows	Embedded	Compact	2013,	and	it	is	succeeded	by	Windows	IoT.[citation	needed]	Main	article:	Microsoft	Windows	version	history	See	also:	List	of	Microsoft	Windows	versions	The	term	Windows	collectively	describes	any	or	all	of	several	generations	of	Microsoft	operating	system	products.
These	products	are	generally	categorized	as	follows:	Main	articles:	Windows	1.0,	Windows	2.0,	and	Windows	2.1	The	history	of	Windows	dates	back	to	1981	when	Microsoft	started	work	on	a	program	called	"Interface	Manager".	The	name	"Windows"	comes	from	the	fact	that	the	system	was	one	of	the	first	to	use	graphical	boxes	to	represent
programs;	in	the	industry,	at	the	time,	these	were	called	"windows"	and	the	underlying	software	was	called	"windowing	software."[13]	It	was	announced	in	November	1983	(after	the	Apple	Lisa,	but	before	the	Macintosh)	under	the	name	"Windows",	but	Windows	1.0	was	not	released	until	November	1985.[20]	Windows	1.0	was	to	compete	with	Apple's
operating	system,	but	achieved	little	popularity.	Windows	1.0	is	not	a	complete	operating	system;	rather,	it	extends	MS-DOS.	The	shell	of	Windows	1.0	is	a	program	known	as	the	MS-DOS	Executive.	Components	included	Calculator,	Calendar,	Cardfile,	Clipboard	Viewer,	Clock,	Control	Panel,	Notepad,	Paint,	Reversi,	Terminal	and	Write.	Windows	1.0
does	not	allow	overlapping	windows.	Instead,	all	windows	are	tiled.	Only	modal	dialog	boxes	may	appear	over	other	windows.	Microsoft	sold	as	included	Windows	Development	libraries	with	the	C	development	environment,	which	included	numerous	windows	samples.[21]	Windows	2.0	was	released	in	December	1987,	and	was	more	popular	than	its
predecessor.	It	features	several	improvements	to	the	user	interface	and	memory	management.[22]	Windows	2.03	changed	the	OS	from	tiled	windows	to	overlapping	windows.	The	result	of	this	change	led	to	Apple	Computer	filing	a	suit	against	Microsoft	alleging	infringement	on	Apple's	copyrights	(eventually	settled	in	court	in	Microsoft's	favor	in
1993).[23][24]	Windows	2.0	also	introduced	more	sophisticated	keyboard	shortcuts	and	could	make	use	of	expanded	memory.	Windows	2.1	was	released	in	two	different	versions:	Windows/286	and	Windows/386.	Windows/386	uses	the	virtual	8086	mode	of	the	Intel	80386	to	multitask	several	DOS	programs	and	the	paged	memory	model	to	emulate
expanded	memory	using	available	extended	memory.	Windows/286,	in	spite	of	its	name,	runs	on	both	Intel	8086	and	Intel	80286	processors.	It	runs	in	real	mode	but	can	make	use	of	the	high	memory	area.[25]	In	addition	to	full	Windows	packages,	there	were	runtime-only	versions	that	shipped	with	early	Windows	software	from	third	parties	and	made
it	possible	to	run	their	Windows	software	on	MS-DOS	and	without	the	full	Windows	feature	set.	The	early	versions	of	Windows	are	often	thought	of	as	graphical	shells,	mostly	because	they	ran	on	top	of	MS-DOS	and	used	it	for	file	system	services.[26]	However,	even	the	earliest	Windows	versions	already	assumed	many	typical	operating	system
functions;	notably,	having	their	own	executable	file	format	and	providing	their	own	device	drivers	(timer,	graphics,	printer,	mouse,	keyboard	and	sound).	Unlike	MS-DOS,	Windows	allowed	users	to	execute	multiple	graphical	applications	at	the	same	time,	through	cooperative	multitasking.	Windows	implemented	an	elaborate,	segment-based,	software
virtual	memory	scheme,	which	allows	it	to	run	applications	larger	than	available	memory:	code	segments	and	resources	are	swapped	in	and	thrown	away	when	memory	became	scarce;	data	segments	moved	in	memory	when	a	given	application	had	relinquished	processor	control.	Main	articles:	Windows	3.0	and	Windows	3.1	Windows	3.0,	released	in
1990	Windows	3.0,	released	in	1990,	improved	the	design,	mostly	because	of	virtual	memory	and	loadable	virtual	device	drivers	(VxDs)	that	allow	Windows	to	share	arbitrary	devices	between	multi-tasked	DOS	applications.[citation	needed]	Windows	3.0	applications	can	run	in	protected	mode,	which	gives	them	access	to	several	megabytes	of	memory
without	the	obligation	to	participate	in	the	software	virtual	memory	scheme.	They	run	inside	the	same	address	space,	where	the	segmented	memory	provides	a	degree	of	protection.	Windows	3.0	also	featured	improvements	to	the	user	interface.	Microsoft	rewrote	critical	operations	from	C	into	assembly.	Windows	3.0	was	the	first	version	of	Windows
to	achieve	broad	commercial	success,	selling	2	million	copies	in	the	first	six	months.[27][28]	Versions	before	Windows	95	had	to	be	installed	from	floppy	disks	by	end	users	(or	in	professional	environments	with	a	network	installation);	here	Windows	for	Workgroups	with	nine	3.5-inch-disks	to	be	inserted	sequentially.	Windows	3.1,	made	generally
available	on	March	1,	1992,	featured	a	facelift.	In	October	1992,	Windows	for	Workgroups,	a	special	version	with	integrated	peer-to-peer	networking	features,	was	released.	It	was	sold	along	with	Windows	3.1.	Support	for	Windows	3.1	ended	on	December	31,	2001.[29]	Windows	3.2,	released	in	1994,	is	an	updated	version	of	the	Chinese	version	of
Windows	3.1.[30]	The	update	was	limited	to	this	language	version,	as	it	fixed	only	issues	related	to	the	complex	writing	system	of	the	Chinese	language.[31]	Windows	3.2	was	generally	sold	by	computer	manufacturers	with	a	ten-disk	version	of	MS-DOS	that	also	had	Simplified	Chinese	characters	in	basic	output	and	some	translated	utilities.[citation
needed]	Main	articles:	Windows	9x,	Windows	95,	Windows	98,	and	Windows	Me	The	next	major	consumer-oriented	release	of	Windows,	Windows	95,	was	released	on	August	24,	1995.	While	still	remaining	MS-DOS-based,	Windows	95	introduced	support	for	native	32-bit	applications,	plug	and	play	hardware,	preemptive	multitasking,	long	file	names
of	up	to	255	characters,	and	provided	increased	stability	over	its	predecessors.	Windows	95	also	introduced	a	redesigned,	object	oriented	user	interface,	replacing	the	previous	Program	Manager	with	the	Start	menu,	taskbar,	and	Windows	Explorer	shell.	Windows	95	was	a	major	commercial	success	for	Microsoft;	Ina	Fried	of	CNET	remarked	that	"by
the	time	Windows	95	was	finally	ushered	off	the	market	in	2001,	it	had	become	a	fixture	on	computer	desktops	around	the	world."[32]	Microsoft	published	four	OEM	Service	Releases	(OSR)	of	Windows	95,	each	of	which	was	roughly	equivalent	to	a	service	pack.	The	first	OSR	of	Windows	95	was	also	the	first	version	of	Windows	to	be	bundled	with
Microsoft's	web	browser,	Internet	Explorer.[33]	Mainstream	support	for	Windows	95	ended	on	December	31,	2000,	and	extended	support	for	Windows	95	ended	on	December	31,	2001.[34]	Windows	95	was	followed	up	with	the	release	of	Windows	98	on	June	25,	1998,	which	introduced	the	Windows	Driver	Model,	support	for	USB	composite	devices,
support	for	ACPI,	hibernation,	and	support	for	multi-monitor	configurations.	Windows	98	also	included	integration	with	Internet	Explorer	4	through	Active	Desktop	and	other	aspects	of	the	Windows	Desktop	Update	(a	series	of	enhancements	to	the	Explorer	shell	which	was	also	made	available	for	Windows	95).	In	May	1999,	Microsoft	released
Windows	98	Second	Edition,	an	updated	version	of	Windows	98.	Windows	98	SE	added	Internet	Explorer	5.0	and	Windows	Media	Player	6.2	amongst	other	upgrades.	Mainstream	support	for	Windows	98	ended	on	June	30,	2002,	and	extended	support	for	Windows	98	ended	on	July	11,	2006.[35]	On	September	14,	2000,	Microsoft	released	Windows
Me	(Millennium	Edition),	the	last	DOS-based	version	of	Windows.	Windows	Me	incorporated	visual	interface	enhancements	from	its	Windows	NT-based	counterpart	Windows	2000,	had	faster	boot	times	than	previous	versions	(which	however,	required	the	removal	of	the	ability	to	access	a	real	mode	DOS	environment,	removing	compatibility	with
some	older	programs),[36]	expanded	multimedia	functionality	(including	Windows	Media	Player	7,	Windows	Movie	Maker,	and	the	Windows	Image	Acquisition	framework	for	retrieving	images	from	scanners	and	digital	cameras),	additional	system	utilities	such	as	System	File	Protection	and	System	Restore,	and	updated	home	networking	tools.[37]
However,	Windows	Me	was	faced	with	criticism	for	its	speed	and	instability,	along	with	hardware	compatibility	issues	and	its	removal	of	real	mode	DOS	support.	PC	World	considered	Windows	Me	to	be	one	of	the	worst	operating	systems	Microsoft	had	ever	released,	and	the	fourth	worst	tech	product	of	all	time.[19]	Main	article:	Windows	NT	Main
articles:	Windows	NT	3.1,	Windows	NT	3.5,	Windows	NT	3.51,	Windows	NT	4.0,	and	Windows	2000	Windows	logo	(1995–2001)	In	November	1988,	a	new	development	team	within	Microsoft	(which	included	former	Digital	Equipment	Corporation	developers	Dave	Cutler	and	Mark	Lucovsky)	began	work	on	a	revamped	version	of	IBM	and	Microsoft's
OS/2	operating	system	known	as	"NT	OS/2".	NT	OS/2	was	intended	to	be	a	secure,	multi-user	operating	system	with	POSIX	compatibility	and	a	modular,	portable	kernel	with	preemptive	multitasking	and	support	for	multiple	processor	architectures.	However,	following	the	successful	release	of	Windows	3.0,	the	NT	development	team	decided	to
rework	the	project	to	use	an	extended	32-bit	port	of	the	Windows	API	known	as	Win32	instead	of	those	of	OS/2.	Win32	maintained	a	similar	structure	to	the	Windows	APIs	(allowing	existing	Windows	applications	to	easily	be	ported	to	the	platform),	but	also	supported	the	capabilities	of	the	existing	NT	kernel.	Following	its	approval	by	Microsoft's	staff,
development	continued	on	what	was	now	Windows	NT,	the	first	32-bit	version	of	Windows.	However,	IBM	objected	to	the	changes,	and	ultimately	continued	OS/2	development	on	its	own.[38][39]	Windows	NT	was	the	first	Windows	operating	system	based	on	a	hybrid	kernel.	The	hybrid	kernel	was	designed	as	a	modified	microkernel,	influenced	by	the
Mach	microkernel	developed	by	Richard	Rashid	at	Carnegie	Mellon	University,	but	without	meeting	all	of	the	criteria	of	a	pure	microkernel.	The	first	release	of	the	resulting	operating	system,	Windows	NT	3.1	(named	to	associate	it	with	Windows	3.1)	was	released	in	July	1993,	with	versions	for	desktop	workstations	and	servers.	Windows	NT	3.5	was
released	in	September	1994,	focusing	on	performance	improvements	and	support	for	Novell's	NetWare,	and	was	followed	up	by	Windows	NT	3.51	in	May	1995,	which	included	additional	improvements	and	support	for	the	PowerPC	architecture.	Windows	NT	4.0	was	released	in	June	1996,	introducing	the	redesigned	interface	of	Windows	95	to	the	NT
series.	On	February	17,	2000,	Microsoft	released	Windows	2000,	a	successor	to	NT	4.0.	The	Windows	NT	name	was	dropped	at	this	point	in	order	to	put	a	greater	focus	on	the	Windows	brand.[39]	Main	article:	Windows	XP	A	variation	of	the	2001–2006	Windows	logo	from	2003	using	the	Segoe	typeface	instead	of	the	Franklin	Gothic	typeface.	This
variation	was	mainly	used	for	branding	purposes.	The	next	major	version	of	Windows	NT,	Windows	XP,	was	released	to	manufacturing	(RTM)	on	August	24,	2001,	and	to	the	general	public	on	October	25,	2001.	The	introduction	of	Windows	XP	aimed	to	unify	the	consumer-oriented	Windows	9x	series	with	the	architecture	introduced	by	Windows	NT,	a
change	which	Microsoft	promised	would	provide	better	performance	over	its	DOS-based	predecessors.	Windows	XP	would	also	introduce	a	redesigned	user	interface	(including	an	updated	Start	menu	and	a	"task-oriented"	Windows	Explorer),	streamlined	multimedia	and	networking	features,	Internet	Explorer	6,	integration	with	Microsoft's	.NET
Passport	services,	a	"compatibility	mode"	to	help	provide	backwards	compatibility	with	software	designed	for	previous	versions	of	Windows,	and	Remote	Assistance	functionality.[40][41]	At	retail,	Windows	XP	was	marketed	in	two	main	editions:	the	"Home"	edition	was	targeted	towards	consumers,	while	the	"Professional"	edition	was	targeted
towards	business	environments	and	power	users,	and	included	additional	security	and	networking	features.	Home	and	Professional	were	later	accompanied	by	the	"Media	Center"	edition	(designed	for	home	theater	PCs,	with	an	emphasis	on	support	for	DVD	playback,	TV	tuner	cards,	DVR	functionality,	and	remote	controls),	and	the	"Tablet	PC"
edition	(designed	for	mobile	devices	meeting	its	specifications	for	a	tablet	computer,	with	support	for	stylus	pen	input	and	additional	pen-enabled	applications).[42][43][44]	Mainstream	support	for	Windows	XP	ended	on	April	14,	2009.	Extended	support	ended	on	April	8,	2014.[45]	After	Windows	2000,	Microsoft	also	changed	its	release	schedules	for
server	operating	systems;	the	server	counterpart	of	Windows	XP,	Windows	Server	2003,	was	released	in	April	2003.[39]	It	was	followed	in	December	2005,	by	Windows	Server	2003	R2.	Main	article:	Windows	Vista	After	a	lengthy	development	process,	Windows	Vista	was	released	on	November	30,	2006,	for	volume	licensing	and	January	30,	2007,	for
consumers.	It	contained	a	number	of	new	features,	from	a	redesigned	shell	and	user	interface	to	significant	technical	changes,	with	a	particular	focus	on	security	features.	It	was	available	in	a	number	of	different	editions,	and	has	been	subject	to	some	criticism,	such	as	drop	of	performance,	longer	boot	time,	criticism	of	new	UAC,	and	stricter	license
agreement.	Vista's	server	counterpart,	Windows	Server	2008	was	released	in	early	2008.	Main	article:	Windows	7	On	July	22,	2009,	Windows	7	and	Windows	Server	2008	R2	were	released	to	manufacturing	(RTM)	and	released	to	the	public	three	months	later	on	October	22,	2009.	Unlike	its	predecessor,	Windows	Vista,	which	introduced	a	large
number	of	new	features,	Windows	7	was	intended	to	be	a	more	focused,	incremental	upgrade	to	the	Windows	line,	with	the	goal	of	being	compatible	with	applications	and	hardware	with	which	Windows	Vista	was	already	compatible.[46]	Windows	7	has	multi-touch	support,	a	redesigned	Windows	shell	with	an	updated	taskbar	with	revealable	jump
lists	that	contain	shortcuts	to	files	frequently	used	with	specific	applications	and	shortcuts	to	tasks	within	the	application,[47]	a	home	networking	system	called	HomeGroup,[48]	and	performance	improvements.	Main	articles:	Windows	8	and	Windows	8.1	Windows	logo	(2012–2015)	Windows	8,	the	successor	to	Windows	7,	was	released	generally	on
October	26,	2012.	A	number	of	significant	changes	were	made	on	Windows	8,	including	the	introduction	of	a	user	interface	based	around	Microsoft's	Metro	design	language	with	optimizations	for	touch-based	devices	such	as	tablets	and	all-in-one	PCs.	These	changes	include	the	Start	screen,	which	uses	large	tiles	that	are	more	convenient	for	touch
interactions	and	allow	for	the	display	of	continually	updated	information,	and	a	new	class	of	apps	which	are	designed	primarily	for	use	on	touch-based	devices.	The	new	Windows	version	required	a	minimum	resolution	of	1024×768	pixels,[49]	effectively	making	it	unfit	for	netbooks	with	800×600-pixel	screens.	Other	changes	include	increased
integration	with	cloud	services	and	other	online	platforms	(such	as	social	networks	and	Microsoft's	own	OneDrive	(formerly	SkyDrive)	and	Xbox	Live	services),	the	Windows	Store	service	for	software	distribution,	and	a	new	variant	known	as	Windows	RT	for	use	on	devices	that	utilize	the	ARM	architecture,	and	a	new	keyboard	shortcut	for
screenshots.[50][51][52][53][54][55][56]	An	update	to	Windows	8,	called	Windows	8.1,[57]	was	released	on	October	17,	2013,	and	includes	features	such	as	new	live	tile	sizes,	deeper	OneDrive	integration,	and	many	other	revisions.	Windows	8	and	Windows	8.1	have	been	subject	to	some	criticism,	such	as	the	removal	of	the	Start	menu.	Main	article:
Windows	10	Windows	logo	(2015–2021)	On	September	30,	2014,	Microsoft	announced	Windows	10	as	the	successor	to	Windows	8.1.	It	was	released	on	July	29,	2015,	and	addresses	shortcomings	in	the	user	interface	first	introduced	with	Windows	8.	Changes	on	PC	include	the	return	of	the	Start	Menu,	a	virtual	desktop	system,	and	the	ability	to	run
Windows	Store	apps	within	windows	on	the	desktop	rather	than	in	full-screen	mode.	Windows	10	is	said	to	be	available	to	update	from	qualified	Windows	7	with	SP1,	Windows	8.1	and	Windows	Phone	8.1	devices	from	the	Get	Windows	10	Application	(for	Windows	7,	Windows	8.1)	or	Windows	Update	(Windows	7).[58]	In	February	2017,	Microsoft
announced	the	migration	of	its	Windows	source	code	repository	from	Perforce	to	Git.	This	migration	involved	3.5	million	separate	files	in	a	300-gigabyte	repository.[59]	By	May	2017,	90	percent	of	its	engineering	team	was	using	Git,	in	about	8500	commits	and	1760	Windows	builds	per	day.[59]	In	June	2021,	shortly	before	Microsoft's	announcement
of	Windows	11,	Microsoft	updated	their	lifecycle	policy	pages	for	Windows	10,	revealing	that	support	for	their	last	release	of	Windows	10	will	end	on	October	14,	2025.[60][61]	On	April	27,	2023,	Microsoft	announced	that	version	22H2	would	be	the	last	of	Windows	10.[62][63]	Windows	logo	(2021–present)	Main	article:	Windows	11	On	June	24,	2021,
Windows	11	was	announced	as	the	successor	to	Windows	10	during	a	livestream.	The	new	operating	system	was	designed	to	be	more	user-friendly	and	understandable.	It	was	released	on	October	5,	2021.[64][65]	As	of	May	2022,[update]	Windows	11	is	a	free	upgrade	to	Windows	10	users	who	meet	the	system	requirements.[66]	See	also:	Azure
Virtual	Desktop	Not	to	be	confused	with	Microsoft	365	or	Windows/386.	In	July	2021,	Microsoft	announced	it	will	start	selling	subscriptions	to	virtualized	Windows	desktops	as	part	of	a	new	Windows	365	service	in	the	following	month.	The	new	service	will	allow	for	cross-platform	usage,	aiming	to	make	the	operating	system	available	for	both	Apple
and	Android	users.	It	is	a	separate	service	and	offers	several	variations	including	Windows	365	Frontline,	Windows	365	Boot,	and	the	Windows	365	app.[67]	The	subscription	service	will	be	accessible	through	any	operating	system	with	a	web	browser.	The	new	service	is	an	attempt	at	capitalizing	on	the	growing	trend,	fostered	during	the	COVID-19
pandemic,	for	businesses	to	adopt	a	hybrid	remote	work	environment,	in	which	"employees	split	their	time	between	the	office	and	home".	As	the	service	will	be	accessible	through	web	browsers,	Microsoft	will	be	able	to	bypass	the	need	to	publish	the	service	through	Google	Play	or	the	Apple	App	Store.[68][69][70][71][72]	Microsoft	announced
Windows	365	availability	to	business	and	enterprise	customers	on	August	2,	2021.[73]	See	also:	Multilingual	User	Interface	Multilingual	support	has	been	built	into	Windows	since	Windows	3.0.	The	language	for	both	the	keyboard	and	the	interface	can	be	changed	through	the	Region	and	Language	Control	Panel.	Components	for	all	supported	input
languages,	such	as	Input	Method	Editors,	are	automatically	installed	during	Windows	installation	(in	Windows	XP	and	earlier,	files	for	East	Asian	languages,	such	as	Chinese,	and	files	for	right-to-left	scripts,	such	as	Arabic,	may	need	to	be	installed	separately,	also	from	the	said	Control	Panel).	Third-party	IMEs	may	also	be	installed	if	a	user	feels	that
the	provided	one	is	insufficient	for	their	needs.	Since	Windows	2000,	English	editions	of	Windows	NT	have	East	Asian	IMEs	(such	as	Microsoft	Pinyin	IME	and	Microsoft	Japanese	IME)	bundled,	but	files	for	East	Asian	languages	may	be	manually	installed	on	Control	Panel.	Interface	languages	for	the	operating	system	are	free	for	download,	but	some
languages	are	limited	to	certain	editions	of	Windows.	Language	Interface	Packs	(LIPs)	are	redistributable	and	may	be	downloaded	from	Microsoft's	Download	Center	and	installed	for	any	edition	of	Windows	(XP	or	later)	–	they	translate	most,	but	not	all,	of	the	Windows	interface,	and	require	a	certain	base	language	(the	language	which	Windows
originally	shipped	with).	This	is	used	for	most	languages	in	emerging	markets.	Full	Language	Packs,	which	translate	the	complete	operating	system,	are	only	available	for	specific	editions	of	Windows	(Ultimate	and	Enterprise	editions	of	Windows	Vista	and	7,	and	all	editions	of	Windows	8,	8.1	and	RT	except	Single	Language).	They	do	not	require	a
specific	base	language	and	are	commonly	used	for	more	popular	languages	such	as	French	or	Chinese.	These	languages	cannot	be	downloaded	through	the	Download	Center,	but	are	available	as	optional	updates	through	the	Windows	Update	service	(except	Windows	8).	The	interface	language	of	installed	applications	is	not	affected	by	changes	in	the
Windows	interface	language.	The	availability	of	languages	depends	on	the	application	developers	themselves.	Windows	8	and	Windows	Server	2012	introduce	a	new	Language	Control	Panel	where	both	the	interface	and	input	languages	can	be	simultaneously	changed,	and	language	packs,	regardless	of	type,	can	be	downloaded	from	a	central	location.
The	PC	Settings	app	in	Windows	8.1	and	Windows	Server	2012	R2	also	includes	a	counterpart	settings	page	for	this.	Changing	the	interface	language	also	changes	the	language	of	preinstalled	Windows	Store	apps	(such	as	Mail,	Maps	and	News)	and	certain	other	Microsoft-developed	apps	(such	as	Remote	Desktop).	The	above	limitations	for	language
packs	are	however	still	in	effect,	except	that	full	language	packs	can	be	installed	for	any	edition	except	Single	Language,	which	caters	to	emerging	markets.	Windows	NT	included	support	for	several	platforms	before	the	x86-based	personal	computer	became	dominant	in	the	professional	world.	Windows	NT	4.0	and	its	predecessors	supported
PowerPC,	DEC	Alpha	and	MIPS	R4000	(although	some	of	the	platforms	implement	64-bit	computing,	the	OS	treated	them	as	32-bit).	Windows	2000	dropped	support	for	all	platforms,	except	the	third	generation	x86	(known	as	IA-32)	or	newer	in	32-bit	mode.	The	client	line	of	the	Windows	NT	family	still	ran	on	IA-32	up	to	Windows	10[66]	(the	server
line	of	the	Windows	NT	family	still	ran	on	IA-32	up	to	Windows	Server	2008).	With	the	introduction	of	the	Intel	Itanium	architecture	(IA-64),	Microsoft	released	new	versions	of	Windows	to	support	it.	Itanium	versions	of	Windows	XP	and	Windows	Server	2003	were	released	at	the	same	time	as	their	mainstream	x86	counterparts.	Windows	XP	64-Bit
Edition	(Version	2003),	released	in	2003,	is	the	last	Windows	client	operating	system	to	support	Itanium.	Windows	Server	line	continues	to	support	this	platform	until	Windows	Server	2012;	Windows	Server	2008	R2	is	the	last	Windows	operating	system	to	support	Itanium	architecture.	On	April	25,	2005,	Microsoft	released	Windows	XP	Professional
x64	Edition	and	Windows	Server	2003	x64	editions	to	support	x86-64	(or	simply	x64),	the	64-bit	version	of	x86	architecture.	Windows	Vista	was	the	first	client	version	of	Windows	NT	to	be	released	simultaneously	in	IA-32	and	x64	editions.	As	of	2024,	x64	is	still	supported.	An	edition	of	Windows	8	known	as	Windows	RT	was	specifically	created	for
computers	with	ARM	architecture,	and	while	ARM	is	still	used	for	Windows	smartphones	with	Windows	10,	tablets	with	Windows	RT	will	not	be	updated.	Starting	from	Windows	10	Fall	Creators	Update	(version	1709)	and	later	includes	support	for	ARM-based	PCs.[74]	Main	articles:	Windows	CE	and	Windows	Phone	Windows	CE	(officially	known	as
Windows	Embedded	Compact),	is	an	edition	of	Windows	that	runs	on	minimalistic	computers,	like	satellite	navigation	systems	and	some	mobile	phones.	Windows	Embedded	Compact	is	based	on	its	own	dedicated	kernel,	dubbed	Windows	CE	kernel.	Microsoft	licenses	Windows	CE	to	OEMs	and	device	makers.	The	OEMs	and	device	makers	can	modify
and	create	their	own	user	interfaces	and	experiences,	while	Windows	CE	provides	the	technical	foundation	to	do	so.	Windows	CE	was	used	in	the	Dreamcast	along	with	Sega's	own	proprietary	OS	for	the	console.	Windows	CE	was	the	core	from	which	Windows	Mobile	was	derived.	Its	successor,	Windows	Phone	7,	was	based	on	components	from	both
Windows	CE	6.0	R3	and	Windows	CE	7.0.	Windows	Phone	8	however,	is	based	on	the	same	NT-kernel	as	Windows	8.	Windows	Embedded	Compact	is	not	to	be	confused	with	Windows	XP	Embedded	or	Windows	NT	4.0	Embedded,	modular	editions	of	Windows	based	on	Windows	NT	kernel.	Main	article:	Xbox	system	software	Xbox	OS	is	an	unofficial
name	given	to	the	version	of	Windows	that	runs	on	Xbox	consoles.[75]	From	Xbox	One	onwards	it	is	an	implementation	with	an	emphasis	on	virtualization	(using	Hyper-V)	as	it	is	three	operating	systems	running	at	once,	consisting	of	the	core	operating	system,	a	second	implemented	for	games	and	a	more	Windows-like	environment	for	applications.
[76]	Microsoft	updates	Xbox	One's	OS	every	month,	and	these	updates	can	be	downloaded	from	the	Xbox	Live	service	to	the	Xbox	and	subsequently	installed,	or	by	using	offline	recovery	images	downloaded	via	a	PC.[77]	It	was	originally	based	on	NT	6.2	(Windows	8)	kernel,	and	the	latest	version	runs	on	an	NT	10.0	base.	This	system	is	sometimes
referred	to	as	"Windows	10	on	Xbox	One".[78][79]	Xbox	One	and	Xbox	Series	operating	systems	also	allow	limited	(due	to	licensing	restrictions	and	testing	resources)	backward	compatibility	with	previous	generation	hardware,[80]	and	the	Xbox	360's	system	is	backwards	compatible	with	the	original	Xbox.[81]	Up	to	and	including	every	version	before
Windows	2000,	Microsoft	used	an	in-house	version	control	system	named	Source	Library	Manager	(SLM).	Shortly	after	Windows	2000	was	released,	Microsoft	switched	to	a	fork	of	Perforce	named	Source	Depot.[82]	This	system	was	used	up	until	2017	once	the	system	could	not	keep	up	with	the	size	of	Windows.[citation	needed]	Microsoft	had	begun
to	integrate	Git	into	Team	Foundation	Server	in	2013,[83]	but	Windows	(and	Office)	continued	to	rely	on	Source	Depot.[84]	The	Windows	code	was	divided	among	65	different	repositories	with	a	kind	of	virtualization	layer	to	produce	unified	view	of	all	of	the	code.[citation	needed]	In	2017	Microsoft	announced	that	it	would	start	using	Git,	an	open
source	version	control	system	created	by	Linus	Torvalds,	and	in	May	2017	they	reported	that	the	migration	into	a	new	Git	repository	was	complete.[59][85][86]	Each	Git	repository	contains	a	complete	history	of	all	the	files,	which	tends	to	be	very	large	for	Windows.[87]	Microsoft	has	been	working	on	a	new	project	called	the	Virtual	File	System	for	Git
(VFSForGit)	to	address	these	challenges.[86]	In	2021	the	VFS	for	Git	was	superseded	by	Scalar.[88]	Legend:UnsupportedSupportedLatest	versionPreview	versionFuture	version	Table	of	Windows	versions	Product	name	Latest	version	General	availability	date	Codename	Support	until[89]	Latest	version	of	Mainstream	Extended	IE	DirectX	Edge
Unsupported:	Windows	1.0	1.04	November	20,	1985	Interface	Manager	December	31,	2001	—	—	—	Unsupported:	Windows	2.0	2.03	December	9,	1987	—	Unsupported:	Windows	2.1	2.11	May	27,	1988	—	Unsupported:	Windows	3.0	3.0	May	22,	1990	—	Unsupported:	Windows	3.1	3.1	April	6,	1992	—	5	Unsupported:	Windows	For	Workgroups	3.1	3.1
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Unsupported:	Windows	NT	3.51	NT	3.51.1057	May	30,	1995	—	5	Unsupported:	Windows	95	4.0.950	August	24,	1995	Chicago,	4.0	December	31,	2000	December	31,	2001	5.5	8.0a	Unsupported:	Windows	NT	4.0	NT	4.0.1381	July	31,	1996	Cairo	June	30,	2002	June	30,	2004	6	3.0a	Unsupported:	Windows	98	4.10.1998	June	25,	1998	Memphis,	97,	4.1
July	11,	2006	9.0c	Unsupported:	Windows	98	SE	4.10.2222	May	5,	1999	—	Unsupported:	Windows	2000	NT	5.0.2195	February	17,	2000	—	June	30,	2005	July	13,	2010	Unsupported:	Windows	Me	4.90.3000	September	14,	2000	Millennium,	4.9	December	31,	2003	July	11,	2006	Unsupported:	Windows	XP	NT	5.1.2600	October	25,	2001	Whistler	April
14,	2009	April	8,	2014	8	Unsupported:	Windows	XP	64-bit	Edition	NT	5.2.3790	March	28,	2003	—	Unsupported:	Windows	Server	2003	April	24,	2003	Whistler	Server	July	13,	2010	July	14,	2015	Unsupported:	Windows	XP	Professional	x64	Edition	April	25,	2005	—	April	14,	2009	April	8,	2014	Unsupported:	Windows	Fundamentals	for	Legacy	PCs	NT
5.1.2600	July	8,	2006	Eiger,	Mönch	Unsupported:	Windows	Vista	NT	6.0.6003	January	30,	2007	Longhorn	April	10,	2012	April	11,	2017	9	11	Unsupported:	Windows	Home	Server	NT	5.2.4500	November	4,	2007	Quattro	January	8,	2013	8	9.0c	Unsupported:	Windows	Server	2008	NT	6.0.6003	February	27,	2008	Longhorn	Server	January	13,	2015
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October	9,	2018	October	10,	2023	11.1	Unsupported:	Windows	8	October	26,	2012	—	January	12,	2016	10	Unsupported:	Windows	8.1	NT	6.3.9600	October	17,	2013	Blue	January	9,	2018	January	10,	2023	11	11.2	Unsupported:	Windows	Server	2012	R2	October	18,	2013	Server	Blue	October	9,	2018	October	10,	2023	Supported:	Windows	10	NT
10.0.19045	July	29,	2015	Various	October	14,	2025[60][61]	12	136	Supported:	Windows	Server	2016	NT	10.0.14393	October	12,	2016	—	January	11,	2022	January	12,	2027	Supported:	Windows	Server	2019	NT	10.0.17763	October	2,	2018	—	January	9,	2024	January	9,	2029	Supported:	Windows	Server	2022	NT	10.0.20348	August	18,	2021	—
October	13,	2026	October	14,	2031	Latest	version:	Windows	11	NT	10.0.26100	October	5,	2021	Various	October	12,	2027[91]	—	Latest	version:	Windows	Server	2025	NT	10.0.26100	November	1,	2024	—	October	9,	2029	October	10,	2034	Timeline	of	Windows	versions	vte	The	Windows	family	tree	Main	article:	Usage	share	of	operating	systems	This
box:	viewtalkedit	Version	market	share	As	a	percentage	of	desktop	and	laptop	systems	using	Microsoft	Windows,[92]	according	to	StatCounter	data	as	of	June	2025[93]:	Desktop	OS	StatCounter	Other	versions	0.06%	Windows	XP	0.37%	Windows	7	2.26%	Windows	8	0.44%	Windows	8.1	0.3%	Windows	10	48.93%	Windows	11	47.54%	Use	of	Windows
10	has	exceeded	Windows	7	globally	since	early	2018.[94]	For	desktop	and	laptop	computers,	according	to	Net	Applications	and	StatCounter	(which	track	the	use	of	operating	systems	in	devices	that	are	active	on	the	Web),	Windows	was	the	most	used	operating-system	family	in	August	2021,	with	around	91%	usage	share	according	to	Net
Applications[95]	and	around	76%	usage	share	according	to	StatCounter.[96]	Including	personal	computers	of	all	kinds	(e.g.,	desktops,	laptops,	mobile	devices,	and	game	consoles),	Windows	OSes	accounted	for	32.67%	of	usage	share	in	August	2021,	compared	to	Android	(highest,	at	46.03%),	iOS's	13.76%,	iPadOS's	2.81%,	and	macOS's	2.51%,
according	to	Net	Applications[97]	and	30.73%	of	usage	share	in	August	2021,	compared	to	Android	(highest,	at	42.56%),	iOS/iPadOS's	16.53%,	and	macOS's	6.51%,	according	to	StatCounter.[98]	Those	statistics	do	not	include	servers	(including	cloud	computing,	where	Linux	has	significantly	more	market	share	than	Windows)	as	Net	Applications	and
StatCounter	use	web	browsing	as	a	proxy	for	all	use.	This	section	needs	to	be	updated.	Please	help	update	this	article	to	reflect	recent	events	or	newly	available	information.	(May	2020)	Early	versions	of	Windows	were	designed	at	a	time	where	malware	and	networking	were	less	common,	and	had	few	built-in	security	features;	they	did	not	provide
access	privileges	to	allow	a	user	to	prevent	other	users	from	accessing	their	files,	and	they	did	not	provide	memory	protection	to	prevent	one	process	from	reading	or	writing	another	process's	address	space	or	to	prevent	a	process	from	code	or	data	used	by	privileged-mode	code.	While	the	Windows	9x	series	offered	the	option	of	having	profiles	for
multiple	users	with	separate	profiles	and	home	folders,	it	had	no	concept	of	access	privileges,	allowing	any	user	to	edit	others'	files.	In	addition,	while	it	ran	separate	32-bit	applications	in	separate	address	spaces,	protecting	an	application's	code	and	data	from	being	read	or	written	by	another	application,	it	did	not	protect	the	first	megabyte	of
memory	from	userland	applications	for	compatibility	reasons.	This	area	of	memory	contains	code	critical	to	the	functioning	of	the	operating	system,	and	by	writing	into	this	area	of	memory	an	application	can	crash	or	freeze	the	operating	system.	This	was	a	source	of	instability	as	faulty	applications	could	accidentally	write	into	this	region,	potentially
corrupting	important	operating	system	memory,	which	usually	resulted	in	some	form	of	system	error	and	halt.[99]	Windows	NT	was	far	more	secure,	implementing	access	privileges	and	full	memory	protection,	and,	while	32-bit	programs	meeting	the	DoD's	C2	security	rating,[100]	yet	these	advantages	were	nullified[improper	synthesis?]	by	the	fact
that,	prior	to	Windows	Vista,	the	default	user	account	created	during	the	setup	process	was	an	administrator	account;	the	user,	and	any	program	the	user	launched,	had	full	access	to	the	machine.	Though	Windows	XP	did	offer	an	option	of	turning	administrator	accounts	into	limited	accounts,	the	majority	of	home	users	did	not	do	so,	partially	due	to
the	number	of	programs	which	required	administrator	rights	to	function	properly.	As	a	result,	most	home	users	still	ran	as	administrator	all	the	time.	These	architectural	flaws,	combined	with	Windows's	very	high	popularity,	made	Windows	a	frequent	target	of	computer	worm	and	virus	writers.[101][102][103]	Furthermore,	although	Windows	NT	and
its	successors	are	designed	for	security	(including	on	a	network)	and	multi-user	PCs,	they	were	not	initially	designed	with	Internet	security	in	mind	as	much,	since,	when	it	was	first	developed	in	the	early	1990s,	Internet	use	was	less	prevalent.[104]	In	a	2002	strategy	memo	entitled	"Trustworthy	computing"	sent	to	every	Microsoft	employee,	Bill
Gates	declared	that	security	should	become	Microsoft's	highest	priority.[105][106]	Windows	Vista	introduced	a	privilege	elevation	system	called	User	Account	Control.[107]	When	logging	in	as	a	standard	user,	a	logon	session	is	created	and	a	token	containing	only	the	most	basic	privileges	is	assigned.	In	this	way,	the	new	logon	session	is	incapable	of
making	changes	that	would	affect	the	entire	system.	When	logging	in	as	a	user	in	the	Administrators	group,	two	separate	tokens	are	assigned.	The	first	token	contains	all	privileges	typically	awarded	to	an	administrator,	and	the	second	is	a	restricted	token	similar	to	what	a	standard	user	would	receive.	User	applications,	including	the	Windows	shell,
are	then	started	with	the	restricted	token,	resulting	in	a	reduced	privilege	environment	even	under	an	Administrator	account.	When	an	application	requests	higher	privileges	or	"Run	as	administrator"	is	clicked,	UAC	will	prompt	for	confirmation	and,	if	consent	is	given	(including	administrator	credentials	if	the	account	requesting	the	elevation	is	not	a
member	of	the	administrators	group),	start	the	process	using	the	unrestricted	token.[108]	Leaked	documents	from	2013	to	2016	codenamed	Vault	7	detail	the	capabilities	of	the	CIA	to	perform	electronic	surveillance	and	cyber	warfare,[109]	such	as	the	ability	to	compromise	operating	systems	such	as	Windows.[110]	In	August	2019,	computer	experts
reported	that	the	BlueKeep	security	vulnerability,	CVE-2019-0708,	that	potentially	affects	older	unpatched	Windows	versions	via	the	program's	Remote	Desktop	Protocol,	allowing	for	the	possibility	of	remote	code	execution,	may	include	related	flaws,	collectively	named	DejaBlue,	affecting	newer	Windows	versions	(i.e.,	Windows	7	and	all	recent
versions)	as	well.[111]	In	addition,	experts	reported	a	Microsoft	security	vulnerability,	CVE-2019-1162,	based	on	legacy	code	involving	Microsoft	CTF	and	ctfmon	(ctfmon.exe),	that	affects	all	Windows	versions	from	Windows	XP	to	the	then	most	recent	Windows	10	versions;	a	patch	to	correct	the	flaw	is	available.[112]	Microsoft	releases	security
patches	through	its	Windows	Update	service	approximately	once	a	month	(usually	the	second	Tuesday	of	the	month),	although	critical	updates	are	made	available	at	shorter	intervals	when	necessary.[113]	Versions	subsequent	to	Windows	2000	SP3	and	Windows	XP	implemented	automatic	download	and	installation	of	updates,	substantially	increasing
the	number	of	users	installing	security	updates.[114]	Windows	integrates	the	Windows	Defender	antivirus,	which	is	seen	as	one	of	the	best	available.[115]	Windows	also	implements	Secure	Boot,	Control	Flow	Guard,	ransomware	protection,	BitLocker	disk	encryption,	a	firewall,	and	Windows	SmartScreen.	In	July	2024,	Microsoft	signalled	an	intention
to	limit	kernel	access	and	improve	overall	security,	following	a	highly	publicised	CrowdStrike	update	that	caused	8.5	million	Windows	PCs	to	crash.[116]	Part	of	that	initiative	is	to	rewrite	parts	of	Windows	in	Rust,	a	memory-safe	language.[117]	All	Windows	versions	from	Windows	NT	3	have	been	based	on	a	file	system	permission	system	referred	to
as	AGDLP	(Accounts,	Global,	Domain	Local,	Permissions)	in	which	file	permissions	are	applied	to	the	file/folder	in	the	form	of	a	'local	group'	which	then	has	other	'global	groups'	as	members.	These	global	groups	then	hold	other	groups	or	users	depending	on	different	Windows	versions	used.	This	system	varies	from	other	vendor	products	such	as
Linux	and	NetWare	due	to	the	'static'	allocation	of	permission	being	applied	directly	to	the	file	or	folder.	However	using	this	process	of	AGLP/AGDLP/AGUDLP	allows	a	small	number	of	static	permissions	to	be	applied	and	allows	for	easy	changes	to	the	account	groups	without	reapplying	the	file	permissions	on	the	files	and	folders.[citation	needed]
Owing	to	the	operating	system's	popularity,	a	number	of	applications	have	been	released	that	aim	to	provide	compatibility	with	Windows	applications,	either	as	a	compatibility	layer	for	another	operating	system,	or	as	a	standalone	system	that	can	run	software	written	for	Windows	out	of	the	box.	These	include:	Wine	–	a	free	and	open-source
implementation	of	the	Windows	API,	allowing	one	to	run	many	Windows	applications	on	x86-based	platforms,	including	UNIX,	Linux	and	macOS.	Wine	developers	refer	to	it	as	a	"compatibility	layer"[118]	and	use	Windows-style	APIs	to	emulate	Windows	environment.	CrossOver	–	a	Wine	package	with	licensed	fonts.	Its	developers	are	regular
contributors	to	Wine.	Proton	–	A	fork	of	Wine	by	Valve	to	run	Windows	games	on	Linux	and	other	Unix-like	OS.	ReactOS	–	an	open-source	OS	intended	to	run	the	same	software	as	Windows,	originally	designed	to	simulate	Windows	NT	4.0,	later	aiming	at	Windows	7	compatibility.	It	has	been	in	the	development	stage	since	1996.	Freedows	OS	–	an
open-source	attempt	at	creating	a	Windows	clone	for	x86	platforms,	intended	to	be	released	under	the	GNU	General	Public	License.	Started	in	1996	by	Reece	K.	Sellin,	the	project	was	never	completed,	getting	only	to	the	stage	of	design	discussions	which	featured	a	number	of	novel	concepts	until	it	was	suspended	in	2002.[119][120][121]	Wintel	^
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similarly	named	Digital	Research	operating	system,	see	CP/M.	Operating	system	OS/2OS/2	Warp	4	desktop.	This	version	was	released	on	25	September	1996.[1]DeveloperIBMMicrosoft	(1.0–1.3)Written	inC,	C++	and	assembly	languageWorking	stateHistorical,	now	developed	as	ArcaOSSource	modelClosed	sourceInitial	releaseDecember	1987;
37	years	ago	(1987-12)Latest	release4.52	/	December	2001;	23	years	ago	(2001-12)Marketing	targetProfessionals,	serversAvailable	inChinese,	English,	French,	German,	Italian,	Japanese,	Korean,	Spanish,	Slovenian,	Portuguese,	RussianPlatforms32-bit	x86,	PowerPCKernel	typeHybrid	kernelInfluenced	byMS-DOS,	IBM	PC	DOSDefaultuser
interfaceWorkplace	ShellLicenseProprietarySucceeded	byeComStationArcaOSOfficial	websiteOS/2	Warp	(Archived)	OS/2	is	a	proprietary	computer	operating	system	for	x86	and	PowerPC	based	personal	computers.	It	was	created	and	initially	developed	jointly	by	IBM	and	Microsoft,	under	the	leadership	of	IBM	software	designer	Ed	Iacobucci,[2]
intended	as	a	replacement	for	DOS.	The	first	version	was	released	in	1987.	A	feud	between	the	two	companies	beginning	in	1990	led	to	Microsoft’s	leaving	development	solely	to	IBM,	which	continued	development	on	its	own.	OS/2	Warp	4	in	1996	was	the	last	major	upgrade,	after	which	IBM	slowly	halted	the	product	as	it	failed	to	compete	against
Microsoft's	Windows;	updated	versions	of	OS/2	were	released	by	IBM	until	2001.	The	name	stands	for	"Operating	System/2",	because	it	was	introduced	as	part	of	the	same	generation	change	release	as	IBM's	"Personal	System/2	(PS/2)"	line	of	second-generation	PCs.	OS/2	was	intended	as	a	protected-mode	successor	of	PC	DOS	targeting	the	Intel
80286	processor.	Notably,	basic	system	calls	were	modelled	after	MS-DOS	calls;	their	names	even	started	with	"Dos"	and	it	was	possible	to	create	"Family	Mode"	applications	–	text	mode	applications	that	could	work	on	both	systems.[3]	Because	of	this	heritage,	OS/2	shares	similarities	with	Unix,	Xenix,	and	Windows	NT.	OS/2	sales	were	largely
concentrated	in	networked	computing	used	by	corporate	professionals.	OS/2	2.0	was	released	in	1992	as	the	first	32-bit	version	as	well	as	the	first	to	be	entirely	developed	by	IBM,	after	Microsoft	severed	ties	over	a	dispute	over	how	to	position	OS/2	relative	to	Microsoft's	new	Windows	3.1	operating	environment.[4][5]	With	OS/2	Warp	3	in	1994,	IBM
attempted	to	also	target	home	consumers	through	a	multi-million	dollar	advertising	campaign.[6]	However	it	continued	to	struggle	in	the	marketplace,	partly	due	to	strategic	business	measures	imposed	by	Microsoft	in	the	industry	that	have	been	considered	anti-competitive.[7][8]	Following	the	failure	of	IBM's	Workplace	OS	project,	OS/2	Warp	4
became	the	final	major	release	in	1996;	IBM	discontinued	its	support	for	OS/2	on	December	31,	2006.[9]	Since	then,	OS/2	has	been	developed,	supported	and	sold	by	two	different	third-party	vendors	under	license	from	IBM	–	first	by	Serenity	Systems	as	eComStation	from	2001	to	2011,[10]	and	later	by	Arca	Noae	LLC	as	ArcaOS	since	2017.[11][12]
[13]	This	section	needs	additional	citations	for	verification.	Please	help	improve	this	article	by	adding	citations	to	reliable	sources	in	this	section.	Unsourced	material	may	be	challenged	and	removed.	(April	2012)	(Learn	how	and	when	to	remove	this	message)	Ironically,	Microsoft	is	competing	against	itself	in	the	operating	systems	market.	Besides
Xenix,	Microsoft	has	announced	Windows	386,	which	[is]	somewhat	similar	to	OS/2.	Of	course,	either	way	users	turn,	Microsoft	wins.— Computerworld,	1987[14]	Logo	of	OS/2	1.xOS/2	1.0	featured	a	text-mode	interface	similar	to	MS-DOS.	The	development	of	OS/2	began	when	IBM	and	Microsoft	signed	the	"Joint	Development	Agreement"	in	August
1985.[15][16]	It	was	code-named	"CP/DOS"	and	it	took	two	years	for	the	first	product	to	be	delivered.	OS/2's	release	was	long	delayed.	It	was	widely	believed	that	all	IBM	programmers	used	assembly	language,	and	a	rumor	said	that	the	delay	was	because	they	had	to	learn	C.[17]	OS/2	1.0	was	announced	in	April	1987	and	released	in	December.	The
original	release	only	ran	in	text	mode,	and	a	GUI	was	introduced	with	OS/2	1.1	about	a	year	later.	OS/2	features	an	API	for	controlling	the	video	display	(VIO)	and	handling	keyboard	and	mouse	events	so	that	programmers	writing	for	protected	mode	need	not	call	the	BIOS	or	access	hardware	directly.	Other	development	tools	included	a	subset	of	the
video	and	keyboard	APIs	as	linkable	libraries	so	that	family	mode	programs	are	able	to	run	under	MS-DOS,[citation	needed]	and,	in	the	OS/2	Extended	Edition	v1.0,	a	database	engine	called	Database	Manager	or	DBM	(this	was	related	to	DB2,	and	should	not	be	confused	with	the	DBM	family	of	database	engines	for	Unix	and	Unix-like	operating
systems).[18]	A	task-switcher	named	Program	Selector	was	available	through	the	Ctrl-Esc	hotkey	combination,	allowing	the	user	to	select	among	multitasked	text-mode	sessions	(or	screen	groups;	each	can	run	multiple	programs).[19]	Communications	and	database-oriented	extensions	were	delivered	in	1988,	as	part	of	OS/2	1.0	Extended	Edition:
SNA,	X.25/APPC/LU	6.2,	LAN	Manager,	Query	Manager,	SQL.	Microsoft's	Bill	Gates	predicted	at	a	1987	Computerworld	interview	that	"three	years	out,	over	80%	of	new	office	systems	will	be	based	on	OS/2".	Ashton-Tate's	Ed	Esber	also	predicted	success,	while	Lotus	Development's	Jim	Manzi	said	"I	don't	know	anyone	who's	screaming	for	OS/2.	End
users	would	really	prefer	that	the	whole	thing	never	happened".	Gates	said	that	Microsoft	would	release	Windows	software	first	with	"very	cheap	upgrades"	to	OS/2	versions,	while	the	other	two	said	their	companies	would	release	for	OS/2	first.[20]	OS/2	1.1	was	the	first	version	to	feature	the	Presentation	Manager	GUI.	The	promised	user	interface,
Presentation	Manager,	was	introduced	with	OS/2	1.1	in	October	1988.[21]	It	had	a	similar	user	interface	to	Windows	2.1,	which	was	released	in	May	of	that	year.	(The	interface	was	replaced	in	versions	1.2	and	1.3	by	a	look	closer	in	appearance	to	Windows	3.0.)	The	Extended	Edition	of	1.1,	sold	only	through	IBM	sales	channels,	introduced
distributed	database	support	to	IBM	database	systems	and	SNA	communications	support	to	IBM	mainframe	networks.	In	1989,	Version	1.2	introduced	Installable	Filesystems	and,	notably,	the	HPFS	filesystem.	HPFS	provided	a	number	of	improvements	over	the	older	FAT	file	system,	including	long	filenames	and	a	form	of	alternate	data	streams
called	Extended	Attributes.[22]	In	addition,	extended	attributes	were	also	added	to	the	FAT	file	system.[23]	Installation	Disk	A	of	Microsoft	OS/2	1.3	(3½-inch	floppy	disk)	The	Extended	Edition	of	1.2	introduced	TCP/IP	and	Ethernet	support.	OS/2-	and	Windows-related	books	of	the	late	1980s	from	both	Microsoft's	Gordon	Letwin	and	his	IBM
counterpart	Ed	Iacobucci	acknowledged	the	existence	of	both	systems	and	promoted	OS/2	as	the	system	of	the	future.[24][17]	Logo	of	Microsoft's	OS/2	until	the	breakup	The	collaboration	between	IBM	and	Microsoft	unravelled	in	1990,	between	the	releases	of	Windows	3.0	and	OS/2	1.3.	During	this	time,	Windows	3.0	became	a	tremendous	success,
selling	millions	of	copies	in	its	first	year.[25]	Much	of	its	success	was	because	Windows	3.0	(along	with	MS-DOS)	was	bundled	with	most	new	computers.[26]	OS/2,	on	the	other	hand,	was	available	only	as	an	additional	stand-alone	software	package.	In	addition,	OS/2	lacked	device	drivers	for	many	common	devices	such	as	printers,	particularly	non-
IBM	hardware.[27]	Windows,	on	the	other	hand,	supported	a	much	larger	variety	of	hardware.	The	increasing	popularity	of	Windows	prompted	Microsoft	to	shift	its	development	focus	from	cooperating	on	OS/2	with	IBM	to	building	its	own	business	based	on	Windows.[28]	Several	technical	and	practical	reasons	contributed	to	this	breakup.	The	two
companies	had	significant	differences	in	culture	and	vision.	Microsoft	favored	the	open	hardware	system	approach	that	contributed	to	its	success	on	the	PC.	IBM	sought	to	use	OS/2	to	drive	sales	of	its	own	hardware,	and	urged	Microsoft	to	drop	features,	such	as	fonts,	that	IBM's	hardware	did	not	support.	Microsoft	programmers	also	became
frustrated	with	IBM's	bureaucracy	and	its	use	of	lines	of	code	to	measure	programmer	productivity.[29]	IBM	developers	complained	about	the	terseness	and	lack	of	comments	in	Microsoft's	code,	while	Microsoft	developers	complained	that	IBM's	code	was	bloated.[30]	The	two	products	have	significant	differences	in	API.	OS/2	was	announced	when
Windows	2.0	was	near	completion,	and	the	Windows	API	already	defined.	However,	IBM	requested	that	this	API	be	significantly	changed	for	OS/2.[31]	Therefore,	issues	surrounding	application	compatibility	appeared	immediately.	OS/2	designers	hoped	for	source	code	conversion	tools,	allowing	complete	migration	of	Windows	application	source	code
to	OS/2	at	some	point.	However,	OS/2	1.x	did	not	gain	enough	momentum	to	allow	vendors	to	avoid	developing	for	both	OS/2	and	Windows	in	parallel.	OS/2	1.3	was	the	final	16-bit	only	version	of	OS/2,	and	the	last	to	be	sold	by	Microsoft.	OS/2	1.x	targets	the	Intel	80286	processor	and	DOS	fundamentally	does	not.	IBM	insisted	on	supporting	the
80286	processor,	with	its	16-bit	segmented	memory	mode,	because	of	commitments	made	to	customers	who	had	purchased	many	80286-based	PS/2s	as	a	result	of	IBM's	promises	surrounding	OS/2.[32]	Until	release	2.0	in	April	1992,	OS/2	ran	in	16-bit	protected	mode	and	therefore	could	not	benefit	from	the	Intel	80386's	much	simpler	32-bit	flat
memory	model	and	virtual	8086	mode	features.	This	was	especially	painful	in	providing	support	for	DOS	applications.	While,	in	1988,	Windows/386	2.1	could	run	several	cooperatively	multitasked	DOS	applications,	including	expanded	memory	(EMS)	emulation,	OS/2	1.3,	released	in	1991,	was	still	limited	to	one	640	kB	"DOS	box".	Given	these	issues,
Microsoft	started	to	work	in	parallel	on	a	version	of	Windows	which	was	more	future-oriented	and	more	portable.	The	hiring	of	Dave	Cutler,	former	VAX/VMS	architect,	in	1988	created	an	immediate	competition	with	the	OS/2	team,	as	Cutler	did	not	think	much	of	the	OS/2	technology	and	wanted	to	build	on	his	work	on	the	MICA	project	at	Digital
rather	than	creating	a	"DOS	plus".	His	NT	OS/2	was	a	completely	new	architecture.[33]	IBM	grew	concerned	about	the	delays	in	development	of	OS/2	2.0.	Initially,	the	companies	agreed	that	IBM	would	take	over	maintenance	of	OS/2	1.0	and	development	of	OS/2	2.0,	while	Microsoft	would	continue	development	of	OS/2	3.0.	In	the	end,	Microsoft
decided	to	recast	NT	OS/2	3.0	as	Windows	NT,	leaving	all	future	OS/2	development	to	IBM.	From	a	business	perspective,	it	was	logical	to	concentrate	on	a	consumer	line	of	operating	systems	based	on	DOS	and	Windows,	and	to	prepare	a	new	high-end	system	in	such	a	way	as	to	keep	good	compatibility	with	existing	Windows	applications.	While	it
waited	for	this	new	high-end	system	to	develop,	Microsoft	would	still	receive	licensing	money	from	Xenix	and	OS/2	sales.	Windows	NT's	OS/2	heritage	can	be	seen	in	its	initial	support	for	the	HPFS	filesystem,	text	mode	OS/2	1.x	applications,	and	OS/2	LAN	Manager	network	support.	Some	early	NT	materials	even	included	OS/2	copyright	notices
embedded	in	the	software.[citation	needed]	One	example	of	NT	OS/2	1.x	support	is	in	the	WIN2K	resource	kit.	Windows	NT	could	also	support	OS/2	1.x	Presentation	Manager	and	AVIO	applications	with	the	addition	of	the	Windows	NT	Add-On	Subsystem	for	Presentation	Manager.[34]	OS/2	2.0	was	the	first	32-bit	release	of	OS/2,	and	the	first	to
feature	the	Workplace	Shell.	OS/2	2.0	was	released	in	April	1992.	At	the	time,	the	suggested	retail	price	was	US$195,	while	Windows	retailed	for	$150.[35]	OS/2	2.0	provided	a	32-bit	API	for	native	programs,	though	the	OS	itself	still	contained	some	16-bit	code	and	drivers.	It	also	included	a	new	OOUI	(object-oriented	user	interface)	called	the
Workplace	Shell.	This	was	a	fully	object-oriented	interface	that	was	a	significant	departure	from	the	previous	GUI.	Rather	than	merely	providing	an	environment	for	program	windows	(such	as	the	Program	Manager),	the	Workplace	Shell	provided	an	environment	in	which	the	user	could	manage	programs,	files	and	devices	by	manipulating	objects	on
the	screen.	With	the	Workplace	Shell,	everything	in	the	system	is	an	"object"	to	be	manipulated.	OS/2	2.0	was	touted	by	IBM	as	"a	better	DOS	than	DOS	and	a	better	Windows	than	Windows".[36]	It	managed	this	by	including	the	fully-licensed	MS-DOS	5.0,	which	had	been	patched	and	improved	upon.	For	the	first	time,	OS/2	was	able	to	run	more	than
one	DOS	application	at	a	time.	This	was	so	effective	that	it	allowed	OS/2	to	run	a	modified	copy	of	Windows	3.0,	itself	a	DOS	extender,	including	Windows	3.0	applications.	Because	of	the	limitations	of	the	Intel	80286	processor,	OS/2	1.x	could	run	only	one	DOS	program	at	a	time,	and	did	this	in	a	way	that	allowed	the	DOS	program	to	have	total
control	over	the	computer.	A	problem	in	DOS	mode	could	crash	the	entire	computer.	In	contrast,	OS/2	2.0	could	leverage	the	virtual	8086	mode	of	the	Intel	80386	processor	to	create	a	much	safer	virtual	machine	in	which	to	run	DOS	programs.	This	included	an	extensive	set	of	configuration	options	to	optimize	the	performance	and	capabilities	given
to	each	DOS	program.	Any	real-mode	operating	system	(such	as	8086	Xenix)	could	also	be	made	to	run	using	OS/2's	virtual	machine	capabilities,	subject	to	certain	direct	hardware	access	limitations.	The	OS/2	2.0	upgrade	box	Like	most	32-bit	environments,	OS/2	could	not	run	protected-mode	DOS	programs	using	the	older	VCPI	interface,	unlike	the
Standard	mode	of	Windows	3.1;	it	only	supported	programs	written	according	to	DPMI.	(Microsoft	discouraged	the	use	of	VCPI	under	Windows	3.1,	however,	due	to	performance	degradation.)[37]	Unlike	Windows	NT,	OS/2	always	allowed	DOS	programs	the	possibility	of	masking	real	hardware	interrupts,	so	any	DOS	program	could	deadlock	the
machine	in	this	way.	OS/2	could,	however,	use	a	hardware	watchdog	on	selected	machines	(notably	IBM	machines)	to	break	out	of	such	a	deadlock.	Later,	release	3.0	leveraged	the	enhancements	of	newer	Intel	80486	and	Intel	Pentium	processors—the	Virtual	Interrupt	Flag	(VIF),	which	was	part	of	the	Virtual	Mode	Extensions	(VME)—to	solve	this
problem.	To	accommodate	those	who	wanted	to	have	multiple	operating	systems	on	their	machine,	Boot	Manager	was	introduced	that	allowed	for	the	creation	of	separate	partitions	on	the	boot	drive	which	could	be	used	to	install	different	versions	of	DOS,	Windows	and	OS/2	and	give	the	user	a	choice	of	which	partition	to	boot	from.[38]	Further
information:	VME	(CONFIG.SYS	directive)	OS/2	2.1	was	released	in	1993.	This	version	of	OS/2	achieved	compatibility	with	Windows	3.0	(and	later	Windows	3.1)	by	adapting	Windows	user-mode	code	components	to	run	inside	a	virtual	DOS	machine	(VDM).	Originally,	a	nearly	complete	version	of	Windows	code	was	included	with	OS/2	itself:	Windows
3.0	in	OS/2	2.0,	and	Windows	3.1	in	OS/2	2.1.	Later,	IBM	developed	versions	of	OS/2	that	would	use	whatever	Windows	version	the	user	had	installed	previously,	patching	it	on	the	fly,	and	sparing	the	cost	of	an	additional	Windows	license.[39]	It	could	either	run	full-screen,	using	its	own	set	of	video	drivers,	or	"seamlessly,"	where	Windows	programs
would	appear	directly	on	the	OS/2	desktop.	The	process	containing	Windows	was	given	fairly	extensive	access	to	hardware,	especially	video,	and	the	result	was	that	switching	between	a	full-screen	WinOS/2	session	and	the	Workplace	Shell	could	occasionally	cause	issues.[40]	Because	OS/2	only	runs	the	user-mode	system	components	of	Windows,	it	is
incompatible	with	Windows	device	drivers	(VxDs)	and	applications	that	require	them.	Multiple	Windows	applications	run	by	default	in	a	single	Windows	session	–	multitasking	cooperatively	and	without	memory	protection	–	just	as	they	would	under	native	Windows	3.x.	However,	to	achieve	true	isolation	between	Windows	3.x	programs,	OS/2	can	also
run	multiple	copies	of	Windows	in	parallel,	with	each	copy	residing	in	a	separate	VDM.	The	user	can	then	optionally	place	each	program	either	in	its	own	Windows	session	–	with	preemptive	multitasking	and	full	memory	protection	between	sessions,	though	not	within	them	–	or	allow	some	applications	to	run	together	cooperatively	in	a	shared
Windows	session	while	isolating	other	applications	in	one	or	more	separate	Windows	sessions.	At	the	cost	of	additional	hardware	resources,	this	approach	can	protect	each	program	in	any	given	Windows	session	(and	each	instance	of	Windows	itself)	from	every	other	program	running	in	any	separate	Windows	session	(though	not	from	other	programs
running	in	the	same	Windows	session).[41]	Whether	Windows	applications	are	running	in	full-screen	or	windowed	mode,	and	in	one	Windows	session	or	several,	it	is	possible	to	use	DDE	between	OS/2	and	Windows	applications,	and	OLE	between	Windows	applications	only.[42]	IBM's	OS/2	for	Windows	product	(codename	Ferengi),	also	known	as
"OS/2,	Special	Edition",	was	interpreted	as	a	deliberate	strategy	"of	cashing	in	on	the	pervasive	success	of	the	Microsoft	platform"	but	risked	confusing	consumers	with	the	notion	that	the	product	was	a	mere	accessory	or	utility	running	on	Windows	such	as	Norton	Desktop	for	Windows	when,	in	fact,	it	was	"a	complete,	modern,	multi-tasking,	pre-
emptive	operating	system",	itself	hosting	Windows	instead	of	running	on	it.	Available	on	CD-ROM	or	18	floppy	disks,	the	product	documentation	reportedly	suggested	Windows	as	a	prerequisite	for	installing	the	product,	also	being	confined	to	its	original	FAT	partition,	whereas	the	product	apparently	supported	the	later	installation	of	Windows
running	from	an	HPFS	partition,	particularly	beneficial	for	users	of	larger	hard	drives.	Windows	compatibility,	relying	on	patching	specific	memory	locations,	was	reportedly	broken	by	the	release	of	Windows	3.11,	prompting	accusations	of	arbitrary	changes	to	Windows	in	order	to	perpetrate	"a	deliberate	act	of	Microsoft	sabotage"	against	IBM's
product.[41]	Wordmark	of	OS/2	Warp	3.0OS/2	Warp	Connect	3.0,	showing	the	Windows	3.1	Program	Manager,	QBASIC	in	a	DOS	window,	and	the	LaunchPad	(bottom	center)	Released	in	1994,	OS/2	version	3.0	was	labelled	as	OS/2	Warp	to	highlight	the	new	performance	benefits,	and	generally	to	freshen	the	product	image.	"Warp"	had	originally
been	the	internal	IBM	name	for	the	release:	IBM	claimed	that	it	had	used	Star	Trek	terms	as	internal	names	for	prior	OS/2	releases,	and	that	this	one	seemed	appropriate	for	external	use	as	well.	At	the	launch	of	OS/2	Warp	in	1994,	Patrick	Stewart	was	to	be	the	Master	of	Ceremonies;	however	Kate	Mulgrew[43]	of	the	then-upcoming	series	Star	Trek:
Voyager	substituted	for	him	at	the	last	minute.[44][45]	OS/2	Warp	offers	a	host	of	benefits	over	OS/2	2.1,	notably	broader	hardware	support,	greater	multimedia	capabilities,	Internet-compatible	networking,	and	it	includes	a	basic	office	application	suite	known	as	IBM	Works.	It	was	released	in	two	versions:	the	less	expensive	"Red	Spine"	and	the
more	expensive	"Blue	Spine"	(named	for	the	color	of	their	boxes).	"Red	Spine"	was	designed	to	support	Microsoft	Windows	applications	by	utilizing	any	existing	installation	of	Windows	on	the	computer's	hard	drive.	"Blue	Spine"	includes	Windows	support	in	its	own	installation,	and	so	can	support	Windows	applications	without	a	Windows	installation.
As	most	computers	were	sold	with	Microsoft	Windows	pre-installed	and	the	price	was	less,	"Red	Spine"	was	the	more	popular	product.[46]	OS/2	Warp	Connect—which	has	full	LAN	client	support	built-in—followed	in	mid-1995.	Warp	Connect	was	nicknamed	"Grape".[21]	In	OS/2	2.0,	most	performance-sensitive	subsystems,	including	the	graphics	(Gre)
and	multimedia	(MMPM/2)	systems,	were	updated	to	32-bit	code	in	a	fixpack,	and	included	as	part	of	OS/2	2.1.	Warp	3	brought	about	a	fully	32-bit	windowing	system,	while	Warp	4	introduced	the	object-oriented	32-bit	GRADD	display	driver	model.	Main	article:	Workplace	OS	In	1991,	IBM	started	development	on	an	intended	replacement	for	OS/2
called	Workplace	OS.	This	was	an	entirely	new	product,	brand	new	code,	that	borrowed	only	a	few	sections	of	code	from	both	the	existing	OS/2	and	AIX	products.	It	used	an	entirely	new	microkernel	code	base,	intended	(eventually)	to	host	several	of	IBM's	operating	systems	(including	OS/2)	as	microkernel	"personalities".	It	also	included	major	new
architectural	features	including	a	system	registry,	JFS,	support	for	UNIX	graphics	libraries,	and	a	new	driver	model.[47]	Workplace	OS	was	developed	solely	for	POWER	platforms,	and	IBM	intended	to	market	a	full	line	of	PowerPCs	in	an	effort	to	take	over	the	market	from	Intel.	A	mission	was	formed	to	create	prototypes	of	these	machines	and	they
were	disclosed	to	several	corporate	customers,	all	of	whom	raised	issues	with	the	idea	of	dropping	Intel.	Advanced	plans	for	the	new	code	base	would	eventually	include	replacement	of	the	OS/400	operating	system	by	Workplace	OS,	as	well	as	a	microkernel	product	that	would	have	been	used	in	industries	such	as	telecommunications	and	set-top
television	receivers.	A	partially	functional	pre-alpha	version	of	Workplace	OS	was	demonstrated	at	Comdex,	where	a	bemused	Bill	Gates	stopped	by	the	booth.	The	second	and	last	time	it	would	be	shown	in	public	was	at	an	OS/2	user	group	in	Phoenix,	Arizona;	the	pre-alpha	code	refused	to	boot.	It	was	released	in	1995.	But	with	$990	million	being
spent	per	year	on	development	of	this	as	well	as	Workplace	OS,	and	no	possible	profit	or	widespread	adoption,	the	end	of	the	entire	Workplace	OS	and	OS/2	product	line	was	near.	Firefox	3.5.4	for	OS/2	Warp	4	Wordmark	of	OS/2	Warp	4OS/2	Warp	4	desktop	after	installation	In	1996,	Warp	4	added	Java	and	speech	recognition	software.[48]	IBM	also
released	server	editions	of	Warp	3	and	Warp	4	which	bundled	IBM's	LAN	Server	product	directly	into	the	operating	system	installation.	A	personal	version	of	Lotus	Notes	was	also	included,	with	a	number	of	template	databases	for	contact	management,	brainstorming,	and	so	forth.	The	UK-distributed	free	demo	CD-ROM	of	OS/2	Warp	essentially
contained	the	entire	OS	and	was	easily,	even	accidentally,	cracked[clarification	needed],	meaning	that	even	people	who	liked	it	did	not	have	to	buy	it.	This	was	seen	as	a	backdoor	tactic	to	increase	the	number	of	OS/2	users,	in	the	belief	that	this	would	increase	sales	and	demand	for	third-party	applications,	and	thus	strengthen	OS/2's	desktop
numbers.[citation	needed]	This	suggestion	was	bolstered	by	the	fact	that	this	demo	version	had	replaced	another	which	was	not	so	easily	cracked,	but	which	had	been	released	with	trial	versions	of	various	applications.[citation	needed]	In	2000,	the	July	edition	of	Australian	Personal	Computer	magazine	bundled	software	CD-ROMs,	included	a	full
version	of	Warp	4	that	required	no	activation	and	was	essentially	a	free	release.	Special	versions	of	OS/2	2.11	and	Warp	4	also	included	symmetric	multiprocessing	(SMP)	support.	OS/2	sales	were	largely	concentrated	in	networked	computing	used	by	corporate	professionals;	however,	by	the	early	1990s,	it	was	overtaken	by	Microsoft	Windows	NT.
While	OS/2	was	arguably	technically	superior	to	Microsoft	Windows	95,	OS/2	failed	to	develop	much	penetration	in	the	consumer	and	stand-alone	desktop	PC	segments;	there	were	reports	that	it	could	not	be	installed	properly	on	IBM's	own	Aptiva	series	of	home	PCs.[49]	Microsoft	made	an	offer	in	1994	where	IBM	would	receive	the	same	terms	as
Compaq	(the	largest	PC	manufacturer	at	the	time)	for	a	license	of	Windows	95,	if	IBM	ended	development	of	OS/2	completely.	IBM	refused	and	instead	went	with	an	"IBM	First"	strategy	of	promoting	OS/2	Warp	and	disparaging	Windows,	as	IBM	aimed	to	drive	sales	of	its	own	software	as	well	as	hardware.	By	1995,	Windows	95	negotiations	between
IBM	and	Microsoft,	which	were	already	difficult,	stalled	when	IBM	purchased	Lotus	SmartSuite,	which	would	have	directly	competed	with	Microsoft	Office.	As	a	result	of	the	dispute,	IBM	signed	the	license	agreement	15	minutes	before	Microsoft's	Windows	95	launch	event,	which	was	later	than	their	competitors	and	this	badly	hurt	sales	of	IBM	PCs.
IBM	officials	later	conceded	that	OS/2	would	not	have	been	a	viable	operating	system	to	keep	them	in	the	PC	business.[50][51]	This	section	does	not	cite	any	sources.	Please	help	improve	this	section	by	adding	citations	to	reliable	sources.	Unsourced	material	may	be	challenged	and	removed.	(March	2013)	(Learn	how	and	when	to	remove	this
message)	A	project	was	launched	internally	by	IBM	to	evaluate	the	looming	competitive	situation	with	Microsoft	Windows	95.	Primary	concerns	included	the	major	code	quality	issues	in	the	existing	OS/2	product	(resulting	in	over	20	service	packs,	each	requiring	more	diskettes	than	the	original	installation),	and	the	ineffective	and	heavily	matrixed
development	organization	in	Boca	Raton	(where	the	consultants	reported	that	"basically,	everybody	reports	to	everybody")	and	Austin.	That	study,	tightly	classified	as	"Registered	Confidential"	and	printed	only	in	numbered	copies,	identified	untenable	weaknesses	and	failures	across	the	board	in	the	Personal	Systems	Division	as	well	as	across	IBM	as
a	whole.	This	resulted	in	a	decision	being	made	at	a	level	above	the	Division	to	cut	over	95%	of	the	overall	budget	for	the	entire	product	line,	end	all	new	development	(including	Workplace	OS),	eliminate	the	Boca	Raton	development	lab,	end	all	sales	and	marketing	efforts	of	the	product,	and	lay	off	over	1,300	development	individuals	(as	well	as	sales
and	support	personnel).	$990	million	had	been	spent	in	the	last	full	year.	Warp	4	became	the	last	distributed	version	of	OS/2.	Although	a	small	and	dedicated	community	remains	faithful	to	OS/2,[52]	OS/2	failed	to	catch	on	in	the	mass	market	and	is	little	used	outside	certain	niches	where	IBM	traditionally	had	a	stronghold.	For	example,	many	bank
installations,	especially	automated	teller	machines,	run	OS/2	with	a	customized	user	interface;	French	SNCF	national	railways	used	OS/2	1.x	in	thousands	of	ticket	selling	machines.[citation	needed]	Telecom	companies	such	as	Nortel	used	OS/2	in	some	voicemail	systems.	Also,	OS/2	was	used	for	the	host	PC	used	to	control	the	Satellite	Operations
Support	System	equipment	installed	at	NPR	member	stations	from	1994	to	2007,	and	used	to	receive	the	network's	programming	via	satellite.[citation	needed]	Although	IBM	began	indicating	shortly	after	the	release	of	Warp	4	that	OS/2	would	eventually	be	withdrawn,	the	company	did	not	end	support	until	December	31,	2006,[53]	with	sales	of	OS/2
stopping	on	December	23,	2005.	The	latest	IBM	OS/2	Warp	version	is	4.52,	which	was	released	for	both	desktop	and	server	systems	in	December	2001.	IBM	is	still	delivering	defect	support	for	a	fee.[53][54]	IBM	urges	customers	to	migrate	their	often	highly	complex	applications	to	e-business	technologies	such	as	Java	in	a	platform-neutral	manner.
Once	application	migration	is	completed,	IBM	recommends	migration	to	a	different	operating	system,	suggesting	Linux	as	an	alternative.[55][56][57]	Main	articles:	eComStation	and	ArcaOS	ArcaOS	is	the	most	recent	OS/2-based	operating	system	developed	outside	of	IBM.	After	IBM	discontinued	development	of	OS/2,	various	third	parties
approached	IBM	to	take	over	future	development	of	the	operating	system.	The	OS/2	software	vendor	Stardock	made	such	a	proposal	to	IBM	in	1999,	but	it	was	not	followed	through	by	the	company.[58]	Serenity	Systems	succeeded	in	negotiating	an	agreement	with	IBM,	and	began	reselling	OS/2	as	eComStation	in	2001.[59]	eComStation	is	now	sold
by	XEU.com,	the	most	recent	version	(2.1)	was	released	in	2011.[60]	In	2015,	Arca	Noae,	LLC	announced	that	they	had	secured	an	agreement	with	IBM	to	resell	OS/2.[11]	They	released	the	first	version	of	their	OS/2-based	operating	system	in	2017	as	ArcaOS.[13]	As	of	2023,	there	have	been	multiple	releases	of	ArcaOS,	and	it	remains	under	active
development.[61]	Many	people	hoped	that	IBM	would	release	OS/2	or	a	significant	part	of	it	as	open	source.	Petitions	were	held	in	2005	and	2007,	but	IBM	refused	them,	citing	legal	and	technical	reasons.[62]	It	is	unlikely	that	the	entire	OS	will	be	open	at	any	point	in	the	future	because	it	contains	third-party	code	to	which	IBM	does	not	have
copyright,	and	much	of	this	code	is	from	Microsoft.	IBM	also	once	engaged	in	a	technology	transfer	with	Commodore,	licensing	Amiga	technology	for	OS/2	2.0	and	above,	in	exchange	for	the	REXX	scripting	language.[63]	This	means	that	OS/2	may	have	some	code	that	was	not	written	by	IBM,	which	can	therefore	prevent	the	OS	from	being	re-
announced	as	open-sourced	in	the	future.[64][failed	verification][65]	On	the	other	hand,	IBM	donated	Object	REXX	for	Windows	and	OS/2	to	the	Open	Object	REXX	project	maintained	by	the	REXX	Language	Association	on	SourceForge.[66]	There	was	a	petition,	arranged	by	OS2World,	to	open	parts	of	the	OS.	Open	source	operating	systems	such	as
Linux	have	already	profited	from	OS/2	indirectly	through	IBM's	release	of	the	improved	JFS	file	system,	which	was	ported	from	the	OS/2	code	base.	As	IBM	didn't	release	the	source	of	the	OS/2	JFS	driver,	developers	ported	the	Linux	driver	back	to	eComStation	and	added	the	functionality	to	boot	from	a	JFS	partition.	This	new	JFS	driver	has	been
integrated	into	eComStation	v2.0,	and	later	into	ArcaOS	5.0.	Release	dates	refer	to	the	US	English	editions	unless	otherwise	noted.[67][68]	Date	Version	December	1987	OS/2	1.0	November	1988	OS/2	1.1	October	1989	OS/2	1.2	December	1990	OS/2	1.3	October	1991	OS/2	2.0	LA	(Limited	Availability)	April	1992	OS/2	2.0	October	1992	OS/2	2.00.1
May	1993	OS/2	2.1	November	1993	OS/2	for	Windows	February	1994	OS/2	2.11	July	1994	OS/2	2.11	SMP	October	1994	OS/2	Warp	3	May	1995	OS/2	Warp	Connect	December	1995	OS/2	Warp,	PowerPC	Edition	February	1996	OS/2	Warp	Server	4	September	1996	OS/2	Warp	4	September	1996	OS/2	Warp	Server	Advanced	SMP	November	1997
WorkSpace	On-Demand	1.0	October	1998	WorkSpace	On-Demand	2.0	April	1999	OS/2	Warp	Server	for	e-Business	(version	4.50)	November	2000	OS/2	Convenience	Pack	1	(version	4.51)	November	2001	OS/2	Convenience	Pack	2	(version	4.52)	The	graphic	system	has	a	layer	named	Presentation	Manager	that	manages	windows,	fonts,	and	icons.	This
is	similar	in	functionality	to	a	non-networked	version	of	X11	or	the	Windows	GDI.	On	top	of	this	lies	the	Workplace	Shell	(WPS)	introduced	in	OS/2	2.0.	WPS	is	an	object-oriented	shell	allowing	the	user	to	perform	traditional	computing	tasks	such	as	accessing	files,	printers,	launching	legacy	programs,	and	advanced	object	oriented	tasks	using	built-in
and	third-party	application	objects	that	extended	the	shell	in	an	integrated	fashion	not	available	on	any	other	mainstream	operating	system.	WPS	follows	IBM's	Common	User	Access	user	interface	standards.	WPS	represents	objects	such	as	disks,	folders,	files,	program	objects,	and	printers	using	the	System	Object	Model	(SOM),	which	allows	code	to
be	shared	among	applications,	possibly	written	in	different	programming	languages.	A	distributed	version	called	DSOM	allowed	objects	on	different	computers	to	communicate.	DSOM	is	based	on	CORBA.	The	object	oriented	aspect	of	SOM	is	similar	to,	and	a	direct	competitor	to,	Microsoft's	Component	Object	Model,	though	it	is	implemented	in	a
radically	different	manner;	for	instance,	one	of	the	most	notable	differences	between	SOM	and	COM	is	SOM's	support	for	inheritance	(one	of	the	most	fundamental	concepts	of	OO	programming)—COM	does	not	have	such	support.	SOM	and	DSOM	are	no	longer	being	developed.	The	multimedia	capabilities	of	OS/2	are	accessible	through	Media
Control	Interface	commands.	The	last	update	(bundled	with	the	IBM	version	of	Netscape	Navigator	plugins)	added	support	for	MPEG	files.	Support	for	newer	formats	such	as	PNG,	progressive	JPEG,	DivX,	Ogg,	and	MP3	comes	from	third	parties.	Sometimes	it	is	integrated	with	the	multimedia	system,	but	in	other	offers	it	comes	as	standalone
applications.	OS/2	Window	(cmd.exe)	on	Microsoft	OS/2	Version	1.3	The	following	list	of	commands	is	supported	by	cmd.exe	on	OS/2.[69][70]	ansi	append	assign	attrib	backup	boot	break	cache	call	cd	chcp	chdir	chkdsk	cls	cmd	codepage	command	comp	copy	createdd	date	ddinstal	debug	del	detach	dir	diskcomp	diskcopy	doskey	dpath	eautil	echo
endlocal	erase	exit	extproc	fdisk	fdiskpm	find	for	format	fsaccess	goto	graftabl	help	if	join	keyb	keys	label	makeini	md	mem	mkdir	mode	more	move	patch	path	pause	picview	pmrexx	print	prompt	pstat	rd	recover	rem	ren	rename	replace	restore	rmdir	set	setboot	setcom40	setlocal	share	shift	sort	spool	start	subst	syslevel	syslog	time	trace	tracebuf
tracefmt	tree	type	undelete	unpack	ver	verify	view	vmdisk	vol	xcopy	This	section	needs	expansion.	You	can	help	by	adding	to	it.	(April	2019)	The	TCP/IP	stack	is	based	on	the	open	source	BSD	stack	as	visible	with	SCCS	what	compatible	tools.	IBM	included	tools	such	as	ftp	and	telnet	and	even	servers	for	both	commands.	IBM	sold	several	networking
extensions	including	NFS	support	and	an	X11	server.	Architecture	of	OS/2	Warp	under	x86	Hardware	vendors	were	reluctant	to	support	device	drivers	for	alternative	operating	systems	including	OS/2,	leaving	users	with	few	choices	from	a	select	few	vendors.	To	relieve	this	issue	for	video	cards,	IBM	licensed	a	reduced	version	of	the	Scitech	display
drivers,	allowing	users	to	choose	from	a	wide	selection	of	cards	supported	through	Scitech's	modular	driver	design.[71]	Document	detailing	OS/2's	architecture.	OS/2	has	historically	been	more	difficult	to	run	in	a	virtual	machine	than	most	other	legacy	x86	operating	systems	because	of	its	extensive	reliance	on	the	full	set	of	features	of	the	x86	CPU;
in	particular,	OS/2's	use	of	ring	2	prevented	it	from	running	in	early	versions	of	VMware.[72]	Newer	versions	of	VMware	provide	official	support	for	OS/2,	specifically	for	eComStation.[73]	VirtualPC	from	Microsoft	(originally	Connectix)	has	been	able	to	run	OS/2	without	hardware	virtualization	support	for	many	years.	It	also	provided	"additions"	code
which	greatly	improves	host–guest	OS	interactions	in	OS/2.	The	additions	are	not	provided	with	the	current	version	of	VirtualPC,	but	the	version	last	included	with	a	release	may	still	be	used	with	current	releases.	At	one	point,	OS/2	was	a	supported	host	for	VirtualPC	in	addition	to	a	guest.	Note	that	OS/2	runs	only	as	a	guest	on	those	versions	of
VirtualPC	that	use	virtualization	(x86	based	hosts)	and	not	those	doing	full	emulation	(VirtualPC	for	Mac).	VirtualBox	from	Oracle	Corporation	(originally	InnoTek,	later	Sun)	supports	OS/2	1.x,	Warp	3	through	4.5,	and	eComStation	as	well	as	"Other	OS/2"	as	guests.	However,	attempting	to	run	OS/2	and	eComStation	can	still	be	difficult,	if	not
impossible,	because	of	the	strict	requirements	of	VT-x/AMD-V	hardware-enabled	virtualization	and	only	ACP2/MCP2	is	reported	to	work	in	a	reliable	manner.[74]	ArcaOS	supports	being	run	as	a	virtual	machine	guest	inside	VirtualBox,	VMware	ESXi	and	VMWare	Workstation.[75]	It	ships	with	VirtualBox	Guest	Additions,	and	driver	improvements	to
improve	performance	as	a	guest	operating	system.[76]	The	difficulties	in	efficiently	running	OS/2	have,	at	least	once,	created	an	opportunity	for	a	new	virtualization	company.	A	large	bank	in	Moscow	needed	a	way	to	use	OS/2	on	newer	hardware	that	OS/2	did	not	support.	As	virtualization	software	is	an	easy	way	around	this,	the	company	desired	to
run	OS/2	under	a	hypervisor.	Once	it	was	determined	that	VMware	was	not	a	possibility,	it	hired	a	group	of	Russian	software	developers	to	write	a	host-based	hypervisor	that	would	officially	support	OS/2.	Thus,	the	Parallels,	Inc.	company	and	their	Parallels	Workstation	product	was	born.[77]	OS/2	has	few	native	computer	viruses;[78]	while	it	is	not
invulnerable	by	design,	its	reduced	market	share	appears	to	have	discouraged	virus	writers.	There	are,	however,	OS/2-based	antivirus	programs,	dealing	with	DOS	viruses	and	Windows	viruses	that	could	pass	through	an	OS/2	server.[79]	Some	problems	were	classic	subjects	of	comparison	with	other	operating	systems:	Synchronous	input	queue
(SIQ):	if	a	GUI	application	was	not	servicing	its	window	messages,	the	entire	GUI	system	could	get	stuck	and	a	reboot	was	required.	This	problem	was	considerably	reduced	with	later	Warp	3	fixpacks	and	refined	by	Warp	4,	by	taking	control	over	the	application	after	it	had	not	responded	for	several	seconds.[80][81]: 565 	No	unified	object	handles
(OS/2	v2.11	and	earlier):	The	availability	of	threads	probably	led	system	designers	to	overlook	mechanisms	which	allow	a	single	thread	to	wait	for	different	types	of	asynchronous	events	at	the	same	time,	for	example	the	keyboard	and	the	mouse	in	a	"console"	program.	Even	though	select	was	added	later,	it	only	worked	on	network	sockets.	In	case	of
a	console	program,	dedicating	a	separate	thread	for	waiting	on	each	source	of	events	made	it	difficult	to	properly	release	all	the	input	devices	before	starting	other	programs	in	the	same	"session".	As	a	result,	console	programs	usually	polled	the	keyboard	and	the	mouse	alternately,	which	resulted	in	wasted	CPU	and	a	characteristic	"jerky"	reactivity
to	user	input.	In	OS/2	3.0	IBM	introduced	a	new	call	for	this	specific	problem.[82]	This	section	needs	additional	citations	for	verification.	Please	help	improve	this	article	by	adding	citations	to	reliable	sources	in	this	section.	Unsourced	material	may	be	challenged	and	removed.	(June	2011)	(Learn	how	and	when	to	remove	this	message)	OS/2	has	been
widely	used	by	Iran	Export	Bank	(Bank	Saderat	Iran)	in	their	teller	machines,	ATMs	and	local	servers	(over	35,000	working	stations).	As	of	2011,	the	bank	moved	to	virtualize	and	renew	their	infrastructure	by	moving	OS/2	to	Virtual	Machines	running	over	Windows.	OS/2	was	widely	used	by	Brazilian	banks.	Banco	do	Brasil	had	a	peak	10,000
machines	running	OS/2	Warp	in	the	1990s.	OS/2	was	used	in	automated	teller	machines	until	2006.	The	workstations	and	automated	teller	machines	and	attendant	computers	have	been	migrated	to	Linux.[83]	An	ATM	in	Australia	revealing	during	a	reboot	that	it	is	based	on	OS/2	Warp	OS/2	has	been	used	in	the	banking	industry.	Suncorp	bank	in
Australia	still	ran	its	ATM	network	on	OS/2	as	late	as	2002.	ATMs	at	Perisher	Blue	used	OS/2	as	late	as	2009,	and	even	the	turn	of	the	decade.[84]	OS/2	was	widely	adopted	by	accounting	professionals	and	auditing	companies.	In	mid-1990s	native	32-bit	accounting	software	were	well	developed	and	serving	corporate	markets.	OS/2	ran	the	faulty
baggage	handling	system	at	Denver	International	Airport.	The	OS	was	eventually	scrapped,	but	the	software	written	for	the	system	led	to	massive	delays	in	the	opening	of	the	new	airport.	The	OS	itself	was	not	at	fault,	but	the	software	written	to	run	on	the	OS	was.	The	baggage	handling	system	was	eventually	removed.	OS/2	was	used	by	radio
personality	Howard	Stern.	He	once	had	a	10-minute	on-air	rant	about	OS/2	versus	Windows	95	and	recommended	OS/2.	He	also	used	OS/2	on	his	IBM	760CD	laptop.	OS/2	was	used	as	part	of	the	Satellite	Operations	Support	System	(SOSS)	for	NPR's	Public	Radio	Satellite	System.	SOSS	was	a	computer-controlled	system	using	OS/2	that	NPR	member
stations	used	to	receive	programming	feeds	via	satellite.	SOSS	was	introduced	in	1994	using	OS/2	3.0,	and	was	retired	in	2007,	when	NPR	switched	over	to	its	successor,	the	ContentDepot.	OS/2	was	used	to	control	the	SkyTrain	automated	light	rail	system	in	Vancouver,	Canada	until	the	late	2000s	when	it	was	replaced	by	Windows	XP.	OS/2	was	used
in	the	London	Underground	Jubilee	Line	Extension	Signals	Control	System	(JLESCS)	in	London,	England.	This	control	system	delivered	by	Alcatel	was	in	use	from	1999	to	2011	i.e.	between	abandonment	before	opening	of	the	line's	unimplemented	original	automatic	train	control	system	and	the	present	SelTrac	system.	JLESCS	did	not	provide
automatic	train	operation	only	manual	train	supervision.	Six	OS/2	local	site	computers	were	distributed	along	the	railway	between	Stratford	and	Westminster,	the	shunting	tower	at	Stratford	Market	Depot,	and	several	formed	the	central	equipment	located	at	Neasden	Depot.	It	was	once	intended	to	cover	the	rest	of	the	line	between	Green	Park	and
Stanmore	but	this	was	never	introduced.	OS/2	has	been	used	by	The	Co-operative	Bank	in	the	UK	for	its	domestic	call	centre	staff,	using	a	bespoke	program	created	to	access	customer	accounts	which	cannot	easily	be	migrated	to	Windows.	OS/2	has	been	used	by	the	Stop	&	Shop	supermarket	chain	(and	has	been	installed	in	new	stores	as	recently	as
March	2010).	OS/2	has	been	used	on	ticket	machines	for	Tramlink	in	outer-London.	OS/2	has	been	used	in	New	York	City's	subway	system	for	MetroCards.[85]	Rather	than	interfacing	with	the	user,	it	connects	simple	computers	and	the	mainframes.	When	NYC	MTA	finishes	its	transition	to	contactless	payment,	OS/2	will	be	removed.[86]	OS/2	was
used	in	checkout	systems	at	Safeway	supermarkets.[85]	OS/2	was	used	by	Trenitalia,	both	for	the	desktops	at	Ticket	Counters	and	for	the	Automatic	Ticket	Counters	up	to	2011.	Incidentally,	the	Automatic	Ticket	Counters	with	OS/2	were	more	reliable	than	the	current	ones	running	a	flavor	of	Windows.[citation	needed]	OS/2	was	used	as	the	main
operating	system	for	Abbey	National	General	Insurance	motor	and	home	direct	call	centre	products	using	the	PMSC	Series	III	insurance	platform	on	DB2.2	from	1996	to	2001.	BYTE	in	1989	listed	OS/2	as	among	the	"Excellence"	winners	of	the	BYTE	Awards,	stating	that	it	"is	today	where	the	Macintosh	was	in	1984:	It's	a	development	platform	in
search	of	developers".	The	magazine	predicted	that	"When	it's	complete	and	bug-free,	when	it	can	really	use	the	80386,	and	when	more	desktops	sport	OS/2-capable	PCs,	OS/2	will—deservedly—supersede	DOS.	But	even	as	it	stands,	OS/2	is	a	milestone	product".[87]	In	March	1995	OS/2	won	seven	awards[88]	InfoWorld	Product	of	the	Year.[89]	Five
Awards	at	CeBIT.	PC	Professional	Magazine	-	Innovation	of	the	Year	award.	CHIP	Magazine	named	OS/2	Warp	the	Operating	System	of	the	Year.	DOS	International	named	OS/2	Warp	the	Operating	System	of	the	Year.	1+1	Magazine	awarded	it	with	the	Software	Marketing	Quality	award.	Industrie	Forum	awarded	it	with	its	Design	Excellence.	SPA
Best	Business	Software	Award.	IBM	has	used	OS/2	in	a	wide	variety	of	hardware	products,	effectively	as	a	form	of	embedded	operating	system.	Product	Product	type	Usage	of	OS/2	IBM	2074	Console	support	controller	Used	to	connect	3270	sessions	to	host	via	ESCON	channels.	Introduced	in	September	2000	as	a	replacement	for	local,	non-SNA	3174
Control	Units.	All	models	were	withdrawn	in	2006	and	replaced	by	the	Open	System	Adapter	Integrated	Console	Controller	(OSA	ICC).[90]	IBM	3494	Tape	library	Used	as	the	operating	system	for	the	Library	Manager	(LM)	that	controlled	the	tape	accessor	(robot)[91]	IBM	3745	Communications	controller	Used	as	the	operating	system	for	the	Service
Processor	(SP)	and	if	installed,	the	Network	Node	Processor	(NNP).[92]	IBM	3890	Document	processor	The	3890/XP1	was	announced	November	12,	1988.	It	initially	used	OS/2	1.1	Extended	Edition[93]	on	a	PS/2	Model	80	to	emulate	the	stacker	control	software	that	previously	ran	on	a	System/360.	IBM	later	switched	to	OS/2	Warp.[94]	IBM	473x
ATM	Used	in	a	range	of	automatic	teller	machines	manufactured	by	IBM.	Was	also	used	in	later	478x	ATMs	manufactured	with	Diebold.	IBM	9672	IBM	mainframe	Used	as	the	operating	system	for	the	Hardware	Management	Console	(HMC)	and	Support	Element	(SE).[95]	Was	also	used	in	later	mainframe	models	such	as	the	IBM	2064.	History	of	the
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out	more,	and	download	the	template.	Zine	template	size:	14.8cm	x	21	cm	14.8cm	x	21cm	is	a	great	zine	size,	however	other	sizes	are	widely	used.	Don’t	panic	if	you	need	a	different	size,	we’ve	put	together	a	handy	little	tutorial	on	how	to	resize	templates	.	Below	you	can	preview	a	selection	of	spreads	from	this	photography	zine	template,	download
the	InDesign	file	and	find	a	bunch	of	helpful	tips	on	how	to	edit	your	template	in	InDesign.	Download	this	12-page	Zine	Template	Download	this	zine	template*	for	free	(your	download	will	include	an	INDD	file	for	InDesign	CS6	and	an	IDML	version	for	opening	in	InDesign	CS4,	CS5	or	CC):	Download	Template	(Free)	*Note	that	images	are	not
included	in	your	free	download.	Font	files	Cormorant	–	Font	Squirrel		Help	Working	with	InDesign	Templates	We’ve	put	together	a	collection	of	helpful	tips	to	make	editing	our	InDesign	Templates	super	easy.	If	you’re	a	newbie	to	Adobe	InDesign	it’s	worth	checking	these	out	before	starting	work	on	your	design.	Unlimited	Downloads:	1,000,000+
Fonts,	Mockups	&	Design	Assets	by	How	to	Open	an	InDesign	Template	Step	1.	Download	the	file.	UNLIMITED	DOWNLOADS:	50	Million+	Fonts	&	Design	Assets	Step	2.	Our	InDesign	templates	are	packaged	and	saved	as	ZIP	files.	If	you	have	a	Windows	computer	Right	Click	>	Extract	All	before	opening	the	InDesign	file.	Step	3.	If	you’re	running
InDesign	CS6	open	the	INDD	version	of	the	file.	If	you’re	working	with	InDesign	CS4,	CS5	or	CC	open	the	IDML	version.	How	to	Work	With	Layers	in	Your	Template	Our	InDesign	templates	are	organized	into	layers,	which	group	similar	elements	together.	The	layers	in	your	document	can	be	controlled	from	the	Layers	panel	(Window	>	Layers).	Pro
tip:	Try	locking	the	YOUR	IMAGES	HERE	layer	to	save	time	when	editing	text.	This	will	prevent	you	from	accidentally	moving	the	graphics	out	of	position.	How	to	Change	the	Colors	The	color	scheme	of	this	template	can	be	edited	from	the	Swatches	panel	(Window	>	Color	>	Swatches).	Pro	tip:	Editing	a	swatch	will	automatically	update	all	instances
of	that	color	across	your	document.	How	to	Add	Your	Own	Text	The	text	across	this	design	can	easily	replaced	with	your	own	copy.	Simple	use	the	Type	Tool	(T)	to	select	the	text	box	you	wish	to	edit.	You	can	then	add	your	own	fonts	and	formatting.	Read	more	about	formatting	text	in	InDesign.	How	to	Add	Your	Own	Images	You’ll	notice	when	you
first	open	the	template	that	all	the	image	frames	have	a	placeholder	image.	You	can	insert	your	own	images	by	selecting	the	image	frame	and	using	File	>	Place	to	select	a	replacement	image.	Read	our	beginner’s	guide	to	working	with	images	in	InDesign.	Pro	tip:	Do	your	images	look	blurry?	Make	sure	your	display	is	set	to	high-quality	(View	>
Display	Performance	>	High-Quality	Display).	To	see	more	accurately	how	your	design	will	appear	when	printed	go	to	View	>	Overprint	Preview.	How	to	Resize	Pages	in	InDesign	It’s	simple	to	change	the	width	of	the	spine	in	your	template	by	using	the	Page	Tool	(Shift+P).	Select	the	tool	and	then	click	onto	the	spine	to	select	it.	You	can	drag	the
sides	of	the	page	to	preview	your	desired	new	size.	Hold	down	Alt	or	Option	while	you	drag	to	resize	the	page.	Read	more	about	resizing	pages	in	InDesign.	How	to	Export	Your	Document	for	Printing	Once	you’ve	completed	work	on	your	template	and	you’re	ready	to	print	it		you	can	head	to	File	>	Export.	To	create	a	print-ready	file,	choose	Adobe
PDF	(Print)	from	the	Format	drop-down	menu	in	the	Export	window.	Make	sure	to	include	the	bleed	in	your	export	options	by	checking	Use	Document	Bleed	Settings	in	the	Export	Adobe	PDF	window.	Read	more	about	prepping	your	designs	for	printing	in	InDesign.	How	to	Change	the	Fonts	in	a	Document	You	can	format	individual	items	of	text	using
the	Type	Tool	(T)	and	Controls	panel,	which	you’ll	find	running	along	the	top	of	the	InDesign	workspace.	The	fonts	in	most	templates	are	not	set	as	InDesign	styles.	However,	it’s	easy	to	create	a	Character	or	Paragraph	Style	using	existing	text	formatting,	and	then	edit	this	from	the	Styles	panels	(Window	>	Styles).	Read	more	about	editing	Styles	in
InDesign.	Discover	more	advice	for	InDesign	beginners	on	our	Tutorials	page.	Or	why	not	discover	inspiration	about	typography,	layout	design	and	much	more	right	here.	templates	Magazines	Zine	Template	for	InDesign	Complete	with	an	elegant	layout	for	the	inside	pages	and	a	wraparound	cover,	this	downloadable	zine	template	features	creative
typography,	black	and	white	photography	and	an	on-trend	design	throughout.	Unlimited	Downloads:	1,000,000+	InDesign	Templates,	Mockups	&	Design	Assets	by	This	zine	template	includes	a	front	and	back	cover,	professional-standard	text	formatting,	page	numbers,	master	pages,	a	bold	colour	palette,	and	simple	and	stylish	geometric
backgrounds.	Scroll	down	to	find	out	more,	and	download	the	template.	Zine	template	size:	14.8cm	x	21	cm	14.8cm	x	21cm	is	a	great	zine	size,	however	other	sizes	are	widely	used.	Don’t	panic	if	you	need	a	different	size,	we’ve	put	together	a	handy	little	tutorial	on	how	to	resize	templates	.	Below	you	can	preview	a	selection	of	spreads	from	this
photography	zine	template,	download	the	InDesign	file	and	find	a	bunch	of	helpful	tips	on	how	to	edit	your	template	in	InDesign.	Download	this	12-page	Zine	Template	Download	this	zine	template*	for	free	(your	download	will	include	an	INDD	file	for	InDesign	CS6	and	an	IDML	version	for	opening	in	InDesign	CS4,	CS5	or	CC):	Download	Template
(Free)	*Note	that	images	are	not	included	in	your	free	download.	Font	files	Cormorant	–	Font	Squirrel		Help	Working	with	InDesign	Templates	We’ve	put	together	a	collection	of	helpful	tips	to	make	editing	our	InDesign	Templates	super	easy.	If	you’re	a	newbie	to	Adobe	InDesign	it’s	worth	checking	these	out	before	starting	work	on	your	design.
Unlimited	Downloads:	1,000,000+	Fonts,	Mockups	&	Design	Assets	by	How	to	Open	an	InDesign	Template	Step	1.	Download	the	file.	UNLIMITED	DOWNLOADS:	50	Million+	Fonts	&	Design	Assets	Step	2.	Our	InDesign	templates	are	packaged	and	saved	as	ZIP	files.	If	you	have	a	Windows	computer	Right	Click	>	Extract	All	before	opening	the
InDesign	file.	Step	3.	If	you’re	running	InDesign	CS6	open	the	INDD	version	of	the	file.	If	you’re	working	with	InDesign	CS4,	CS5	or	CC	open	the	IDML	version.	How	to	Work	With	Layers	in	Your	Template	Our	InDesign	templates	are	organized	into	layers,	which	group	similar	elements	together.	The	layers	in	your	document	can	be	controlled	from	the
Layers	panel	(Window	>	Layers).	Pro	tip:	Try	locking	the	YOUR	IMAGES	HERE	layer	to	save	time	when	editing	text.	This	will	prevent	you	from	accidentally	moving	the	graphics	out	of	position.	How	to	Change	the	Colors	The	color	scheme	of	this	template	can	be	edited	from	the	Swatches	panel	(Window	>	Color	>	Swatches).	Pro	tip:	Editing	a	swatch
will	automatically	update	all	instances	of	that	color	across	your	document.	How	to	Add	Your	Own	Text	The	text	across	this	design	can	easily	replaced	with	your	own	copy.	Simple	use	the	Type	Tool	(T)	to	select	the	text	box	you	wish	to	edit.	You	can	then	add	your	own	fonts	and	formatting.	Read	more	about	formatting	text	in	InDesign.	How	to	Add	Your
Own	Images	You’ll	notice	when	you	first	open	the	template	that	all	the	image	frames	have	a	placeholder	image.	You	can	insert	your	own	images	by	selecting	the	image	frame	and	using	File	>	Place	to	select	a	replacement	image.	Read	our	beginner’s	guide	to	working	with	images	in	InDesign.	Pro	tip:	Do	your	images	look	blurry?	Make	sure	your
display	is	set	to	high-quality	(View	>	Display	Performance	>	High-Quality	Display).	To	see	more	accurately	how	your	design	will	appear	when	printed	go	to	View	>	Overprint	Preview.	How	to	Resize	Pages	in	InDesign	It’s	simple	to	change	the	width	of	the	spine	in	your	template	by	using	the	Page	Tool	(Shift+P).	Select	the	tool	and	then	click	onto	the
spine	to	select	it.	You	can	drag	the	sides	of	the	page	to	preview	your	desired	new	size.	Hold	down	Alt	or	Option	while	you	drag	to	resize	the	page.	Read	more	about	resizing	pages	in	InDesign.	How	to	Export	Your	Document	for	Printing	Once	you’ve	completed	work	on	your	template	and	you’re	ready	to	print	it		you	can	head	to	File	>	Export.	To	create
a	print-ready	file,	choose	Adobe	PDF	(Print)	from	the	Format	drop-down	menu	in	the	Export	window.	Make	sure	to	include	the	bleed	in	your	export	options	by	checking	Use	Document	Bleed	Settings	in	the	Export	Adobe	PDF	window.	Read	more	about	prepping	your	designs	for	printing	in	InDesign.	How	to	Change	the	Fonts	in	a	Document	You	can
format	individual	items	of	text	using	the	Type	Tool	(T)	and	Controls	panel,	which	you’ll	find	running	along	the	top	of	the	InDesign	workspace.	The	fonts	in	most	templates	are	not	set	as	InDesign	styles.	However,	it’s	easy	to	create	a	Character	or	Paragraph	Style	using	existing	text	formatting,	and	then	edit	this	from	the	Styles	panels	(Window	>	Styles).
Read	more	about	editing	Styles	in	InDesign.	Discover	more	advice	for	InDesign	beginners	on	our	Tutorials	page.	Or	why	not	discover	inspiration	about	typography,	layout	design	and	much	more	right	here.	Discover	a	huge	range	of	professionally-designed	FREE	InDesign	templates.	Download	free	InDesign	templates	for	Adobe	InDesign,	including	flyer
templates,	brochure	templates,	book	templates,	report	templates,	portfolio	templates	and	much	more.	Here	you’ll	find	exceptionally	stylish	InDesign	templates	to	help	you	make	a	start	on	marketing	campaigns,	design	projects	and	social	media	templates.	Created	by	our	team	of	pro	graphic	designers,	these	free	InDesign	templates	have	been	set	up
with	correct	dimensions,	print-ready	swatches	and	design-forward	layouts	to	allow	you	to	create	simply	stunning	designs.	If	you’re	looking	for	a	little	extra,	scroll	down	to	discover	premium	template	bundles	for	Adobe	InDesign,	from	branding	kits	to	wedding	stationery	templates.	Premium	InDesign	Templates


